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Chapter 

1  
ABOUT THIS USER MANUAL 

This manual is a guide to the settings and options within the PrintBoss Select program. It applies to the current 
version of the software and does not cover features that may have only been relevant to older versions of the 
software.  This manual also assumes fairly recent versions of the Host Accounting Software are being used. 

Documents viewed or printed from the VIEW NOTES button during PrintBoss installation are Host Accounting 
Software specific. These notes, referred to as Installation Notes, supplement this manual, as this manual is a generic 
guide for all interfaces. 

SYMBOL KEY 

 Important items 

 Refer to another section of this manual for more detail 

MANUAL UPDATES 

Please check online at www.WellspringSoftware.com for an updated version of this manual. 
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Chapter 

2  
INTRODUCTION 

PrintBoss Select is a faster, more efficient way of capturing check runs and combines them with digital forms 
(PrintBoss Select Form files) for QuickBooks and Quicken only.  It is practically set up as soon as it is installed.  

PrintBoss Select allows checks to be printed on blank check stock and copies to be printed on blank paper. PrintBoss 
Select eliminates the need for multiple part forms.  The software creates a database to print the original and all 
copies to the specified location or destination (printer or fax service). Each copy can be printed with unique 
information, including a legend (CUSTOMER FILE, ACCOUNTING FILE, etc.), a logo, or any other field 
available in the accounting software that might pertain to a specific copy of a document. 

PrintBoss Select captures information from QuickBooks or Quicken to the PrintBoss Printer Driver. 

SYSTEM REQUIREMENTS 

PrintBoss Select is compatible with W2003 Server, W2008 and W2008 R2 Servers, W2012 Server, Windows XP, 
Vista, Windows 7, Windows 8, Windows 8.1, and Windows 10 operating systems.  It is also compatible with 64-bit 
versions of these operating systems.  As a general rule, 64 MB of RAM should be available for use with PrintBoss 
Select.  PrintBoss Select can be installed onto a work station or a network.  Please see the license agreement to 
determine the restrictions. 

PRINTER REQUIREMENTS 

PrintBoss Select was designed to work with a Hewlett-Packard LaserJet printer.  ANY PRINTER USED WITH 

PRINTBOSS Select MUST BE 100% HP COMPATIBLE AND USE A PCL5E OR PCL6 DRIVER. If there are driver 
options for the printer model, please use one of these choices.  PrintBoss Select is not compatible with PostScript 
printers. 

PrintBoss Select is guaranteed to work with most of the Hewlett-Packard LaserJet printers. The suggested models 
include HPLJ4 and newer.  Print speed requirements and budget should help determine the best Hewlett-Packard 
LaserJet model for your needs. 

When considering a brand other than HP, determine if your bank requires MICR ink.  If the bank does require this 
special magnetic ink (for reading the bank code on checks), make sure the brand and model of Laser printer you 
choose has MICR toner available.  Not all models have MICR toner cartridges available in the market. 

NOTE: 

Printers other than Laser printers have a smaller printable area and may not be able to print full documents.  
This is particularly important for printing checks as models other than Lasers are often incapable of printing 
the MICR line.  PrintBoss is not guaranteed to work with printers that are not Laser printers.  
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Chapter 

3  
INSTALLATION 

PrintBoss Select can be installed locally on a single workstation (Local Install), or it can be installed to a shared 
network folder where multiple workstations access the one application (Network Install).  Both mapped driver letters 
and UNC paths will work to identify the location of the PrintBoss Directory.  We recommend PrintBoss Select is 
installed on a shared folder if there are multiple users so bank information, forms, and other information can be 
shared.  After installing PrintBoss Select to the shared folder (Network Install), each additional workstation only 
needs the Workstation Install steps.  

 Unless the server is used as a workstation, installation to the server folder can be performed 
from a workstation.  

 All PrintBoss Select users need FULL CONTROL of the PrintBoss Home directory.  Simply 
having read and write permissions are not sufficient. 

 When running the PrintBoss setup program on operating systems beginning with Windows 
7, we suggest you right-click and choose the option ‘Run as Administrator. 
 

 If you have internet access, download the latest setup.exe from our web site.  Use this setup 
program instead of the setup.exe file on the CD to ensure you are installing the most recent 
version of PrintBoss Select. 

 Citrix &Terminal Server installations are referenced in Chapter 6. 

The following pages contain tables with step by step installation instructions for the 3 basic install types – local, 
network, and workstation.  
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SS TT EE PP  11   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Start the PrintBoss 
Select Installation 

 Log in as 
ADMINISTRATOR. 

Insert the PrintBoss Select 
CD-ROM in the CD-ROM 
Drive. 

Run X:\setup.exe (where X: is 
the CD-ROM drive). 

QuickBooks / Quicken is 
selected as the Host 
Accounting Software to be 
used with PrintBoss Select.   

Select the directory where 
PrintBoss Select is to be 
installed.  PrintBoss Select 
will default to C:\PrntBoss. 

Select to install icons for the 
Current User or for All Users 
of this workstation. 

Click on Next. 

 Log in as 
ADMINISTRATOR. 

Insert the PrintBoss Select CD-
ROM in the CD-ROM Drive. 

Run X:\setup.exe (where X: is 
the CD–ROM drive). 

QuickBooks / Quicken is 
selected as the Host Accounting 
Software to be used with 
PrintBoss Select.   

Select the directory where 
PrintBoss Select is to be 
installed. PrintBoss Select will 
default to C:\PrntBoss.  Change 
this to X:\PrntBoss (where X is 
the shared network drive). 
PrintBoss Select may use either 
drive mappings or the UNC path.  

Select to install icons for the 
Current User or for All Users of 
this workstation. 

Click on Next. 

 Log in as 
ADMINISTRATOR. 

Run X:\PrntBoss\setup.exe 
(where X is the shared 
network drive). 

QuickBooks / Quicken is 
selected as the Host 
Accounting Software to be 
used with PrintBoss Select. 

Select the directory 
X:\PrntBoss (where 
PrintBoss Select is already 
installed).  

Choose the Workstation/ 
Printer Driver/Special Host 
Tasks option from the active 
radio buttons. 

Select to install icons for the 
Current User or for All Users 
of this workstation. 

Click on Next. 

SS TT EE PP  22   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Registration & 
Activation of the 
PrintBoss Select 
software. 

Enter the Serial Number, 
Options, and Registration 
Code from the BLUE 
registration card that came 
with the software. 

Enter the Company Name, 
contact, and site that should 
become permanent within the 
PrintBoss Select software. 

Confirm the information and 
save the registration. 

 If the workstation has 
internet access, click on 
the online activation 
option.  If the workstation 
does not have internet 
access, choose to e-mail or 
fax the activation. PrintBoss 
Select will function for 30 
days without activation 
(Evaluation Date). 

Enter the Serial Number, Options, 
and Registration Code from the 
BLUE registration card that came 
with the software. 

Enter the Company Name, 
contact, and site that should 
become permanent within the 
PrintBoss Select software. 

Confirm the information and save 
the registration. 

 If the workstation has 
internet access, click on the 
online activation option.  If 
the workstation does not have 
internet access, choose to e-mail 
or fax the activation.  PrintBoss 
Select will function for 30 days 
without activation (Evaluation 
Date). 

This step is skipped.  The 
software is already 
registered & activated. 



PrintBoss Select 13 Electronic Copy 

SS TTEE PP  33   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Installation of 
Components 

PrintBoss Select 
automatically selects the 
components that are 
needed. Leave the defaults. 

PrintBoss Select automatically 
selects the components that are 
needed. Leave the defaults. 

This step is skipped.  The 
software is already installed. 

 

 

SS TTEE PP  44   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

PrintBoss Settings 
Saved 

PrintBoss Select 
automatically selects the 
registry that is needed.  
Typically, this is the Local 
and User Registry. 

PrintBoss Select automatically 
selects the registry that is 
needed.  Typically, this is the 
Local and User Registry. 

PrintBoss Select 
automatically selects the 
registry that is needed.  
Typically, this is the Local 
and User Registry. 

 

SS TTEE PP  55   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

View Notes Click on the VIEW NOTES 
button. 

 PRINT OUT THESE 

NOTES. They will guide you 
through steps specific for 
QuickBooks / Quicken. 

Click on the VIEW NOTES 
button. 

 PRINT OUT THESE NOTES.  
They will guide you through 
steps specific for QuickBooks / 
Quicken. 

This step is skipped.  The 
document has already been 
viewed and printed. 

 

SS TTEE PP  66   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Special Install 
Steps 

If the SPECIAL INSTALL 
STEPS button is active, click 
on it. 

Follow the instructions per 
the NOTES printed in Step 5 
that are specific for 
QuickBooks / Quicken. 

If the SPECIAL INSTALL STEPS 
button is active, click on it. 

Follow the instructions per the 
NOTES printed in Step 5 that are 
specific QuickBooks / Quicken. 

If the accounting software is 
installed locally, then this 
step may be necessary. 

 



PrintBoss Select 14 Electronic Copy 

SS TT EE PP  77   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Install the 
PrintBoss Printer 
Driver 

The installation will 
automatically select the best 
driver choice for this 
workstation.  Usually, this is 
PrintBoss 50.  

Click on Finish. 

Restart the computer or 
restart the Print Spooler if 
the PrintBoss 50 driver was 
installed. 

For more information about 
the differences between the 
PrintBoss NT40 and 
PrintBoss 50 drivers, please 
see the support documents 
on our web site. 

The installation will automatically 
select the best driver choice for 
this workstation.  Usually, this is 
PrintBoss 50. 

Click on Finish. 

Restart the computer or restart 
the Print Spooler if the PrintBoss 
50 driver was installed. 

For more information about the 
differences between the 
PrintBoss NT40 and PrintBoss 
50 drivers, please see the 
support documents on our web 
site. 

The installation will 
automatically select the best 
driver choice for this 
workstation.  Usually, this is 
PrintBoss 50. 

Click on Finish. 

Restart the computer or 
restart the Print Spooler if 
the PrintBoss 50 driver was 
installed. 

For more information about 
the differences between the 
PrintBoss NT40 and 
PrintBoss 50 drivers, please 
see the support documents 
on our web site. 

 

SS TT EE PP  88   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Setup PrintBoss 
Select for 
QuickBooks / 
Quicken 

Follow the Installation Notes 
to setup PrintBoss Select 

specifically for QuickBooks 
/ Quicken. 

Follow the Installation Notes to 
setup PrintBoss Select 

specifically for QuickBooks / 
Quicken. 

This step is skipped.  Setup 
is already complete. 

 

SS TT EE PP  99   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Setup QuickBooks 
/ Quicken for 
PrintBoss Select  

Follow the Installation Notes 

to setup QuickBooks / 
Quicken to interface with 
PrintBoss Select. 

Follow the Installation Notes to 

setup QuickBooks / Quicken to 
interface with PrintBoss Select. 

Follow the Installation Notes 

to setup QuickBooks / 
Quicken to interface with 
PrintBoss Select. 

 

SS TTEE PP  11 00   L O C A L  I N S T A L L  N E T W O R K  I N S T A L L  
W O R K S T A T I O N  

I N S T A L L  

Check for 
PrintBoss Select 
Updates Online. 

If the workstation has 
internet access, check for 
updates. 

Start the PrintBoss Select 
program (PB32 Program). 

Select HELP / ABOUT. 

Click on the button CHECK 

FOR PRINTBOSS UPDATES 

ONLINE. 

RUN the update.  This 
update is accessible on the 
day PrintBoss Select is 
FIRST installed or if there is 
a current service contract. 

If the workstation has internet 
access, check for updates. 

Start the PrintBoss Select 
program (PB32 Program). 

Select HELP / ABOUT. 

Click on the button CHECK FOR 

PRINTBOSS UPDATES ONLINE. 

RUN the update.  This update is 
accessible on the day PrintBoss 
Select is FIRST installed or if 
there is a current service 
contract. 

This step is skipped.  The 
software should already be 
updated. 

 Save the BLUE PrintBoss Select registration card in a safe place for backup purposes. 
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Activating PrintBoss from Installed Demo 

A demo version of PrintBoss can be registered as a full version. 

1. Navigate to the PrintBoss home directory and locate Setup.exe.  The folder name may be 
PrntBoss. 

2. Double click on or run Setup.exe. 
3. Verify your Host Accounting System is listed at the top of the Destination Selection window.  

PrintBoss will automatically install forms necessary for the selected host. 
4. Verify the home directory for this installation (usually a server location).  The path can be a 

mapped drive or a UNC path. 
5. Select Registration/Activation Only under the Install Type section. 
6. Click the Next button. 
7. Remove the Demo check mark at the top of the Registration window. 
8. Fill in the fields. 
9. Click Next. 

10. Read the Software License Agreement and click Next to agree. 
11. Select Online Activation as the Activation Method. 
12. Click Next.   
13. Click Finish.  PrintBoss will verify the registration is successful. 
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Chapter 

4  
SETUP 

PrintBoss Select is designed to send QuickBooks / Quicken information through the PrintBoss printer driver.  This 
allows the information printed by PrintBoss Select to include additional user specified data (e.g. Company Name 
and Address; and Bank Name and Address).  PrintBoss Select will also add the MICR line. 

PRINTBOSS SELECT  INTERFACE 

PrintBoss Select is shipped ready to interface with QuickBooks / Quicken.  This includes the following: 

 US Voucher Check in 6 styles 
o Top 
o Middle 
o Bottom 
o Equal Thirds Top 
o Equal Thirds Middle 
o Equal Thirds Bottom 

 Canadian Image Voucher Check in 3 styles 
o Top 
o Middle 
o Bottom 

 Online Payroll Check 
 Standard 3-Up Check 
 Wallet Check 
 Deposit Slips in 3 styles 

o Top 
o Middle 
o Bottom 

Print the View Notes at the end of the installation for instructions on how to set up QuickBooks / Quicken with 
PrintBoss Select.  These document files are stored in the PrntBoss\Docs directory. 

NOTE: 

 Banks prefer the MICR edge be the clean edge of the paper (easier for processing by equipment). 
 Most of our standard forms provide a mini copy of both the check and advice on the top portion of the 

page. The mini copy is at the bottom on Middle and Top checks.  This very popular option eliminates the 
need to make additional copies of checks for record keeping. 
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PRINTER SETUP 

1. Open the PrintBoss Master Application. 
2. Click on the File menu and select Printer Setup.  This PrintBoss Printer Setup dialog opens.   
3. Choose the default laser printer for documents printed through PrintBoss.  Do Not Select the PrintBoss 

printer itself (PrintBoss NT40 or PrintBoss 50).  The PrintBoss printer should only be selected by the 
accounting software. 

a. Select Use Windows Default to use PrintBoss Select on a terminal server. 
b. Select a Specific Printer from the drop down menu to specify a printer other than the Windows 

default to use with PrintBoss Select in environments other than a terminal server. 
4. Click OK when you are finished.  The OK button is only available when changes are made to the printer 

setup. 

Each workstation using PrintBoss Select can choose a different default printer.  This selection is saved locally on the 
workstation and will not change the selection on other workstations. 

 PrintBoss Select is very literal with the names of printers.  If the printer name changes in 
any way, the PrintBoss Select program will consider the new name as a new/different 
printer. 

 Settings for Terminal Servers / Citrix Servers 

Often in a Terminal Server or Citrix environment the printer name includes the session number or indicator.  
This results in multiple names for the same printer.  Each name is only available in the specified session.  
Applications such as PrintBoss Select generate an error when the selected printer name is not available.  
PrintBoss Enterprise can define the session indicators and truncate the printer name so the printer is 
recognized in all sessions.  The other option is to save the printer choice in the PrintBoss Select Directory 
instead of the Terminal Server registry. 

CONFIGURATION 

The Configuration screens provide additional options for working with QuickBooks / Quicken.  Click OPTIONS / 
CONFIGURATION from the main PrintBoss Master Application window to view or change these options.  Choose 

the settings recommended in the Installation Notes.  A description of the settings on each tab follows. 

Settings 
Most of these settings are set automatically for the QuickBooks / Quicken.  If multiple users are working with 
PrintBoss Select on a network, the Work Files Private Folder Name should be set to WinUserName globally for each 
workstation.  See Private Folder Names below. 

MICR OFFSET ADJUSTMENT & MICR ADJUST WIZARD 
The location of the MICR line is calculated by PrintBoss Select based on the directives passed in the #MICR 
command.  Typically, this placement is accurate for a check printed at the bottom of an 11" page.  Sometimes there 
are small differences in alignment from printer to printer.  A separate adjustment can be made in the Configuration 
of PrintBoss Select to correct the alignment.  Once the adjustment is made, it should not need to be changed unless 
the printer, printer driver, or operating system is changed.  The adjustment of the MICR can be both vertical and 
horizontal. This setting is global for all forms and is workstation and printer specific.   

Select OPTIONS / CONFIGURATION from the PrintBoss Select Master Application window to access the 
adjustment settings.  The adjustments may be completed with the help of the MICR 
Adjust Wizard or by manually adjusting the values. 

MICR Adjust wizard 

The location of the MICR line is calculated by PrintBoss based on the directives passed 
in the #MICR command. Typically, this placement is accurate for a check printed at the bottom of an 11" page.  
Sometimes there are small differences in alignment from printer to printer.  A separate adjustment can be made in 
the Configuration of PrintBoss to correct the alignment.  Once the adjustment is made, it should not need to be 
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changed unless the printer, printer driver, or operating system is changed.  The adjustment of the MICR can be both 
vertical and horizontal. This setting is global for all forms and is workstation and user specific. 

 See Chapter 8, Bank Accounts, for additional information about the MICR line. 

NON-MICR OFFSET ADJUSTMENT 
This setting adjusts the entire document, except the MICR line, to center documents on the page.  The purpose of 
this setting is to adjust for small differences in printer driver margins and is not intended for significant shifts of 
form placement.  The adjustment can be both vertical and horizontal.  This setting is global for all forms and is 
workstation and user specific.  You may need to adjust this setting if a new printer or new printer driver is used 
with PrintBoss Select. 

Start by selecting the orientation of the page, either Portrait or Landscape.  If the document needs to move Right or 
Down (Bottom), increase the corresponding Non-MICR offset. The values are in thousandths of an inch.  The 
amount of the adjustment may vary from printer to printer.  Decrease the MICR offset to shift the forms Left or Up 
(Top).  Use negative numbers to move below zero. 

PRIVATE FOLDER NAMES  

 Work Files 
Every time PrintBoss Select processes a document it creates a work file.  The work files are specific to a Form.  If 
the PrintBoss Select application is on a shared drive, each workstation should have a unique work file folder name to 
prevent accidentally overwriting files. 

Click on the Work Files drop down menu to change the selection from <COMMON> to something unique for each 
workstation.  The {WinUserName} setting creates a folder using the Windows User Name of the person logged into 
the computer.  You may also highlight the field and type a name.  DO NOT put the arrows (< >) around the new 
name.  PrintBoss Select creates a work file folder using the name you specified and saves it in the PrintBoss Work 
folder located in the PrintBoss Directory folder. 

Repeat this step on each workstation that will use PrintBoss Select or check the Set Globally box.    

 

Checking the box changes the settings for the Private Folder Names of the Work Files to {WinUserName}.  

Allow temporary folder change when browsing work file 
The default setting for browsing work files is to only display work files for the person logged into the workstation.  
Occasionally, a manager or Wellspring Software technician may need to review the work files of other users.  This 
option allows all work files to be viewed from this workstation.  This is faster than changing the configuration 
settings and going back to the work file browse window. 

Set Globally (check box) 
This option, when checked, sets the Private Folder Names for the Work Files for all users to {WinUserName}.  This 
is required for Citrix or Terminal Server users.  It also eliminates an extra step during the setup of each workstation. 

Allow temporary folder change when browsing archive  
This option is irrelevant for PrintBoss Select users. 

ENABLE PRINTBOSS WINDOWS PRINTER DRIVER PROCESSING 
This option should be checked at all times to activate the PrintBoss Select driver. 
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Internal 

MISC LOCAL PROPERTIES 

Suppress warning that PrintBoss is the Windows Default Printer 
The PrintBoss printer driver should not be the Window's default printer.  If the PrintBoss printer is set as the 
Window's default printer, the PrintBoss Select program will generate a warning message.  This option should not be 
checked.  Only check this option in special circumstances. 

Save Printer Settings 

This setting is checked by default and allows the PrintBoss Select program to retain information about specific 
printers and trays. 

Suppress dialogs when appropriate 

Check one or all of the following options to stop PrintBoss Select from popping up a window or flashing in the 
taskbar when it is processing documents: Print Dialog. 

Local Drive Letter for Signature Disks 
By default, PrintBoss Select expects the signature disks to be in the A drive of the workstation.  Choose the default 
drive letter appropriate for your workstation. 

 Remote Signature Read Delay (Seconds) 
Enter an amount in seconds to delay PrintBoss from reading the signature code until the device is loaded by the OS. 

Print Status Screen Position 
This option allows the user to select the position of the Print Status window.  The choices are Top Right, Screen 
Center, or Bottom Right.  The default value is Screen Center. 

TextCapt Hst Last Used Count 
The default setting for this feature is set to 5.  It is used for troubleshooting. 

Minimize PrintBoss on startup 
This option sets PrintBoss to minimize to the Taskbar on startup. 

MISC APPLICATION PROPERTIES 

When launched by Acct. Host, Terminate PrintBoss After Batch Print 
Check this box to automatically close PrintBoss Select when it has been automatically opened by a print job.  This 
will not close PrintBoss Select if the user manually opens the program. 

Windows Print Job Limit 
This setting allows PrintBoss Select to help ease the stress of a printer queue. This setting can be used to separate a 
single large batch into smaller print jobs by creating a pause between each job.  The pause allows the first print job 
to begin processing before the second job is sent to the printer, minimizing the backlog in the printer memory. 

Print Jobs till Prompt to Continue 
This feature is available when the Windows Print Job Limit has been modified.  Enter a value greater than 0 to have 
PrintBoss Select prompt the user to send more print jobs to the printer.  This feature is often used when printing 
large batches and provides a prompt to allow the user time to refill a paper tray. 

Delay Between Print Jobs 
This feature is available when the Windows Print Job Limit has been modified. The value represents seconds and 
determines the length of the pause between each print job PrintBoss Select sends to the printer. 

Print Jobs received within these secs are treated as one batch 
PrintBoss Select can be set to "wait" to combine all pages into a single batch for accounting software that sends each 
page as a separate print job.  This only works when the Append to Transfer File option is checked on the PrintBoss 
Driver Settings window.  

Stop Before Print Job starts when invalid printer exists 
Check this box to stop PrintBoss Select from processing the print job when an invalid printer is selected. 

Default printer choice for new users (or Terminal Server Clients) is "use Win Default" 
There are times when you want to set the printer for the PrintBoss Printer Setup for all users to use the Windows 
Default printer.  This is especially true for users in a terminal server environment using Standard PrintBoss.  This 
option will set this default for all new users.  Select this immediately after the initial installation to apply to all users. 
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Force form pre-read for each page (helps for multiple forms per batch) 
Select this option when more than one PrintBoss Select Form is used within a single batch. 

Work/Archive File Compression ALWAYS (overrides each form’s setting) 
This option is only visible with Force form pre-read for each page is selected.  Select this option to override the 
form’s settings and always compress Work Files.  (The archive feature is not available in the Select edition of 
PrintBoss). 

ReqList Examines all pages for form ID within a batch (not just first page) 
This setting is usually not relevant for PrintBoss Select. It is included for accounting software that has the ability to 
send documents with different formats in the same print batch.  This option allows PrintBoss to match each 
document against the Form/Bank Request List to determine the correct Form and Bank for each document in the 
batch.   

DocRecip Length 

Use this option to extend the length of the DocRecip field in the Work File.  The default length is currently 40 
characters.  PrintBoss allows a maximum of 60 characters for the DocRecip field in the Work File. 

BANK APPLICATION PROPERTIES 

Method of Matching of Bank Code 
There are two different methods PrintBoss Select uses to match the Bank Code from the accounting software with 
the Bank Code in the PrintBoss Bank List (when a Bank Code is used).  The most common method is Enforce Exact 
Bank Code Match and requires a character-by-character match for the entire string.  The Allow Partial Match 
method looks for an exact match up to the colon ( : ) in the bank code and then any partial match after the colon.  
Partial matching is very unusual. 

 See Chapter 8, Bank Accounts. 

Allow for Selection when multiple Bank Codes match 
Occasionally, there may be more than one account with the same bank code.  Check this option to allow the user to 
select from a list of the matching bank codes.  This is a good feature to select even if you don’t expect to have 
matching bank codes to alert you in case a matching bank code has been inadvertently created.   

Allow bank accounts to be AP and Payroll 
QuickBooks uses the variables {ChkAcct}:{CompName} to allow PrintBoss Select to choose the correct bank 
account for each check in a batch.  However, QuickBooks does not print the checking account ID for payroll checks 
and PrintBoss Select may substitute the word Payroll for the checking account ID.  When the same bank account is 
used for both AP and Payroll, PrintBoss may generate a list of bank codes every time Payroll is printed after AP or 
vice versa.  Often the Bank Code gets renamed each time.  Select this option to use one bank account for both AP 
and Payroll.  PrintBoss Select will match the company name only for the Payroll checks.  The Enable "Payroll" 
alias name must be selected on the Bank Record as well. The alias is only available when Allow bank accounts to be 
AP and Payroll is selected on the Internal tab of the Configuration window. 

Auto Populate Bank List with Unused Records 

Select a value to automatically populate the Bank List in PrintBoss.  The default is the number of bank records 
purchased.  Ten bank records are provided with each PrintBoss license.  This feature is often used with the unlimited 
bank module to limit the initial population of the bank list.  The default for the unlimited bank module is 25. 

Change Bank Code Len 
The default Bank Code length is 50 characters.  Occasionally, the accounting software sends a longer bank code.  In 
these cases, the bank code length may be increased up to a maximum of 60 characters.  If the bank code length is set 
to a longer value and then decreased, any bank codes that are longer than the new value will be truncated.  This 
action cannot be undone.  The bank code length may be changed back to a longer length, but the actual bank codes 
in PrintBoss Select need to be edited to match their original names. 

Search Payee List using this method: 
The default method is ‘Standard Mode’ and matches by Payee Name and ID.  The other two choices are: 

 Matches on Payee 
 Matches on Payee ID 
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Menus  
ENABLE TOOL BAR 

Check this option to select the menu icons you want to appear as shortcuts on the Master Application window. 

ENABLE MASTER MENU STATUS PANEL 
When this box is checked, the lower half of the Master Application window shows the Capturing Status dialog.  
This is a great feature for troubleshooting.  When this box is not checked, the lower half of the Master Application 
window is suppressed.  The value is checked by default. 

ENABLE MASTER MENU STATUS TRAY (NORMALLY UNCHECKED) 
Select this option to display the Status Tray at the bottom of the PrintBoss Master Application window. 

RESET WINDOW SIZES 
PrintBoss Select remembers the size and location of many of the windows in PrintBoss Select as a user naturally 
adjusts them.  Click this button to reset all windows to their original default locations and sizes. 

Special Controls  

SELECT CHECK STOCK STYLE 
This drop down menu provides the choice of Bottom, Top, or Middle check styles for the QuickBooks Voucher 
Check or the QuickBooks Voucher Image Check (Canadian).  The selection must be made before checks are printed 
to PrintBoss Select in order for the change to take effect. 

SELECT DEPOSIT STOCK STYLE 
This drop down menu provides the choice of Bottom, Top, or Middle deposit styles for the QuickBooks Deposit 
Slip.  The selection must be made before deposit slips are printed to PrintBoss Select in order for the change to take 
effect. 

Legacy  
Most of the settings on this tab are being discontinued and do not apply to PrintBoss Select.  Talk to a Wellspring 
Software support technician before changing any of these settings. 

SUPPRESS FORM'S COMMON PRINTER BY PROJECTING ONTO INDIVIDUAL COPIES 
PrintBoss Select had a Form/Printer Device setting in versions prior to 5.3.  This setting can still be used if the 
legacy option is set to Original Method Form Printer.  Version 5.3 and later can Suppress Form's Common Printer 
and assign the selected printer to individual copies on the Multi-Parts & Printers tab of the Form Editor.  The old 
Form Printer choice has been replaced with Default PrintBoss Printer on the form's Multi-Parts and Printers tab. 

SHOW "SCAN SCOPE STATUS" BUTTON ON PRINT SCREEN 
Set this option to Displayed to display the Scan Scope Status button on the PrintBoss Print Copies Dialog.  This 
button is used to scan the status of the documents defined in the Scope.  For example, it might display 3/15 next to 
the Original copy, indicating 3 of the 15 documents have been processed. 

Select Suppressed to hide this button on the PrintBoss Print Copies Dialog.  The Default setting for new installs is to 
suppress this button. 

"STAY ON TOP" METHOD FOR DOCUMENT PRINTING WINDOWS 
This option should typically remain at the Default (Bring to front) value.  Click on the drop down menu if you prefer 
a different method. 

VIRUS SCANNER ALLOWANCES 
The Virus Scanner Allowances include options for Alternate Workfile Delete Method and Millisecond Wait for files 
to open.  These options should only be used when instructed by a Wellspring Software support technician. 
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HIDDEN FILES 
The following features are hidden and require the assistance of a Wellspring Software technician. 

Graphic Printing Module 
This should be Standard. 

Pitch Method used in printing when Pitch is specified 

This remains Precise Pitch. 

Include Host Blank Pages 

This should remain unchecked. 

Show "Current Bank" on Master 

This is typically not checked and the bank list appears as a drop down menu at the bottom of the Form Select 
window.  When checked, the bank list appears as a drop down menu on the Master Application screen of PrintBoss 
and the list will not appear at the bottom of the Form Select window. 

Allow Fragmented PB#INFO line 
This option is irrelevant for PrintBoss Select users. 

Workaround for Novell bug 
This should be checked for Novell clients/servers only. 

PRINTBOSS DRIVER SETTINGS 

PrintBoss Driver Settings set the locations of the Transfer File and the PB 50 Driver Spool.  Select OPTIONS / 
PRINTBOSS DRIVER SETTINGS from the PrintBoss Select Master Application window to view or change these 
features.  Choose the settings recommended in the Installation Notes for QuickBooks / Quicken.  A description of 
the settings follows. 

PRINTBOSS DIRECTORY 
PrintBoss Select uses files (such as Form Files, Bank Lists, and Work Files) that are installed in the PrintBoss 
directory or its descendants.  This PrintBoss directory is referred to as the PrintBoss Home Directory. The location 
of this directory is saved in the Local User Registry on each workstation that runs PrintBoss Select.  Select About 
under the Help menu in PrintBoss Select to verify the location of your Home Directory. 

The location of the Home Directory can create some confusion.  If the PrintBoss Select program is started from 
another location (as per the properties of the shortcut icon that starts PrintBoss Select), it will still use the Home 
Directory that was originally recorded.  This typically occurs when PrintBoss Select is initially installed locally and 
then all files are moved to a network location.  PrintBoss Select still looks at the local directory as its Home. 

To change the Home Directory, choose OPTIONS / PRINTBOSS DRIVER SETTINGS and change the PrintBoss 
Directory accordingly.  Restart PrintBoss Select for the change to take effect. 

It is strongly recommended that the Home and EXE directories listed on the HELP / ABOUT window match. When 
PrintBoss Select is automatically loaded by a print job, the executable listed in the Home Directory is used 
regardless of any shortcut settings. 

PrintBoss Select cannot use two different HOME directories at the same time. 

TRANSFER FILE SETTINGS 

Transfer Folder/File 
The Transfer Folder/File option under Transfer File Settings should not be selected unless directed otherwise by a 
Wellspring Software, Inc., support technician.  The transfer file is a temporary file that is generated by the PrintBoss 
Select printer driver and then renamed and finally deleted.  The user must have permissions to create, rename, and 
delete this file in the Transfer folder. While the folder name is the same for all users, the actual file must be unique 
for each user or multiple users could overwrite each other's files.  The default folder path and file name are 
{ComAppData\...\Transfer} \ {WinUserName}.  This setting is the same for a Terminal Server or Citrix 
environment.  Click OK when exiting this dialog. 

 There are other options for Terminal Server/Citrix environments.  See Chapter 6, Citrix or Terminal Server 
Installs, for additional information. 
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Use Driver Port 
This option should remain unchecked unless directed otherwise by a Wellspring Software, Inc., support technician 
for troubleshooting. 

Append to Transfer File 
This option should not be checked unless directed otherwise by a Wellspring Software, Inc., support technician. This 
allows PrintBoss to wait for additional documents to treat all of the documents as a single batch.  If checked, the 
wait increment must be defined in seconds on the Internal tab of the Configuration window (OPTIONS / 
CONFIGURATION).   

Test Path 

This option confirms the location specified for the Transfer File Settings exists. 

Driver Log 
This setting should be set to Never unless directed by a Wellspring Software, Inc., support technician for 
troubleshooting. 

Load PB32.exe 

This option should be checked to automatically load the PrintBoss Select program when a transfer file is received 
from your accounting software.  This box should NOT be checked for Citrix or Terminal Server installations when 
the users only have access to "Published Applications" on a Windows 2003 server. 

 See Chapter 6, Citrix or Terminal Server Installs. 

PB 50 DRIVER SPECIAL SETTINGS 
This section is unavailable by default and typically does not need to be edited.  Check the Allow Editing box to 
access this section. 

50 Driver Spool Dir 
Users must have Read/Write permissions to this directory.  The default setting (except for Win2000) is   
{ComAppData\...\Spool}.  A button labeled Test confirms the actual path location.   If sufficient permissions do not 
exist to this path and cannot be granted, there are several options.   

 Set the 50 Driver Spool Directory to the same location indicated by the Transfer Folder/File (see Transfer 
File Settings).  

 Set the 50 Driver Spool Directory to the {Program Files Dir} of the machine where PrintBoss Select 
resides.  This should NEVER point to a directory not physically on the hard disk of the workstation.   

PrintBoss Select will generate a reminder after clicking OK that changes to the driver spool will not take effect until 
the workstation is rebooted or the Print Spooler service is restarted.  

 See Chapter 6, Citrix or Terminal Server Installs. 

CONFIGURATION SETTINGS SAVE LOCATION 
This is set during installation to Local _User Registry (Standard). 

 See Chapter 3, Step 4 – Installation. 

MISC SETTINGS 

Printer List Settle Time 
This allows the Windows Printers list to "settle" in an environment where printers are shared.  This feature is 
especially helpful in Citrix or Terminal Server environments.  The default value is 200. 

Print Job Delete Secs 
This option should only be used when instructed by a Wellspring Software support technician. 

Render Method 
This option should only be used when instructed by a Wellspring Software support technician.  The Render Method 
applies to the PrintBoss driver and only has an impact when the textcapt.hst file is created.  This is set to Default for 
QuickBooks / Quicken.   
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PRINTBOSS ABOUT 

Click on the HELP menu and select ABOUT to review system information for your PrintBoss Select program. 

CHECK FOR PRINTBOSS UPDATES ONLINE 
This option allows a workstation that is connected to the internet to poll the Wellspring Software web site to check 
for a newer posted version of the software.  If a newer version exists, options for updating are provided.  

 A current service contract is required to download an update. 

 An update will not and cannot overwrite or delete the bank files or the forms currently 
being used. 

 Updates should only be run when all other users have CLOSED the PrintBoss Select 
program. 

This option may be restricted by the security settings within PrintBoss Select. 

 See Chapter 11, Security Features. 

VERSION INFO 
This section lists the version of the executable that is currently open.  It also lists the version information for the 
PrintBoss printer driver installed on the workstation. 

LICENSE 
This section lists license information including the serial number and site location.  Please see your license 
agreement for more detail. 

DIRECTORIES 
This section lists the directories for the PrintBoss Select program executable that is currently open and the Home 
directory indicated by the settings.  

The Accounting Host listed is the last accounting software selected during a PrintBoss Select Installation.  This 
setting does not list more than one accounting software package, even if PrintBoss Select is setup to work with 
multiple accounting software packages.  

 Please see PrintBoss Directory under PrintBoss Driver Settings earlier in this chapter. 

LIST CURRENT USERS 
This button lists the current computers and users running this copy of the PB32.exe.
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Chapter 

5  
THE PRINTBOSS PRINTER DRIVER 

The PrintBoss printer driver is the link between QuickBooks / Quicken and the PrintBoss Select application.  The 
PrintBoss printer driver is designed to appear as a normal printer driver.  However, this printer driver does not 
actually print anything.  It simply passes the data printed by the accounting application to the PrintBoss Select 
application.  

The PrintBoss printer driver should NOT be the Windows default printer.  This printer driver should only be 
selected for printing documents intended to be formatted or processed by the PrintBoss Select application. 

 Do NOT rename or modify the properties of the PrintBoss printer driver. 

PRINTBOSS 50 

PrintBoss 50 is the newest PrintBoss printer driver.  It is NOT a kernel mode printer driver.  For this reason, it is the 
default driver to install on VISTA, Windows 7, Windows 8, and 64-bit workstations, as well as Windows 2003 and 
2008, 2008R2, and 2012 servers, Citrix servers, and Terminal Services environments.   

 It is possible to pass graphics from the accounting software to the PrintBoss Form when using the PrintBoss 
50 driver with PrintBoss Enterprise.  This is only available with the Enterprise edition.  PrintBoss Select 
strips out all graphics. 

MANUAL INSTALLATION OF PRINTBOSS 50 DRIVER 

These drivers are usually installed during installation.  Occasionally, the printer driver needs to be installed or 
reinstalled manually. 

1. Navigate to the Windows Printers Control Panel. 
2. Click on the Add printer wizard. 
3. Choose to install a local printer. 
4. DO NOT select Plug & Play to automatically detect a printer. 
5. Select nul: (Local Port). 
6. Click Next. 
7. When asked for the printer driver, click on the Have Disk button. 
8. Browse to the PrintBoss directory. 
9. Open the appropriate folder (NT40a or NT50). 

10. Select the Pbnt2.inf or PB50Printer.inf file from the folder. 
11. Click Open. 
12. Click OK. 
13. Click Next. 
14. Select Replace the current driver if asked this question. 
15. DO NOT change the Name of the PrintBoss printer driver. 
16. DO NOT Share the PrintBoss printer driver. 
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17. DO NOT set the PrintBoss driver as the default printer. 
18. DO NOT print a test page. 
19. Despite any Microsoft warnings about certificates or testing, complete the install of the printer driver. 
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6  
CITRIX OR TERMINAL SERVER INSTALLS 

Citrix is a super-set of Terminal Server.  For the remainder of this chapter, references to Terminal Server include 
Terminal Server and Citrix server.  Their treatment and setup for PrintBoss Select are the same. 

A Terminal Server is actually a PC that is connected to a LAN (Local Area Network).  Clients that connect to the 
Terminal Server are running sessions on the Terminal Server and only the I/O (mostly keyboard, video, and mapped 
printers) is transmitted back and forth to the client stations.  The functions are the same as if the user is actually 
sitting at the Terminal Server.  As such, the PrintBoss printer driver must be installed on the Terminal Server and the 
PrintBoss Home folder located on the LAN server or, in unusual cases, on the Terminal Server if ONLY Terminal 
Server clients will be using PrintBoss Select.  Since the PrintBoss Home folder is normally on the LAN server, only 
a workstation install is necessary on the Terminal Server. 

The installation of PrintBoss Select is not much different than installation on any LAN workstation (see Chapter 3, 
Installation).  The Setup.exe install program is run from an existing PrintBoss folder on the LAN or from a CD.  It is 
important to run the setup while logged in as the Terminal Server Administrator.  If this is the first install on the 
LAN, choose a destination folder that will be accessible for all PrintBoss Select users, both LAN workstations and 
Terminal Server clients.  

Within an accounting application, documents intended to be printed by PrintBoss Select should be sent to the 
PrintBoss NT40 or PrintBoss 50 printer driver.  The printer driver communicates with the PrintBoss Select 
application and will ultimately send the documents to the printer specified by each user from the PrintBoss 
application.   

NOTE:  

The printer choices are saved by user on a Terminal Server.  

 Do NOT use PrintBoss Select with multiple operators using the same Windows User Name. 

 Do NOT install PrintBoss in the Program Files folder W2008 servers and above. 

WARNINGS 

The Terminal Server may be setup 2 different ways to operate as a workstation.  This setup has a significant impact 
on the settings in PrintBoss Select and how it is used. 

Desktop Terminal Server Session 
This method defines a shortcut that starts the Terminal Server session without identifying a specific application. 
Once the session starts, the operator sees a Windows Desktop on the Terminal Server as if sitting at the Terminal 
Server.  The desktop includes the Windows Start menu, quick launch, taskbar, and tool tray along with any icons on 
the desktop.  When the operator starts an accounting application and that application initiates a call to PrintBoss 
Select, it automatically loads PrintBoss Select and runs the batch of documents.  This process is the same as a 
standard workstation install of PrintBoss Select. 
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Published Applications 
This method identifies a specific application when the session is started.  In fact, when the window opens, the only 
application running is that specific application and there may be no other buttons within the session window (i.e. no 
other application can be launched from the Terminal server).  This is sometimes referred to as a Published 
Application.  This method is often used for security reasons, but it creates a problem for PrintBoss Select.  Normally 
when a batch is printed to the PrintBoss printer driver, the driver loads the PrintBoss Select program (if it is not 
already running).  In the case of a Published Application, the session does not allow other applications to start.  You 
will need to start PrintBoss Select manually before printing documents. 

The work around for this is to set PrintBoss Select to NOT load automatically which is the default setting.  Open the 
PrintBoss Select program.  Click on the OPTIONS menu and select PRINTBOSS DRIVER SETTINGS.  
Underneath the Transfer File Settings area there is a checkbox called Load PB32.exe.  UNCHECK this option.  In 
addition, select the Citrix setting that loads applications after printers are loaded or assigned.  PrintBoss will open 
when a batch is sent to receive the documents. 

W2003 SERVERS AND ABOVE 

Windows 2003 Servers and above have a default group policy setting that prevents the PrintBoss NT40 printer 
driver from installing. The PrintBoss 50 printer driver should install automatically under these circumstances.  

 Users must have Full Control permissions to the Transfer Folder defined under OPTIONS / 
PRINTBOSS DRIVER SETTINGS.   The folder selected by the setup program should have 
this permission, but it is worthwhile to check security. 

 Users must have FULL CONTROL of the PrintBoss directory. 

 Users should have “read” permissions to C:\Windows\System32\Spool\Printers directory.  
This only applies to W2003 Servers. 

If an install of the PrintBoss NT40 printer driver on a W2003 server is necessary, follow these steps prior to 
installing PrintBoss Select.  Please note these steps may also be necessary on the domain server as well. 

1. Select START / RUN. 
2. Type gpedit.msc and click on OK. 

3. Double-click Computer Configuration under Local Computer Policy. 
4. Double-click Administrative Templates. 

5. Double-click Printers. 

6. Right-click on Disallow installation of printers using kernel mode drivers  
7. Select Properties and Disable this setting 

8. Restart the server for the setting to take effect 

PRINTBOSS SETTINGS 

Many of these settings are the same as a standard PrintBoss Select installation.  

NOTE: 

Log in to the Terminal Server as ADMINSTRATOR before installing PrintBoss Select. After completing the 
setup, individual users should be able to log in with all settings complete. 

Options / Configuration 

PRIVATE FOLDER NAMES 
Check the Set Globally box in the upper right corner of this selection.  This will set the work file and archive file 
private folder names to {WinUserName}. 

ENABLE PRINTBOSS WINDOWS PRINTER DRIVER PROCESSING 
This option should be checked. 
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“PB#INFO” FLAG OVERRIDES ABOVE 
This option should be checked. 

Options / PrintBoss Driver Settings 

PRINTBOSS DIRECTORY 
This is the location of the PrintBoss directory, probably on the LAN server.  Users will need FULL CONTROL of 
this directory. 

TRANSFER FILE SETTINGS 
A common Transfer Folder is C:\Transfer with the File name {WinUserName}.  The Transfer folder MUST be in a 
location where ALL users have complete access.  It also MUST be in a location that is on the local hard drive of the 
Terminal Server.  In some instances, Terminal Servers are configured so the local driver is a letter other than C.  In 
those cases it would be appropriate to use that letter, such as M:\Transfer.  This is a global setting for all Terminal 
Server users on each Terminal Server PC.  The Transfer File MUST be {WinUserName} (or some other dynamic 
derivative) on a Terminal Server, otherwise Print Jobs will get mixed between users. 

The recommended Transfer Folder/File Name for Terminal Servers is 
{ComAppData\...\Transfer}\{WinUserName}.  This path determines the "All Users" location on the server and 
creates the Transfer folder under Wellspring\PrintBoss. 

APPEND TO TRANSFER FILE 
This option is checked only if required per the PrintBoss Installation Notes for the accounting software. 

LOAD PB32.EXE 
This should be Checked for Desktop Terminal Server setups, or UNCHECKED FOR PUBLISHED APPLICATION 

SETUPS. 

PB 50 DRIVER SPECIAL SETTINGS 
The default is {ComAppData\..\PrintBoss\Spool}. 

Users need Read permissions to this directory, but Full Control is preferred.   Restart the Print Spooler (or restart 
your PC) once changes are made to this setting. 

CONFIGURATION SETTINGS SAVE LOCATION 
This should be set to Local_User Registry (Standard). 

PRINTER SELECTION 

Once PrintBoss Select is installed, each user may select a default LaserJet printer as the destination for PrintBoss 
Select documents. Select FILE / PRINTER SETUP on the PrintBoss Select Master Application window. 

The Windows’ printer list often displays each printer with a session label.  If a user logs in during one session, 
selects a printer with that session label, logs off, and then logs in at another time during a different session, the 
printer will have a different session label even though it is the same printer.  PrintBoss Select will perceive the 
different label as a different printer.  The original printer name will not be available and PrintBoss Select will 
generate an error message when opening the application.  PrintBoss Select will then automatically select the 
Windows default printer. 

A work around is to select the option Use Windows Default in the Printer Setup window.  PrintBoss Select will 
select the default printer for the user's session. 

 PrintBoss Enterprise users have an option to define the "label" for the session and have PrintBoss truncate 
this label or session "ID" when reviewing the list of printers.  This eliminates the recognition conflict when 
the user logs into different sessions and allows the specific printer to be selected and retained for all sessions. 
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Chapter 

7 
SOFTWARE UPDATES 

PrintBoss Software can be updated with a valid service contract.  This is the same service contract that allows you to 
call Wellspring Technical Support for help.  There are basically two ways to update your software. 

1. Online through our web update. 
2. Offline after a file download from our web site. 

AUTOMATED ONLINE UPDATES 

Online updates are automated for your convenience.  Call your IT department if you have trouble performing live 
updates through your firewall. 

1. Open the PrintBoss Master Application window. 
2. Click on the Help menu and select About. 
3. Click on the Check for PrintBoss updates Online button at the top of the About window. 

a. This button is available for PrintBoss versions 5.x and above. 
b. The About window also contains useful information about your version and the location of the 

PrintBoss Home directory. 
4. Click Yes to continue. 
5. Click Run on the File Download – Security Warning window. 
6. Click Continue if you receive a user account security warning. 
7. Click Unblock if you receive a Block warning. 
8. Other warnings may appear based on your internet browser software or setup.  Answer appropriately to 

continue with the live web update. 
9. The PrintBoss Web Update window opens. 

10. Click Refresh to refresh your license file.   
a. PrintBoss will not allow you to continue when your License Date is expired.   
b. Please call Wellspring Software to renew your Service Contract before your License Date expires. 

11. Click Continue with Update if you have a valid License Date. 
a. Please call Wellspring Software if you believe you have a current service contract and the License 

Date shows as expired. 
12. The web will initiate 2 downloads. 

a. The first download is the updated PrintBoss Select software. 
b. The second download is the updated PrintBoss Help files. 

13. PrintBoss Select will launch Setup.exe immediately after the Help files are downloaded and will 
automatically update your software.   

14. Wait for the PrintBoss Setup/Update window.  It should indicate PrintBoss has successfully updated.  Press 
OK. 

You can now open PrintBoss and begin using your updated software.  Please call Wellspring Software 
Technical Support if you receive any errors during this process. 
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OFFLINE MANUAL UPDATES 

Offline updates are helpful when your firewall does not allow you to use the live update option.  Even if you do not 
have internet access at work, you can use this method from any computer to download an updated version of 
PrintBoss and copy it to your local workstation at the office to initiate the update process. 

1. Open a web browser and point it to www.wellspringsoftware.com.  This opens the Wellspring Software 
web site. 

2. Roll your mouse over the Support button and click Downloads. 
3. Click on setup.exe and Save this file to your computer or removable media. 

a. DO NOT click on PBUpdate.  This initiates a live web update and is available for PrintBoss 
versions prior to 5.0. 

4. Copy the setup.exe file to a computer with PrintBoss if you did not download it from a computer with 
PrintBoss. 

5. Double-click on Setup.exe and follow the prompts. 
a. Host Accounting System – Select your current accounting system from the list if it is not 

displayed. 
b. Install PrintBoss into this directory – Confirm this is the current location of your PrintBoss 

Home directory.  This may be a server location or your local C:\ drive. 
c. Install Type – Select Update. 
d. Install "Programs\PrintBoss\<Icons>" for – Select All Users. 

6. Click Next.  Leave the defaults on the Select components to install screen. 
7. Click Next.  PrintBoss will copy installation files. 
8. Choose settings to complete the setup. 

a. These settings are pulled from your current PrintBoss settings. 
b. Install Printer Driver – The driver you are currently using should already be selected. 
c. Update "Desktop icons calling PB32.exe – Check this option. 
d. Update "Quick Launch" icons calling PB32.exe – Check this option. 

9. Click Finish.  PrintBoss will complete the installation. 
10. Click OK on the PrintBoss Setup/Update window.  It should indicate PrintBoss has successfully updated.   

 

You can now open PrintBoss and begin using your updated software.  Please call Wellspring Software Technical 
Support if you receive any errors during this process.
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Chapter 

8 
BANK ACCOUNTS 

Bank Accounts, or Bank Records, are typically setup in PrintBoss Select after the application is installed and provide 
options to work with your accounting software.  Additional records can be purchased as needed. 

PrintBoss Select provides a database, or Bank List, that stores information used to print checks.  Bank data is not 
pulled from the accounting software’s database.  The information stored can include the Bank Name, Bank Address, 
Bank MICR information, and Company Information for the account.  The MICR information includes the bank 
routing number, account number, and check number.  Since PrintBoss Select can store multiple bank accounts, there 
is normally some data from the accounting software that PrintBoss Select can use to select the correct bank record 
when a check is printed through PrintBoss Select.  Once the account is selected, PrintBoss Select can use any of the 
fields in the bank record as the source for commands.  In particular, the #MICR command is used to print the MICR 
across the bottom of the check 

Initially, PrintBoss Select provides 10 bank records for your convenience.  More accounts can be added by 
purchasing and installing a Bank Module.   Each module, or Bank Key, adds 5 blank bank records to the database in 
PrintBoss Select.  When the number of purchased bank accounts reaches 80 (14 modules), the number of available 
records becomes unlimited.  Contact Wellspring Software to purchase additional Bank Modules or visit our web 
site. 

See Appendix A for a more thorough description of the fields on the PrintBoss Bank Edit window. 

CREATE A BANK RECORD 

Fill in the fields that will be used for printing checks.  Sample data is provided for many of the fields.  If you do not 
want to use or display a field, make sure it is blank.   

1. Click on the Edit menu and select Bank List from the main PrintBoss Select window.  The PrintBoss Bank 
List opens.  Initially, the Bank Code for each record starts with Unused.   

2. Select the first available record.   
a. Select an Unused Bank if one is available. 

b. Click the plus  button in the menu bar if you have unlimited banks and need to add a new 
record or if you rebuilt your table after deleting records. 

3. Open the PrintBoss Bank Edit dialog. 
a. Double-click on the record; OR  
b. Click the Edit Bank button. 

4. Enter data for the appropriate fields.  The following steps include recommendations. 
a. Primary tab 
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i. Bank Code – Required.  This should match the checking account code used in your 
accounting software. 

ii. Bank Prompt – PrintBoss Select will duplicate the Bank Code in this field if it is left 
blank. 

iii. Bank Information – Typically the Name and Address 1 fields are used.  The Address 1 
field usually contains the city and state of the bank.  The other fields in this section are 
often blank. 

iv. Company Information – Fill in the fields to be printed on the check face.  Unused fields 
must be empty to prevent them from printing. 

1.  Name – The company name is entered when a logo is not used.   
2. 2nd Name – This field is available for a second name or d/b/a.  This field is often 

blank. 
3. Address 1 – Enter the street address for the company. 
4. Address 2 – Enter the city, state, and zip or postal code for the company. 
5. Address 3 – Optional; may contain country, phone, fax, or email information. 
6. Address 4 – Optional; may contain country, phone, fax, or email information. 

v. Fractional Code – enter as provided by your bank.  Use the slash ( / ) symbol to 
represent the fraction symbol (–). 

vi. Next Check Number – This field is ignored unless you are using accounting software, 
such as QuickBooks, that does not pass a check number to PrintBoss Select.  If this is the 
case, enter the next check number from the check registry.  PrintBoss will prompt the 
user to confirm or change this value at the beginning of each check batch.  This field will 
NOT update the check registry in the accounting software. 

vii. Confirm Check # at start of batch – See the Installation Notes you printed for your 
accounting software.  Typically, this is set to Auto…. 

viii. Include bank on Popup Bank Request List – Optional.  Typically, the word Unused is 
left at the beginning of the Bank Code for unused bank records and Suppress if 
"Unused" in Bank Code is selected from the drop down menu.  This will remove all 
unused bank records from the popup Bank Request List when a Bank Code match is not 
detected by PrintBoss Select. 

ix. Password Required at start of batch – Optional.  This feature provides the ability to 
limit the use of this bank record. 

x. Always Confirm Auto Bank Select Options – Optional.   
1. Always Confirm Auto Selection – This feature is only available when the 

Enforce Exact Bank Code Match and Allow for Selection when multiple 
Bank Codes match options are selected at the bottom of the Options / 
Configuration / Internal tab in PrintBoss Select. 
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2. Enable "Payroll" alias name – This feature is only available when Allow bank 
account to be AP and Payroll is selected at the bottom of the Options / 
Configuration / Internal tab in PrintBoss Select. 

b. MICR tab  

 

i. Routing Number – Enter this value exactly as it is provided by your bank, including 
dashes. 

ii. Account Number – Enter this value exactly as it is provided by your bank, including 
dashes.  Use periods to represent spaces.  Spaces, and not the periods, will display in the 
MICR Line. 

iii. Check Number – Select the value indicated by the Installation Notes printed for your 
accounting software.  Most accounting packages use CChkNo.  QuickBooks and Quicken 
use BBBBB or BChkNo. 

iv. Include US Funds flag (45) on MICR line – Select this option when the US Funds flag 
is required.  This is typically for Canadian checks written on US Funds. 

v. Custom Format – This field cannot be edited unless the Custom radio button under the 
Check Format Type section is selected.  This is not recommended. 

vi. Check Format Type – Choose Standard 8.5" Business Checks for most applications.   
c. Miscellaneous tab (Optional) 
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i. Miscellaneous Information – Optional.  These fields are available to accommodate 
special circumstances, such as adding a second logo to a check.  The Values field can 
contain the path for a logo, special value, or text.  The Description field can be edited to 
describe the item in the Values field. 

ii. Miscellaneous Flags 
1. 2nd Signature Line – Select this checkbox to add a second signature line to your 

checks for this bank record. 
2. Miscellaneous Flags – Optional.  These fields are available to accommodate 

special circumstances and evaluate to True when checked.  The Description field 
can be edited to describe the purpose of the flag. 

iii. Canadian Style Date/Amount – Select this checkbox if you want the style of the date 
and amount on the check to follow the CPA format. 

d. Signatures Logos tab (Optional) 

 

i. File Name – Enter the name, including the extension, or browse to select a Logo or 
Signature for the appropriate field.  The graphic files associated with these file names 
should be stored in the Logos folder of the PrntBoss directory folder.  These graphics are 
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bank specific and will only print when this bank record is used.  The field length is 40 
characters. 

ii. Position – Adjust the X (horizontal) and Y (vertical) position of the graphic.  These 
measurements are in inches from the left and top edge of the page, respectively. 

iii. Options – Enter an option to apply to the graphic.  For example, /Watermark adds a 
medium watermark to the graphic when the variable associated with this option is added 
to the form (see Appendix A). 

iv. Range Condition – Add a high and low dollar amount to determine when a signature 
should print on a check. Example:  Enter 10000 in the Lo field and 9999999 in the Hi 
fields of Signature 2 to only print the signature file associated with this field when the 
check amount is greater than$10,000 and less than $10 million. 

v. Size – Adjust the size of the Logo or Signature by inches (Width and Height) or 
Percent.  You cannot use both at the same time. 

vi. Align Address – PrintBoss version 5.736 and above include the options to align the 
address Below the logo or to the Right of the logo.  This feature automatically works with 
newer PrintBoss Forms included with PrintBoss 6.0 or above. 

e. Security tab (Optional) – See Bank Security later in this chapter. 
f. ACH Definition tab (Optional) – This tab contains ACH fields for this bank record used in 

creating an ACH file.  See Chapter 17, Ach Setup, for more information. 
i. File Header Record Fields - These are the fields referenced in the SignOn tab of the 

ACH File Editor. 
1. Immediate Destination – Enter the Routing number of the bank that will 

process the ACH file.  The field name is {bACHImdDstNo}. 
2. Immediate Origin – Enter the routing number for this bank record.  Normally, 

this is the same value as the Immediate Destination unless the bank provides 
other instructions.  The field name is {bACHImdOrgNo}. 

3. Immediate Destination Name – Enter the name of the bank for the Immediate 
Destination.  The field name is {bACHImdDstName} and may contain up to 23 
characters. 

4. Immediate Origin Name – Enter the company name.  The field name is 
{bACHImdOrgName} and may contain up to 23 characters. 

5. File ID Modifier – This field starts with A and should be incremented for each 
file printed in a single day.  The field name is {bACHFileIDMode} and is only 1 
character. 

6. Pre-Note Override if checked – This field should only be checked the first 
time an ACH is created for this bank record for the bank to test and should be 
removed after testing.  New recipients can be pre-noted in the Payee List. 

7. The following is an image of the SignOn tab for the ACH File Spec where these 
fields are used: 

 

ii. Company/Batch Record Fields – These are the fields referenced in the Header tab of 
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the ACH File Editor. 
1. Service Class Codes – Select the appropriate Service Class Codes from the drop 

down menu.  The field name is {bACHSvcClassCode} and contains 3 
characters.  The choices are: 

a. 200 – Mixed 
b. 220 – Credits Only 
c. 225 – Debits Only 
d. 280 – Automated 

2. Company Name – Enter the Company Name as it appears on this bank account.  
The field name is {bACHCompName} and contains 16 characters. 

3. Company Discretionary Data – Enter one or more codes to identify this batch.  
This is for company use only and is optional.  The field name is 
{bACHCompDisc} and contains 20 characters. 

4. Company Identification – Enter a specific company identifier, usually “1” 
followed by the Employer Identification Number (EIN).  The field name is 
{bACHCompID} and contains 10 characters. 

5. Standard Entry Class – Select the appropriate code from the drop down menu.  
The field name is {bACHStdEntryClsCod} and contains 3 characters.  The 
choices are: 

a. CCD – Corporate to corporate EFT 
b. PPD – Prearranged payment and deposit (consumer) 

6. Company Entry Description – Enter a description for this batch that will be 
communicated to the receiver, such as PAYROLL or PURCHASES.  The 
designation is established by the company.  The field name is 
{bACHCompEntry} and contains 10 characters. 

7. Originating DFI Identification – Enter the routing number with leading zeros.  
The field name is {bACHOrgDFIID} and contains 8 characters. 

8. The following is an image of the Header tab for the ACH File Spec where these 
fields are used: 

 

iii. Balanced File – Select this column when the bank requires a balancing entry for the 
credits (or debits) listed in the Detail section of the ACH file.  The fields will then appear 
on the Balance Record tab of the ACH File Editor. 

1. Routing Number – Enter the routing number with leading zeros as entered in 
the Originating DFI Identification field.  The field name is {bACHBalRout} and 
contains 8 characters.  A check digit is added by PrintBoss per the ACH Rules to 
create a 9 character field. 

2. Account Number – Enter the account number for this bank record. The field 
name is {bACHBalAcct} and contains 17 characters. 

3. Account Name – Enter the company name as it appears on this bank account.  
The field name is {bACHBalName} and contains 22 characters. 
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4. The following is an image of the Balance Record tab for the ACH File Spec 
where these fields are used: 

 

iv. Payee List – PrintBoss provides the option of using a Payee List to provide the required 
ACH information used on the Details tab of the ACH File Editor.  Alternatively, these 
fields may be assigned from data that is printed from the accounting system. 

1. (active) – Select the Payee List check box to activate this feature. 
2. Browse button – Select the folder “Browse” button to select the name of a 

Payee List.  The Payee List is created under the Edit menu.  Create a Payee List 
for this bank record before activating this option. 

3. Add Record – Click on the “add record” drop down menu to choose how to 
treat new records when there is no current match for the payee name.  The 
choices are: 

a. Create Empty Record in List – Creates an empty record with only the 

{DocRecip} name from the check batch.  The record will not be active 
in the Payee List. 

b. Ignore Payee 
c. Alert with option to Add/Ignore 

v. More Info – Click this button to view a list of fields that must be assigned from data 
printed from the accounting software or entered in the Payee List as well as optional 
fields to assign. 

5. Click OK on the PrintBoss Select Bank Edit window to save changes to the information. 

NOTE: 

Changes made to Logos or Signatures in a bank record only apply to that bank record.  If more than one bank 
record includes a logo or signature that requires an adjustment, the change needs to be made to each bank 
record. 

COPY/TAG/PASTE  

Occasionally, it is beneficial to copy part or all of the information from one bank record to another.  This is 
accomplished using the Copy/Set Tags / Paste / Clear Tags buttons at the bottom of the Bank Edit dialog as follows. 

COPY 
1. Select the Bank Record you want to copy and click the Edit Bank button to open the Bank Edit dialog.   
2. Click the Copy button.  Almost all of the fields from the current bank (on all tabs) will be stored on an 

invisible clip board.  These fields cannot be Pasted at this point.   
3. Proceed to Set Tags. 

SET TAGS 
Start with the instructions for Copy above.   
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1. Open the destination or new Bank Record.   
2. Click the Set Tags button to select all fields.  Only fields that are tagged will be filled from the clip board.  

Tagged fields are displayed in yellow.  Notice PrintBoss Select will not tag the Check Number, Check 
Format Type, or Custom Format fields on the MICR tab.  There are a couple of fields on the Primary tab 
that are not highlighted as well. 

3. Hold the CNTRL key and click in a field to remove the tag.  This will toggle off and on.   
4. Proceed to Paste. 

PASTE 
Start with the instructions for Set Tags above.   

1. Click the Paste button after you are finished removing or adding tags to the Bank Record fields. 
2. Proceed with Clear Tags. 

CLEAR TAGS 
This button will turn off the highlight on all fields.  

1. Click the Clear Tags button after you finish pasting fields.  This will not clear the data in the fields.   
2. Hold the CTRL button and click on a field to clear that specific field. 
3. Click OK when you are finished. 

ADDING BANKS 

PrintBoss Select comes with unlimited bank records.  Simply click on the plus (+) sign in the menu bar of the 
PrintBoss Bank List to add bank records.. 

BANK LIST MAINTENANCE 

PrintBoss Select has the ability to Import/Export bank lists beginning in version 5.31.1.  The user must first login as 
Supervisor (Administrator) before using this feature. 

IMPORT BANK LIST 
PrintBoss can import an Excel file saved as a *.csv file. 

1. Open Excel. 
2. Enter the column labels in Row 1.   

a. The labels need to exactly match the name and order of the PrintBoss bank list.   
b. You do not need to enter labels for columns if you don't have data.  PrintBoss will enter default 

values automatically. 
3. Enter or import the Bank Records by row.   

a. Do not leave blank rows.   
b. You cannot import more bank records than licensed in PrintBoss. 

4. Save Excel as a *.csv file. 
5. Open PrintBoss. 
6. Login as administrator. 

a. Click on the File menu and choose User Log-In. 
b. Enter the supervisor name and password.  The defaults are: 

i. Operator Name – Administrator or Supervisor 
ii. Password – ADMIN (This is the Master Password and may have been changed on the 

Security Settings window.  It is case sensitive beginning in PrintBoss v.5.71.3). 
7. Click on the Edit menu and select Bank List. 

8. Click on the Tools button  to the left of the Bank Code label. 
9. Select Import. 

10. Navigate to the location of the *.csv file. 
11. Select the *.csv file. 
12. Click Open. 
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PrintBoss Select will populate the Bank List with this data. 

EXPORT BANK LIST 
1. Open the PrintBoss Master Application window. 
2. Login as Administrator. 

a. Click on the File menu and choose User Log-In. 
b. Enter the supervisor name and password.  The defaults are: 

i. Operator Name – Administrator or Supervisor 
ii. Password – ADMIN (This is the Master Password and may have been changed on the 

Security Settings window.  It is case sensitive beginning in PrintBoss v.5.71.3). 
c. Click OK to continue. 

3. Click on the Edit menu and select Bank List. 
4. Hold down the Shift or Ctrl key to select a range of bank records. 

a. Shift allows you to select contiguous records. 
b. Ctrl allows you to select non-contiguous records. 

5. Right-click on the selected records and choose Export. 
6. Click Yes to continue. 
7. Enter a name and destination for the file. 
8. Click Save. 

DELETE BANK LIST RECORDS 

Single Bank Records can be deleted by selecting a record and clicking the minus  button in the menu bar or by 

right-clicking on a file and selecting delete.  The selected record will always have the arrow  in the left column. 

Multiple Bank Records can be deleted using the Shift or Ctrl keys to select a range of records.  Ranges are always 
highlighted in blue. 

1. Open the PrintBoss Master Application window. 
2. Click on the Edit menu and select Bank List. 
3. Select a range of Bank Records.  Use one of the following methods: 

a. Click on the first record in the range.  Hold the Shift key and click the last record in the range.  
The range will be highlighted in blue.  This method works for contiguous records. 

 

b. Click on the first record in the group.  Hold the CTRL key and click each record you want to 
delete.  The records in the range are highlighted in blue.  This method works for non-contiguous 
records. 

 

4. Right-click on one of the highlighted records and select Delete. 

NOTE: 

Be sure to right-click on a blue highlighted record before selecting delete.  Otherwise, the wrong record will be 
deleted.  In the example below, the record with the arrow will be deleted instead of the blue highlighted 
records. 
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REBUILD TABLE 
The Bank List table will automatically try to Rebuild after records are deleted.  This can only take place when no 
other user is using PrintBoss.  When the table does not rebuild, the total number of records in the list does not update 
to reflect the true number of records.  You can Rebuild the table manually when everyone is out of PrintBoss. 

1. Open the PrintBoss Master Application window. 
2. Click on the Edit menu and select Bank List. 

3. Click on the Tools button  to the left of the Bank Code label. 
4. Select Rebuild Table. 

PrintBoss Select will provide a confirmation window before rebuilding the table. 

SORT BANK LIST RECORDS 
There are two ways to sort records in the Bank List: 

1. Click on the drop down menu in the men bar and choose a sort order. 
a. Natural Order – The order the records were originally numbered (Unused Bank011, Unused 

Bank012, etc.) or imported. 
b. Bank Code Order – This is an alpha-numeric field. 
c. Bank Prompt Order – This is an alpha-numeric field. 
d. Bank Name Order – This is an alpha-numeric field. 
e. Company Name Order – This is an alpha-numeric field. 

2. Click on one of the darker gray labels to sort by that label.  These labels match the last four choices in the 
drop down menu. 

The sort order will return to Natural Order when you close the Bank List and reopen it. 

ADJUST MICR PLACEMENT 

The location of the MICR line is calculated by PrintBoss Select based on the directives passed in the #MICR 
command.  Typically, this placement is proper for a check at the bottom of an 11" page.  Sometimes there is a small 
difference in position from printer to printer, so a separate adjustment can be made in the Configuration of 
PrintBoss.  Once this is made, it should not need to be changed unless the printer, printer driver, or operating system 
is changed. 

The MICR Offset Adjustment is set in PrintBoss Select.  The adjustment can be both vertical and horizontal. This 
setting is global for all forms and is workstation specific.   

Select OPTIONS / CONFIGURATION from the main PrintBoss Select screen to access the adjustment settings. 

MICR ADJUST WIZARD 
Click on the MICR Adjust Wizard button to open a step by step adjustment wizard.  This wizard will prompt you to 
print a sample on the Wellspring Software check stock, compare the alignment to the preprinted Transit Character, 
and then prompt for adjustment directions.  Follow the prompts to adjust the placement until satisfactory.  Click on 
Finish to exit the Wizard.  Upon completion, the MICR Offset Adjustment values will be modified. 

MICR adjustment settings are saved locally on the workstation.  Even if PrintBoss is running 
from a shared drive, settings on each workstation can be adjusted without impacting the other 
workstations. 

MICR PLACEMENT RANGE 
As each piece of paper runs through the printer with slight variations, no two pages will print exactly the same.  For 
this reason, a range of placement is acceptable according to the American Banking Association and the Canadian 
Payments Association.  This range is indicated by the box around the transit symbol.  As long as the MICR transit is 
within this box the placement should be acceptable. 
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BANK SECURITY 

Security can be added to each Bank Record to define the users who may access the Bank Record.  This process 
starts with enabling bank security. 

SETUP GENERAL SECURITY (OPTIONAL) 
Click on the Options menu on the PrintBoss Master Application window and choose Security. 

1. Enter your Master Password.  The default Master Password is ADMIN.  The password is case sensitive 
beginning with PrintBoss version 5.71.3.  If this has been changed, contact your Administrator.  See 
chapter 11, Security Features, for more information. 

 

2. Click OK.  The Security Settings window opens. 
3. Click on the Enable User Security in Banks button at the bottom of the General Settings tab. 
4. Select Enable Bank User Security and click OK.  The name of the bank security button changes to 

Disable User Security in Banks. 

 

5. Select the Display ONLY primary fields in bank list browse… option to hide sensitive information on 
the Bank List and encrypt the key fields. 

    

6. Click on the Advanced User Rights tab. 
7. Click on the Plus sign (+) to setup users.  Only the User Name is required for bank security. 
8. Click OK to exit the User Edit window. 
9. Click OK to exit the Security Settings window. 

Once the bank security is enabled, log into PrintBoss as the Administrator. 
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NOTE: 

It is not mandatory to create user accounts on the Security Settings window.  Bank records can be secured by 
entering Windows Users names on the Bank Edit Security tab as described below. 

LOG-IN AS ADMINISTRATOR 
1. Click on the File menu and choose User Log-In. 
2. Enter the Operator Name for the Administrator/Supervisor (the default is Administrator). 
3. Enter the Master Password (the default is ADMIN).  The password is case sensitive beginning with 

PrintBoss version 5.71.3. The log-in window will close after a successful log-in. 

Next, add security to a Bank Record. 

SETUP BANK SECURITY 
1. Click on the Edit menu and choose Bank List. 
2. Select a bank and click the Edit Bank button.  Notice the Bank Edit window has a new Security tab. 
3. Select the Security tab. 
4. Click the Users Listed Here radio button.   

 

5. There are two methods for adding names to your security list: 
a. PrintBoss Defined Users 

i. The far right column lists the users defined in PrintBoss Security as described under 
Setup General Security above. 

ii. Select one or more name(s) from the right column and click the Add Selected PB Users 
button.  The name will move to the left column. 

b. Windows Users 
i. Click on the Add Windows Users button at the bottom of the right column.  The 

PrintBoss Windows User Addition window opens. 
ii. Enter the WinUserName of the person who should have access to this Bank Record. 

iii. Click OK. 
6. Click OK when you are finished to close the PrintBoss Bank Edit window. 

Only people in the Users with Rights to this bank account list will be able to open or edit this Bank Record. 
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Chapter 

9 
FORM FILES 

When PrintBoss Select captures a print job from the QuickBooks / Quicken, the 
PrintBoss Form File (.PBF) is the conductor that controls if and how all the data will 
be used. This includes: 

 Add background graphics and text to the form 
 Place data from the PrintBoss Bank Record 
 Select and place graphic/logo/signature files 
 Reformat  and use data passed by the accounting software 
 Add conditions 
 Manage copies 

STANDARD FORM FILES 

Standard check form files are provided for QuickBooks / Quicken in order to expedite 
the installation and use of PrintBoss Select.  These forms are installed automatically 
during the PrintBoss Select setup process.  These are the only forms included with 
PrintBoss Select. 

 With PrintBoss Select, users can modify existing Form Files and, under special 
circumstances, create new Form Files. 

NOTE: 

PrintBoss Select is only capable of automatically utilizing forms with the original form name.  A list of 
the form files PrintBoss Select will automatically use follows: 

Document Form Name 
 Wallet Check QB_wCk1 
 Standard 3-Up QB_sCk1  
 Voucher Check QB_CHK4, QB_CHK4T, QB_CHK4M 
 Voucher Image Check (Canadian_ QB_CkVI1, QB_CkVIM, QB_CKVIT 
 Deposit Slip QB_DPST2, QB_DPT2B, QB_DPT2M 
 Online Payroll Check QB_OLPCK 
 Intuit Full Service Payroll IN_FSPR, IN_FSPRM, IN_FSPRT 

Quicken and Online AP both work with QB_Chk4. 

CREATE A NEW FORM FILE 

PrintBoss Select is designed to use its default forms (i.e. Qb_Chk4.pbf, etc.).  Please upgrade to the Enterprise 
edition of PrintBoss if you need to create new Forms. 
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MODIFY FROM THE DOCUMENT VIEW 

Both the Form Editor and the Document View can be used to modify a form whether it is a copy or a new form.  
Many users find the Document View more convenient for editing since the objects can be viewed immediately, 
though certain elements are not accessible through the View. 

1. Open the PrintBoss Master Application window. 
2. Click the Edit menu at the top of the window and select Form Files. 
3. Select your form and click View.  This opens the View of Form window.  Clarity will depend on the 

monitor's size and resolution. 
4. Double click on an object to edit its properties. 
5. Click OK on the Properties window to save your changes. 
6. Right click anywhere on the form to Insert a new object. 

Across the top and down the left edge of the View are rulers to indicate coordinates on the page.  As you move the 
cursor over the document, slight line indicators mark the matching coordinates on the rulers and a field above the 
ruler displays the numeric coordinates.  The coordinates are measured in inches from the top left corner of the page. 

A light blue border around the edge of the document indicates the margins or unprintable area of the page.  This area 
adjusts according to the LaserJet printer selected within the PrintBoss Select program and the orientation of the 
form. 

 Above the ruler to the far left is a drop down menu to adjust the view’s magnification.  This is similar to a zoom. 

 
 

  

The Copy Number to the right of the Magnification Percentage allows you to select different copies associated with 
this form.  Zero represents the original document.  Use the up arrow to navigate to additional copies if there are 
multiple copies set for this form.   The down arrow navigates back towards the original.  Any conditional items 
based on copy number will be reflected in the View when the copy is selected.  Copies are set and defined on the 
Form Editor. 

The button to the right of Matching Coordinates appears when duplex printing is selected on the Special Controls 
tab of the Form Editor.  This button indicates whether the view is of the Front or Back of the page.  Click on the 
button to toggle between sides. 

The Dollar Value field is located to the right to the Page Side Selector (or Matching Coordinates when duplex 
printing is not selected) and is used for testing objects that only appear based on a conditional Amount Range.  
Initially, the dollar value is set to 0.00.  Enter an amount to test the AmntRange condition when it is used. 

 Please see PrintBoss Conditional Commands at the end of this chapter for more information. 

NOTE:  

All items inserted through the View will be placed at the bottom of the Footer Objects tab of the form.  The 
location of these objects can only be adjusted in the Form Editor.  Location and order can affect how the 
objects appear on a page. 

INSERT AN OBJECT IN THE DOCUMENT VIEW 

Right click anywhere on View of Form to access the following options: 

Copy 
Number 

Simulated 
Document Amount Zoom 

Matching 
Coordinates 

Page Side 
Selector 
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EDIT CURRENT OBJECT 
This option opens the Properties dialog for the selected (highlighted) item in the View. 

DELETE CURRENT OBJECT 
This option deletes the selected (highlighted) object from all copies and accounts that use this form.  A prompt will 
confirm deletion or allow the user to cancel. 

COMMENT CURRENT OBJECT 
This option comments the selected object in the View without actually deleting it.  An object cannot be viewed when 
it is commented.  The command will remain on the objects tab of the Form Editor with a pipe symbol (|) in front so 
that it is not processed.  A prompt will confirm this action or allow the user to cancel. 

INSERT OBJECT 
This option adds an object by opening the appropriate Properties dialog. A brief description of the use of each object 
follows: 

Object Description 

Barcode Changes data into a barcode.  See #Barcode for more information.   

Block Inserts a block on the document.  Rectangle (#RECT) is more commonly used. 

Canadian Date Formats the document date value according to the Canadian format standard. 

Graphic Inserts a #PIC object to place a graphic file, such as a logo, on the document. 

Grid – relative Inserts a #GRID object with a standard 4-column advice format. 

Grid – horizontal Inserts a #HGRID object.  #GRID is more commonly used. 

Grid – vertical Inserts a #VGRID object.  #GRID is more commonly used. 

Line Inserts a horizontal line, such as a signature line, on the document.  Second signature lines 
are usually selected from the Misc tab of a Bank Record rather than inserting a new line. 

Rectangle Inserts a rectangle.  Rectangles are often used with Security Back patterns to hide sensitive 
information, such as social security numbers. 

Secure Seal Inserts an encrypted seal containing information from the check file used as verification by 
the bank.  The bank must have appropriate technology to decipher the encrypted seal. 

Signature Inserts a #PIC object to print an electronic signature file. 

Text Inserts a #Text object to print static text or text referenced by a variable. 

Text – Multi-Line / 
Vertical 

Inserts a #VText command.  This is most frequently used to place the words Pay To The 
Order Of vertically on a check. 

Text – secure Displays check amount in blocks or with a pattern and is used to protect against fraudulent 
changes on a check.   
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SHOW FORM OBJECTS 
This option displays the objects from the PrintBoss Select Form File in addition to the captured text from the 
accounting software when it is selected (check marked). 

SHOW BLANKED CAPTURED TEXT 
This reveals the raw data captured from the accounting software that has been hidden with a PrintBoss Select 
command such as #Assign, #RegionMove, or #BlockMove.  This option is only useful when editing a work file or 
archive file. 

SHOW INFO PANEL 
This option opens a panel at the bottom of the View displaying the order and coordinates of both objects and 
captured data shown in the form.  Either click on the desired object or data or use the slider bar to move quickly 
through objects and data in the order they were placed on the form.  The field after the slider displays the order of 
the item, such as item 47 of 225.  The matching coordinates field displays the coordinates of the selected item.  The 
last field displays the text or description of the item. 

 

 

VIEW RAW CAPTURE 
This option strips out all of the PrintBoss Select form elements and reveals only the data from the accounting 
software in its original format.  This option is only useful when editing a form from the work file or archive file. 

DISPLAY ASSIGNMENTS 
This option opens the form Assignments window containing a list of all available variable assignments for this form.  

 See #Assign in the commands section later in this chapter. 

EXIT 
Exit the view of this form.  If changes have been made, you will be prompted to save or abandon changes prior to 
exiting. 

EXIT THEN EDIT FORM 
This option leaves the View of the form and automatically opens the Editor of the form.  You will be prompted to 
save or abandon changes prior to opening the Editor if changes have been made in the View of the form. This is 
helpful to quickly move from viewing a work file to working in the Form Editor. 

FORM EDITOR 

The Form Editor has several tabs and options for customizing forms or handling special needs.  There are two ways 
to access the Form Editor after opening the PrintBoss Master Application: 

1. Click on the Edit menu and choose Form Files.  Then highlight a form and click the Editor button. 
2. Right click anywhere on a View and choose Exit then Edit Form.  PrintBoss will notify you to save changes 

before continuing if applicable. 

The primary tabs that appear when you open the Editor include: 

Settings Comments  
Special Controls RunTime Objects 
Block Mirrors Footer Objects 
Multi-Parts & Printers Misc 

Other tabs may appear depending on the settings selected in the Form Editor.  These include: 

 

 

Slider Order 
Matching 
Coordinates Description 
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Setting Location Tab 

Duplex Printing Special Controls tab Page Back Objects 

Positive Pay Multi-Parts & Printers tab 
Positive Pay / ACH 
File Editor 

Check box under Access  Special Controls tab Proprietary 

A detailed description of the Form Editor is in Appendix B of this manual. 

FORM FILE COMMANDS 

PrintBoss Select Form Files combine data from the accounting software, the PrintBoss Select bank record, as well as 
graphics and text to create a final document.  The most common commands used to accomplish this task are 
described in this section.  See Appendix B for a list of the remaining commands. 

NOTE: 

Type the # symbol followed by the command in the appropriate Object tab.  Then double click on the text to 
open a dialog box displaying the parameters and options for the specific command. 

#Assign 
#Assign 'VarName', 'Value' [, CaptXRange, CaptYRange [, Options]] 

There are several different assign commands: 

 #Assign 
 #AssignLines 
 #AssignmentsBlock 
 #Assigns 

Use the #Assign command to assign a value to a variable name.  The other assign commands can be found in 
Appendix B of this manual. 

#Assign uses two methods to assign a value.  The first method is to enter a static value in the Variable Value 
parameter field.  The command can be placed in any Object tab when using this method.  If an assignment occurs 
more than once, the last assignment created is always the current one.  Assignments are processed in the order they 
appear in the Objects tab. 

The second method is to specify coordinates to capture value(s) from the data supplied by the accounting software.  
The #Assign command MUST be in the RunTime section when using this method.  The assigned variable can only 
be referenced in Footer or Page Back Objects since the value is not supplied until the accounting software data is 
evaluated between the RunTime and Footer sections.  Select the Pre-process Assignments box on the Special 
Controls tab when an assignment needs to be referenced in the RunTime Objects tab.  This method is useful for 
repositioning or reformatting captured data passed by the accounting software.  It can also be used to assign the 
DocNo, DocAmnt, DocRecip, DocDate, and DocMisc as well as adding conditional elements.  One of the options 
for this command blanks out the original location of the data after it is captured. 

All captured variables can be used in #Text commands, as components of conditional statements, and as components 
of loops and counters.  In addition, they can be used in positive pay scripts, e-mails, fax messages, and as parts of 
dynamic file names for PDF and Positive Pay files.  The dynamic file name feature is only available in the 
Enterprise edition of PrintBoss. 

The following is a description of the parameters for the #Assign command. 

VARNAME 

The Variable Name can be a variable expected by PrintBossSelect, such as DocNo, or any arbitrary name. 

VALUE 

Only enter a static Variable Value when the CaptXRange and CaptYRange (Capture Coordinates) are not passed to 
PrintBoss Select.  If CaptXRange and CaptYRange are passed, this parameter is usually left blank.  When both the 
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Variable Value and Capture Coordinates exist, PrintBoss Select will only use the Variable Value when no value is 
returned for the Capture Coordinates.  For example: 

#Assign "EmailTo", "Support@WellspringSoftware.com" – where EmailTo is the VarName and the email 
address is the Value.  No coordinates are assigned. 

#Assign "DocNo","", 7.100, 0.65 – where DocNo is the VarName, the Value is blank, CaptXRange is 
7.100, and CaptYRange is 0.65 

CAPTXRANGE, CAPTYRANGE 

These are the coordinates of the captured data. You can determine the coordinates for a captured field through the 
work file.   

1. Open the PrintBoss Master Application. 
2. Click on the File menu in PrintBoss and select Open Document Work Files.   
3. Select the desired work file and click on the Browse button. 
4. Select a document and click the View button.   
5. Right click anywhere on the View and choose View Raw Capture.   
6. Double click on the object you want to capture.  The Captured Text Command Properties dialog opens. 

 

7. The beginning of the capture ranges are displayed as Inches from Left (X) and Inches from Top (Y).  
8.  Select the Click to Assign to Variable button to capture these coordinates.  The Assign Command 

Properties dialog opens. 
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9. Enter a Variable Name.   
10. The Capture Coordinates ranges are predefined from the selected data.  You may adjust the +/- values or 

click on that button and change it to a to range. 
11. Select the desired options, such as Blank Out After Capture. 
12. Click OK on the Assign Command Properties dialog to save changes. 
13. Click Close on the Text Command Properties. 
14. Close the View and select Yes to save the assignments. 

NOTE: 

Capture ranges can be entered as inches with a decimal or thousandths of an inch with no decimal. 

#Assign 'DocNo', '', 7.100, .65 

Or  #Assign 'DocNo', '', 7100, 650 

Often the location may vary slightly based on the length of the string.  You can assign a range using a dash: 

#Assign 'DocNo', '', 7.00-7.200, .65 

Alternatively, a slash represents a Plus or Minus (+/-) amount: 

#Assign 'DocNo', '', 7.100/.1, .65 

The #Assign command is usually entered by clicking on the Click to Assign to Variable button on the Captured Text 
Command Properties dialog mentioned above.  This naturally pulls in all the coordinates and places the new 
command at the top of the RunTime Objects tab. 

The following lists the most common options that may be used with the #Assign command. 

OPTIONS 

Option Description 

1 Make only 1 assignment per capture field.  This option is valuable when there are several capture 
fields close together that may overlap with this assignment range. 

A Add together fields in the horizontal range specified by the CaptXRange. 

B Blanks out the entire field after the assignment is captured.  This prevents the data from displaying 
in an unwanted location on the document. 

L Left trim the captured field (eliminates any blank characters to the left of the captured field). 

R Right trim the captured field (eliminates any blank characters to the right of the captured field). 

S Trim choices applied after Segments appended 
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W Capture raW text objects only.  This option only captures items from their original location – not 
items moved with a #RegionMove or #Block command that might share the same coordinates.  This 
option is checked by default and should be used whenever assigning data captured from the 
accounting software. 

Z Use last captured value instead of first 

#Barcode 
#Barcode X, Y, Barcode Height, Options, "Barcode Value" 

This command is used to print a Barcode.   

 

The top left corner, center, or top right corner is defined with the X and Y coordinates. The Barcode Height is also 
assigned.  

The following Symbologies can be specified as options. 

Symbology Character Type 

Code 3 of 9 alphanumeric 

UPC Version A numeric only 

UPC Version E numeric only 

Postnet Code numeric only 

Interleaved 2 of 5 numeric only 

Codabar  numeric only 

Code 93 alphanumeric 

Code 128 alphanumeric 

The option of /SC prints the text characters below the barcode.  This option is a check box in the Barcode Command 
Properties dialog. 

The Barcode Value can be either a variable that references captured text or specific characters.  For example: 

#Barcode 6.7C, 1.000, 0.850, /SYM:C39, "{DocNo}" 
#Barcode 6.7, 1.000, 1.000, /SYM:PNT, "34580" 

The first example centers the Barcode at 6.7 inches horizontally and 1 inch down from the top with a height of 0.85 
inches.  The symbology is Code 3 of 9 and the variable DocNo defines the Barcode.  The second example starts at 
6.7 horizontally and 1inch down from the top with a height of 1 inch.  The symbology is Postnet Code and the 
Barcode value is 34580. 
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#Block 
#Block X1, Y1, X2, Y2, Fill [, Options] 

The Block command is used to place a block on the document.  The top left and bottom right corners are defined.  
By default, a black rectangle is drawn on the form.  Options include fill patterns, corner radius, and shaded edges 
(often used for the top legend row of a table).  This command has been replaced by #Rect. 

X1, Y1  
These coordinates represent the location of the top left corner of the block in inches from the left and top edge of the 
paper. Coordinates can be entered in thousandths of an inch. 

X2, Y2 
These coordinates represent the location of bottom right corner of the block. 

OPTIONS 

Option Description 

/Rnnn Corner Radius of nnn inches.  For example, /R.1 is a 1/10" radius 

/STnnn Shade Top nnn inches 

/SLnnn Shade Left nnn inches 

 /SBnnn Shad Bottom nnn inches 

 /SRnnn Shade Right nnn inches 

/SHDnnn Shadow extends nnn inches from block 

The following example prints a white box near the top of the page outlined in black with rounded corners. 

#Block 3.25, .3, 4.75w, 1.0h, W_,  /R.1 

FILLER 

Filler Description 

T Clear 

W White (prints Opaque) 

S Shade 

B Black 

G/ or G0 …G9 Gray scale shading from lightest to darkest 

P1 or PH Horizontal Line Pattern 

P2 or PV Vertical Line Pattern 

P3 or PB Backward Diagonal Pattern 

P4 or PF Forward Diagonal Pattern 

P5 or PR cRrosshatch Pattern 

P6 or PA diAgonal Crosshatch Pattern 

Color The color codes are too numerous to list.  The codes display as numeric 
strings, for example 0255 is red 

NOTE: 

Adding an underline following the fill descriptor will outline the block with a black line. 

#BlockMove 
#BlockMove X1, Y1, X2, Y2 [, DestX, DestY [, DestX2, DestY2]] 

This command is used to move or remove whole blocks of text captured from the accounting software.  This 
operates the same as the #RegionMove command, except this sets X (or horizontal) boundaries while RegionMove 
includes the entire width of the page. 



PrintBoss Select 56 Electronic Copy 

Every text object included in the block move needs to have its beginning coordinates inside the block.  If only the 
beginning character of a long string occurs inside the block, the entire string will be treated as part of the block. 

 This command must only be placed near the top of the RunTime Objects section.  #Block 
and #RegionMove commands normally need to be processed prior to all other commands 
except #Assign.  

 

X1, Y1 
These coordinates define the top left corner of the block to be moved or removed. 

X2, Y2 
These coordinates define the bottom right corner of the block to be moved or removed. 

DESTX, DESTY 
These coordinates define the top left corner of the destination.  When these parameters are not provided, the text 
objects inside the block are removed (deleted). 

DESTX2, DESTY2 
These coordinates define the bottom right corner of the destination.  The source block will be stretched or reduced to 
fit this destination block.  When these parameters are not provided, the destination block will be the same size as the 
source.  

#CanadianDate 
#CanadianDate X, Y, Font Size, "date", "Mask"[, Color[, Frame[, DateInMask[, SuppressLegends]]]] 

This command formats a date in the style required by the Canadian Payments Association for their image ready 
standard called the "CPA Standard 006".  This command places a letter under each numeral in the date indicating 
the part of the date it represents.  Both English and French options are available.  A frame may be selected to appear 
around or behind the numerals.  The word "Date" automatically prints to the left of the formatted date. 

 

The Canadian Date command is automatically triggered by the Canadian Style Date/Amount flag on the 
Miscellaneous tab of the Bank Edit dialog for all standard PrintBoss Select forms. 
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#Grid 
#Grid X1, Y1, X2, Y2[, Options] 

The Grid command creates a frame and draws horizontal and vertical lines within the frame.  The coordinates for 
each line are relative to the frame.  Options provide further modifications with corner radius, shadow, edge shading, 
and line color.  In most cases, #Grid is more effective than #HGrid or #VGrid commands since all the lines within 
the Grid are relative to the top left corner of the grid, allowing the grid to be easily moved or dragged.  Use this 
command to create the advice grid and the Date/Amount grid on a check or the grid for an invoice or packing slip. 

 

X1, Y1 
These are the coordinates for the top left corner of the frame in inches from the left and top edge of the paper.  The 
coordinates may be entered in thousandths of an inch. 

X2, Y2 
These are the coordinates for the bottom right corner of the frame. 

XA, XB…XZ 
This parameter represents any number of lines drawn vertically down the frame.  Each line is defined as the distance 
in inches from the left edge of the frame. 

YA, YB…YZ 
This parameter represents any number of lines drawn horizontally across the frame.  Each line is defined as the 
distance in inches from the top edge of the frame. 

OPTIONS 

Corner Radius 
/Rnnn where nnn is the radius size.  For example, /R.1 is a corner radius of 1/10th of an inch. 

Shaded Edges 
/STnnn (Shade Top), /SLnnn (Shade Left), /SBnnn (Shade Bottom) or /SRnnn (Shade Right) where nnn is the width 
of the edge shade in inches. 

Shadow Width 
/SHDnnn where nnn is the width of the shadow in inches. 

Line Color 
/0LC followed by a number representing a color.  The color number can be 4 to 8 digits. 
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#Line 
#Line X1, Y1, X2, Y2[, Fill [, Options]] 

The #Line command functions the same as the #Block command and is often used to draw signature lines on checks.  
A vertical line has identical X1 and X2 coordinates.  A horizontal line has identical Y1 and Y2 coordinates.  The Y 
coordinates are labeled as Inches from Top on the Line Command Properties dialog. 

 

#MICR 
#MICR "MICR string" [, Options [, X [, Y]]] 

This command prints the special MICR line at the bottom of a check.  Normally, the location is completely 
calculated by PrintBoss based on the length of the form.  Options may be used to select middle or top check stock, 
or use the X and Y to explicitly place the MICR.  The MICR string is most often pulled from the Bank List by using 
the following line in RunTime Objects: 

 #MICR "{BMICR}" 

MICR STRING 
This string must be entered accurately.  Each character (including blank spaces) must be entered exactly as it 
appears on an existing check.  There are three characters that appear on the MICR line of a check that cannot be 
reproduced with any computer keyboard key.  Therefore, we have assigned replacement characters for the MICR 
line characters listed in the following table: 

Symbol Description Represented By Alternate Chars 

 Transit [ :    A 

 On Us / <   C 

 Dash - =    D 

 Amount $ ;     B 

 
The left portion of the MICR line is the Check Number.  Since this changes from check to check, a variable needs to 
be entered instead of typing a specific number.  The available variables are: 

{BChkNo} = Check number pulled from bank record with no leading zeros 
BBBBBB = 6 digit check number pulled from bank record – left zero filled 
BBBBBBBB = 8 digit check number pulled from bank record – left zero filled 
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{CChkNo} = Check number captured from accounting software with no leading zeros 
CCCCCC = 6 digit check number captured from accounting software – left zero filled 
CCCCCCCC = 8 digit check number captured from accounting software – left zero filled 

The following illustrates a common MICR string.  Periods are used to represent spaces. 

 /{CChkNo}/ [123456789[ .123-12345/ 

OPTIONS 

T 
Places the MICR line for a top check (3.5" check). 

B 
This option places the MICR Line for a bottom check relative to the bottom of the form.  This is the default value. 

Mn.nnn 
M places the MICR Line relative to a check section (i.e. perforation) that ends n.nnn inches from the top of the page. 
For example, an 11" page perforated into sections of 3.5, 3.5, and 4.0, with a check in the middle would be M:7.00. 
An 11" page perforated into sections of 3.67, 3.67, 3.67, with a check in the middle would be M:7.333. 

N 

No check number segment of the MICR line is printed. This is used for deposit slips. 

BR 

This option includes the MICR Line in the check copy (mirrored block) section usually located at the top of the 
page.  The length of the Block Mirrors on the Form Editor may need to be adjusted to include the MICR Line in the 
source block.  The MICR Line will display at full size and not reduced since the characters are not standard text. 

X and Y 
This is optional and is rarely used since PrintBoss automatically places a line.  If the X is 0 or blank, PrintBoss will 
place the line relative to the placement of the Routing Number section of the MICR line.  When a value for X is 
passed, the line is explicitly positioned according to the value of X.  The same is true for Y.  The vertical placement 
is relative to the bottom of the form when there is no value for Y. 

Include in Mirror Blocks 
The MICR line can be included in Block Mirrors and displayed in the check copy near the top of a check.  Select the 
Include in Mirror Blocks option on the MICR Command Properties dialog and extend the End of source block on 
the Block Mirrors tab of the Form Editor to display the MICR line in the check copy.  The MICR line will display at 
full size and not reduced since the characters are not text. 

NOTE: 

It is best to adjust the placement of the MICR line via the MICR Offset Adjustment fields in the Configuration 
Settings of PrintBoss Select.  The settings in Configuration are workstation specific.  Adjusting the placement 
in the form impacts all users. 

#PIC 
#PIC X, Y, "GraphicFileName" [, Options [, SigDiskDrive]] 

This command prints a graphic file at the location specified by the coordinates.  It will accept graphic files with the 
formats of BMP, PCX, JPG, or SIG (Wellspring Software encoded signature file).  Graphics can be added using 
variables, file paths, or as embedded files. 

NOTE: 

MICR toner is only available in black.  If the bank requires MICR ink, all logos printed with the checks will 
print monochromatic regardless of any color used in the graphic file. 
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X, Y 
These coordinates represent the location of the left top corner or the graphic, in inches, from the left top EDGE of 
the paper.  Coordinates may be entered in thousandths of an inch.  Variables referencing fields in the Bank Record 
may also be used (see graphic above for an example). 

GRAPHICFILENAME 
This is the name of the graphic file to print.  If no path is provided, PrintBoss Select will look in the Logos folder of 
the PrintBoss Home directory.  The file extension must be used to help PrintBoss Select determine the file type.  The 
graphic file may also be added from the Embedded File Select list on the Misc tab of the Form Editor. 

OPTIONS 
Any of the following options can be selected: 

Option Description 

600 Forces image to be printed in 600 dpi instead of the default 300 

REV Reverse prints black to white and white to black 

Show Shows errors if they occur 

Hide Does not report file read access errors if they occur 

Size:nnn Adjusts the size according to this percentage (100=full size, 50=half size, etc) 

SizeX:nnn Adjusts the horizontal size to the specified value in inches 

SizeY:nnn Adjusts the vertical size to the specified value in inches 

Watermark Prints graphic with gray instead of black 

Watermark:n 
Same as Watermark except n is replaced by B, M, or L for Bold, Medium, or Light. 
The value is medium by default. 

SIG DISK DRIVE LETTERS 
PrintBoss checks the listed drive(s) for a security disk when a .sig file is selected.  PrintBoss assumes the A:\ drive 
contains the disk when no drive letter is supplied.  A series of drive letters may be entered and each specified drive 
will be scanned until the target sig media is found.  Commas are not necessary between drive letters (ex:  DEFG).  
The media may be a floppy disk, CD, or USB flash drive. 
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#PrinterOverride 
PrinterOverride “Name of Windows Printer Driver” 

The PrinterOverride command overrides the printer set on the Multi-Parts & Printers tab of the PrintBoss form, 
including the default printer.  This command assigns a specific Windows printer and often includes conditions.  For 
example: 

#[C,1][Inu, "St. Louis", ÷{Location}÷]PrinterOverride "HP Color LaserJet 4700 PCL 6" 

This example assigns a specific printer only for Copy 1 when the string “St. Louis” is in the Location variable.  This 
command can also be used in #IF/#ElseIF/#EndIf commands. 

Enter the exact printer name as it appears in the Windows printer list.  Double click on the #PrinterOverride 
command to select the printer name from a drop down menu to ensure an exact match. 

#ProcessPage 
#ProcessPage [Parameter] 

The page will process when the parameter evaluates to True.  Often #ProcessPage will specify the document page in 
the condition.  For example: 

#[Copy, 4]ProcessPage [!Empty, {EmailTo}] 

PrintBoss will only examine this condition on the 4th copy and process the page if the variable EmailTo does not 
resolve to an empty value. 

NOTE: 

The Pre-process Assignments ‘Yes’ or ‘Special’ option MUST be selected on the Special Controls tab of the 
Form Editor to use the #ProcessPage command (EDIT / FORM FILES / <highlight form> / EDITOR / 
SPECIAL CONTROLS).We recommend selecting Special. 

#Rect 
#Rect X1, Y1, X2, Y2 [, corner radius[, outline width[, fill of line[, color background[, pattern]]]]] 

This command generates a rectangle with control over the size, thickness, and fill of the shape.  This is often used to 
create a patterned rectangle behind a text object to prevent fraudulent changes to a document.  A selection of 
patterns is provided to choose from.  The most common is the zigzag pattern. 

This command is also used for Negative Printing.  The Vertical Fade or Horizontal Fade are the best choices to use 
for the background.  Overlay white lettering with a separate #Text command. 

 



PrintBoss Select 62 Electronic Copy 

CORNER RADIUS 
This parameter defines the shape of the corners.  No radius is a 90 degree corner.  Larger values equate to softer 
edges. 

OUTLINE WIDTH 
Outline width, or Line Width, defines the width of the rectangle outline.  The default width is .009 inches. 

FILL OF LINE  
A fill may be defined if the line has a discernable width.  This is also called Outline Color Select. 

COLOR BACKGROUND 
Define a background color for the shape.  The background color, or Inner Fill Color Select, is behind the security 
pattern in the center of the rectangle. The default is black. 

PATTERN 
There are several options for the pattern, or Security Back, in the center of the rectangle: 

0 = none 1=vertical fade 
2= horizontal fade 3= zig zag fine 
4 = zig zag medium 5 = zig zag course 
6 = half circles fine 7 = half circles medium 
8 = half circles course 

For example:  

#Rect 4.7, 9.8, 8.15, 10.34, 0.10, 0.020, B, W, 3 (shown in the graphic above) 

The object masks the signature line as: 

 

#RegionMove 
#RegionMove StartRegion, EndRegion [, StartDestRegion [, EndDestRegion]] 

This command is used to move or delete whole regions of text captured from the accounting software.  Moved 
regions can be compressed or expanded proportionately by entering both a start and ending destination. 

This operates the same as the #BlockMove command with the exception that the horizontal boundaries are the left 
and right edges of the page.  For example, if the accounting software prints a check with an advice at the top of an 
11" page, the #RegionMove can move the advice to the center of the page.  If the accounting software is passing two 
advice sections, use this command to delete one of the advices in order to use the PrintBoss Block Mirror with its 
compression feature to print the secondary advice section. 

NOTE: 

This command must only be placed in the RunTime Objects section. This command, along with the 
#BlockMove command, should be used prior to other commands except #Assign. 
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STARTREGION 
This parameter is also known as the Block Source Dimensions and defines the start of the region in inches from the 
top of the page. 

ENDREGION 
Define the end of the region in inches from the top of the page. 

STARTDESTREGION 
This parameter is also known as the Block Destination Dimensions and defines the start of the destination of the 
selected region in inches from the top of the page.  The text within the region will be deleted if this parameter is not 
defined. 

ENDDESTREGION 
Define the end of the destination of the selected region in inches from the top of the page.  The source region will 
proportionately fit between the destination start and end when this parameter is defined.  Otherwise, the region will 
be moved at its original size. 

#SecureSeal 
#SecureSeal X, Y, "seal image", "<Text>", "<Recipient>", "<Number>", "<Amount>", "<Date>", "<Bank>", 

"<Routing>", "<Account>" [, Options] 

SecureSeal provides added security supported by some banks.  This command prints an encoded graphic image on 
the check containing information such as the check amount, date, payee, and check number.  If the graphic is altered 
or the information on the check does not match the information embedded in the graphic, the bank will not process 
the check. 

 

For more information about Enseal’s SecureSeal, contact Fiserve at www.imagesoft.fiserv.com or your bank. 
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X, Y 
The coordinates represent the distance of the left top corner of the Secure Seal graphic, in inches, form the Left Top 
corner of the page. 

SEAL IMAGE 
The Seal Image parameter specifies the location of the file used to create the Secure Seal image.  Templates for the 
image are stored in the SecureSeal folder of the PrintBoss Home directory. 

CHECK INFORMATION 
The next several parameters represent information originally printed on the checks.  These include the following. 

Parameter Description Variable 

Recipient The name of the recipient or payee of the check.   DocRecip 

Number Check number. DocNo 

Amount The amount of the check. DocAmnt 

Date The date on the check. DocDate or RecDate 

Bank The name of the bank from which the funds are drawn.  BName 

Routing Routing number of the bank. BMicrRoutNo 

Account Bank account number for the check. BMicrAcctNo 

These variables allow the parameter information to adjust dynamically for each check in the batch.  They also ensure 
the information on the check matches the information in the Secure Seal. 

#SecureText 
#SecureText X, Y, "<Font>/<Size>/<Style>/<Color>", "<Text>" [, Options] 

This command is used to protect against fraudulent changes on a document. All current PrintBoss Select check 
forms include this security feature.  
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There are two options for the Secure Text Type: Custom and Standard Block-Numeric. 

CUSTOM 
This option can be used with both alpha and numeric text.  It includes a patterned rectangle behind the text.  There 
are a few patterns to choose from, but the default is ZigZagMed.  The rectangle automatically sizes to fit the text. 

 

STANDARD BLOCK-NUMERIC 
As the name implies, this option can only be used with numeric amounts and is specifically used for the amount of a 
check.  It is nearly impossible to modify the printed check amount with this option. 

 

Enlarged for better viewing 

TEXT 
Normally a variable is entered in the Text field to dynamically update the check amount information for each check 
in the batch. 

#SkipPage 
#SkipPage 

This command tells PrintBoss to skip the processing of a page.  A condition must be placed on this command or all 
pages will be skipped and nothing will be processed!  The SkipPage command may be in either the RunTime 
Objects or Footer Objects tabs.  Pre-process Assignments MUST be checked on the Special Controls tab of the Form 
Editor to use the #SkipPage command. 

Unlike the #ProcessPage command, the SkipPage command only skips and places an “S” in the printed column of 
the work file or places a “s”, indicating an error.  It does not provide a condition to process a page.   

 See Conditional Commands later in this chapter. 
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#Text 

 See Chapter 10, #Text Command. 

#VText 
#VText Xc, Y, Font/Size, Spacing, <Text> 

This command prints text on incrementing lines.  Each line may be a single character or it may be a phrase in a 
multi-line text object.  One common use is on invoices, credit notes, etc. for the Sold To and Ship To labels in the 
address boxes.  For example: 

#VText 4.50c, 2.15, Arial/10, 0.130, "SHIP TO" 

 

This command centers the characters at 4.50 inches from the left edge of the page.  The top of the first character 
starts at 2.15 inches down from the top edge of the page.  The top of each character thereafter is 0.13 inches below 
the top of the previous character. 

Another common use is to print a captured address assigned to a multi-line variable called {Address}. 

 #VText 1.05, 8.1, Arial/10, .15, "{Address}" 

Several lines of text can be entered into the VText command separated by commas to indicate line returns.  Be sure 
to use a delimiter such as quotes around the series of text. 

 #VText 1.040, 8.245, Arial/10, 0.180, "Pay, To The, Order Of" 

 See the Multi-Line Variables section later in this chapter for more information. 

PRINTBOSS DEFAULT ASSIGNMENTS 

A few variables should always be assigned.  They are stored in the PrintBoss work file database enabling helpful 
sorting and locating of records and are often used in conditions within a form. These variables are: 

 DocAmnt  
 DocDate  
 DocNo  
 DocRecip 



PrintBoss Select 67 Electronic Copy 

These will automatically be assigned when a PrintBoss Flag Trigger exists in the document (PB#INFO ….).  
Otherwise, be sure to capture and assign these variables using the #Assign command.  

NOTE: 

The {CChkNo} variable is usually automatically assigned the value of the {DocNo} variable. 

MULTI-LINE VARIABLES 

Normally an assigned or captured variable is a single line of text.  Assignments made using #AssignS may contain 
multiple lines of text with each line separated by a Carriage Return / Line Feed.   A few commands accept and 
process multi-line variables as multiple lines, such as the #VText command.  A few standard variables, such as 
EMailBody, EmailTo, EmailCC, and EmailBCC, also accept multiple lines. 

A particular line of a Multi-Line Variable may be referenced by appending a line number enclosed in square 
brackets as part of the variable reference.  For example, the following assignment can be used to capture an 
unknown number of address lines: 

 #Assigns AddressLines, 1.0-1.2, 8.0-9.5, BW 

The third line can be printed as follows: 

 #Text 1, 1, Arial/12, ''The third line of the address is: {AddressLines [3]} '' 

The zero element returns the total number of elements.  Continuing with this example, the following loop prints all 
the address lines: 

 #Assign LastLineY, 7.9 
 #For n= 1 to {AddressLines [0]} 
  #Text 1, {LastLineY+.18}, ''Arial/12'', ''Address Line {n} = {AddressLines [{n}]}'' 
 #Next n 

PRINTBOSS CONDITIONAL COMMANDS 

Each PrintBoss Select command can be executed based on a condition that is evaluated at the time the line is 
processed.  For example, a logo may be printed based on the existence of a logo file name in the bank record, or a 
second signature line on a check may only be printed if the check amount exceeds $1000.  The condition statement 
is one or more condition expressions with each expression enclosed in brackets [ ]. The condition statement is 
inserted between the # character and the command name (for example:  #[Copy, 1]Text …). 

In addition to conditions for commands, several commands accept Conditional Parameters, such as the # 
ProcessPage [<condition>] command.  The conditional parameter is simply a condition statement that follows the 
same rules but is used after the command.  It is often helpful to enclose a Condition Parameter in a delimiter, 
especially if the condition statement has multiple condition expressions. 

A condition statement is comprised of a series of condition expressions chained together with an assumed AND or a 
symbol for OR.  Normally, a condition statement is only one condition expression.   

Each condition expression begins with a condition operator followed by a comma and as many parameters as 
defined by the operator. 

More than one condition can be entered by chaining together the bracketed condition expressions.  Multiple 
conditions are usually considered to be joined by AND, so usually all expressions must be true for the condition to 
be true.   

Ex:  #[Copy,12][AmntRange, 0, 200]Text  1,1, Arial/12,  "Prints on Copy 1 and 2 if amount is less than 200" 

#[!Copy,0][Flagged, {BFlag2}]Text  1,1, Arial/12,  "Prints on all  Copies but 0 if banks Flag 2 is checked" 

ANY CONDITION PRECEDED BY AN EXCLAMATION MARK (!) HAS ITS LOGIC REVERSED. 

A double pipe symbol may be inserted between conditions to represent OR with the next condition. Parentheses 
cannot be used with conditions.   
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Ex:  #[Inu, "Jones","{Comp}"]||[Inu, "ABC", "{Comp}"]Text  1,1, Arial/12, "Jones or ABC in Company Name" 

Very complex conditions may require several lines together that create variables in stages and then those variables 
can be used within other condition statements. 

The following is a list of the most common conditional commands and their descriptions.  See Appendix B for a list 
of the remaining commands. 

NOTE: 

Although it is helpful for us humans to see the condition names spelled out completely, only as many 
characters as is needed to make the condition unique are required. For example, Fi is enough to register as the 
FileExists condition, or As is enough to register as the Assigned condition, or E as the Empty condition.  

= 
=, 'String1', 'String2',  

This command returns a value of true if String1 is identical to String2 up to the length of String2.  For example, 
comparing "12345" with "123" is true, but "123" compared to "12345" is false. 

 The Compare Options include: 

Option Description 

E Exact match rather than stopping at the number of characters in String2 

U Converts all characters to upper case before comparing – Not Case 
Sensitive 

T  or  R Right trim both strings before comparing 

A  or  B Trim Both (or All) sides of each string before comparing 

The following example prints the words "No Charge" if the value of the variable {Dept} is equal to "Accounting" 
and is not case sensitive: 

#[=,'Accounting', {Dept}, U]Text 1,2.1, 'Arial/12', 'No Charge' 

The following is a list of examples showing the effect of the Compare Options: 

 [=,"12345", "123"] true 

 [=,"123", "12345"] false 

 [=,"12345", "123", "e"] false 

 [=,"123",   "123  "] false 

[=,"123",   "123   ", t] true 

[=,"ABC",   "abc"] false 

[=,"ABC",   "abc", u] true 

=e, =eu, =u 
=e, 'String1', 'String2' 

Same as = condition with a Compare Option of "e", "eu", or "u" (see the table above under the = condition). 

== 
==, 'NumericValue1', 'NumericValue2', 

Returns true if NumericValue1 is EQUAL to NumericValue2.  The numeric values of the items are compared.  For 
example: 0 == 0.00 is true. 
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<> 
<>, 'NumericValue1', 'NumericValue2' 

Returns true if NumericValue1 is NOT EQUAL to NumericValue2.  The numeric values of the items are compared.  
For example: 1 <> 0.00 is true. 

<= 
<=, 'NumericValue1', 'NumericValue2' 

Returns true if NumericValue1 is LESS THAN OR EQUAL TO NumericValue2. 

>= 
>=, 'NumericValue1', 'NumericValue2' 

Returns true if NumericValue1 is GREATER THAN OR EQUAL TO NumericValue2. 

< 
<, 'NumericValue1', 'NumericValue2' 

Returns true if NumericValue1 is LESS THAN NumericValue2. 

> 
>, 'NumericValue1', 'NumericValue2' 

Returns true if NumericValue1 is GREATER THAN NumericValue2. 

AmntRange 
AmntRange, 'LoRange', 'HiRange' [, TestAmount] 

Returns true if the Test Amount falls on or within the specified range.  {DocAmnt} is used as the test amount when 
the Test Amount is omitted.  There is no upper limit when the HiRange is omitted or set to 0. 

The following examples print a second signature line on checks with a {DocAmnt} of 1000 dollars or above.  The 
first expression makes use of the exclamation mark "!" to reverse the logic and the second drops the HiRange 
parameter to remove the upper limit. 

#[!AmntRange, 0.1, 999.99]Line 4.7, 9.7, 8.15, 9.7 

#[AmntRange, 1000, ]Line 4.7, 9.7, 8.15, 9.7 

Another common use is to put a condition on a signature to determine when it prints.  The following example will 
not print a signature when the check amount {DocAmnt} is below $0.01 and above $49,999.99. 



PrintBoss Select 70 Electronic Copy 

 

Notice the condition was entered directly in the Pic Command Properties dialogue.  The button at the end of the 
Condition field opens a list of the available conditions and their parameters.  The condition can be tested in the Form 
Files’ View by entering an amount in the Simulated Document Amount field at the top of the View. 

Assigned 
Assigned, '<Name of assigned variable to test>' 

Returns true if the variable is explicitly assigned (i.e. #Assign 'EmailTo', "support@wellspringsoftware.com") or 
assigned through capture coordinates (#Assign 'EmailTo', ' ', 1.5, 4.5).  PB#INFO can also be used to assign the 
variable.  DO NOT include braces around the variable name.   Note the value of a variable can be blank, but the 
variable is still considered assigned. 

The following example prints the company logo when CompName is assigned. 

#[Assigned, 'CompName']PIC 0.30, 7.8, 'CompLogo.bmp' 

Captured 
Captured, 'Name of assigned variable to test' 

Returns true if the variable is captured raw data from the accounting software.  This is different than the Assigned 
conditional command.  Before a variable can be captured, a command must assign a variable name and define the 
coordinates used to capture a value.  If the raw data never has a text object that falls within those coordinates, then 
NO data is Captured, but it is Assigned.  

Copy 
Copy, 'String of Digits' 

Returns true if the form copy number is included in the string of digits, where 0 represents the original copy and 1 
through 7 represents copies 1 through 7.  Specify each copy number when more than one copy is to be considered.  
Separators are not required, but any character may be used to separate multiple copy numbers except an asterisk.  

If an asterisk (*) appears after a character, the object is only printed in the mirrored block section.  This is useful 
with the BLOCK command that draws a frame on 11" checks.  The block should not be printed on the original, but it 
is nice to have a frame printed on the mirrored block on the top tear off copy. 

 See Block Mirror tab earlier in this chapter. 



PrintBoss Select 71 Electronic Copy 

If a B appears after the copy number, the object only prints in the body of the document.  It will not appear in the 
mirrored block section. 

NOTE: 

If no condition operator is specified inside of the condition braces, the COPY operator is assumed.  

Examples: 

Conditional Command Description 

#[Copy, 23]TEXT 5.00, 9.00, "TM/8", "Duplicate Copy" Prints Duplicate Copy on copies 2 and 3 

#[COPY, 0*123]Block .250, 7.6, 8.25, 10.5, /R.1 Prints a frame on the mirrored block for copies 1, 2, and 3 

#[0*123]Block .250, 7.6, 8.25, 10.5, /R.1 Prints a frame on the mirrored block for copies 1, 2, and 3 

#[Copy, 1]TEXT 4.5, 10.5, '5', 'Customer File Copy' Prints Customer File Copy on copy 1 

#[!C,0]Text 4.4, 10.4, "Arial/14", "** COPY **" Prints **COPY** on all copies except the original 

Dates=, DATES>,   DATES< 
Dates=, '<Date1>', '<Date2>’ 

These condition commands return true if date1 and date2 compare as indicated by the =, >, or < signs.  If date2 is 
omitted, then the current date is assumed to be date2. 

The Windows’ ShortDateFormat is the assumed format for the dates.  An alternate format can be specified by 
appending a semicolon followed by a mask to the date string.  For example: 

 [Dates=, "4/1/08; m/d/y"]    This statement evaluates to true when the current date is Apr 1, 2008. 

Empty 
Empty, 'StringToTest' 

This returns true if the StringToTest is empty.  Use this condition command with the exclamation mark to reverse 
the condition.  For example: 

#[!Empty, {BMisc1}]Pic 0.3000, 8.200, {BMisc1}  This command prints the logo specified in the Bank Misc1 field 
when BMisc1 is not empty. 

#[!Empty,÷{Memo}÷]Text 8.137R, 8.813, 'Arial/9', ÷MEMO: {Memo}÷  This command prints the contents of the 
Memo field when it is not empty.  The Memo field is an 
assigned field. 

False 
False 

This indicates the expression is FALSE and is often helpful in debugging conditional statements. 

FileExists 
FileExists, 'FileName' 

This returns true if the file specified by the FileName exists.  It is often used with logos and signatures.  PrintBoss 
will look in the Logos folder under the Home directory when no path is specified.  The following example will print 
the logo file when it exists: 

#[File, '{PDir}\Logos\Logo.BMP']PIC .4, 7.9, '{PDir}\Logos \Logo.BMP' 

This condition command is most commonly used when logos are added directly to the Form File instead of through 
the Bank Record. 
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Flagged 
Flagged, 'StringToTest' 

This returns true if the StringToTest begins with any of these characters:  Y, y, T, t (as in Yes or True).  It is often 
used with the 5 bank variable fields called {BFlag1} … {BFlag5}, though it will work testing any string that can 
return one yes or true value. 

#[Flagged,{BFlag1}]Line  4.7, 9.6, 8.149, 9.6, ''  This command prints a second signature line when the 
BFlag1 field is checked (flagged).  The description for 
the BFlag1 field is 2nd Signature Line and it is located on 
the Miscellaneous tab of the Bank Edit window. 

 See Chapter 8, Bank Accounts. 

In 
In, 'StringFragment', 'StringToSearchIn' 

This returns true if the StringFragment exists anywhere in StringToSearch.  The search is CASE SENSITIVE.  The 
following example whites out the dollar amounts when an exact match of the word Packing occurs anywhere in the 
assigned variable DocDesc: 

#[In, 'Packing', '{DocDesc}']Block 6.5, 4.5, 8.25, 9.2, W 

Inu 
Inu, 'StringFragment', 'StringToSearchIn' 

This returns true if the StringFragment exists anywhere in StringToSearch. This search is NOT case sensitive.  The 
following example whites out the dollar amounts when the word Packing occurs anywhere in the assigned variable 
DocDesc, regardless of case: 

#[Inu, 'Packing', '{DocDesc}']Block 6.5, 4.5, 8.25, 9.2, W 

True 
True 

The condition is TRUE.  This is often used in debugging conditional statements. 

Type  
Type, 'Source Abbreviations' 

This returns true when the document Type appears in the Source Abbreviation list and is useful when certain 
documents are to print only for specific types of source files. 

Source 
Abbreviation 

Description 

W Work Files 

A Archive Files 

S Samples in Utilities 

F Form Editor 

The following is an example of disabling a signature from printing when processing archive files: 

#[Type, WSHF]SIG 4.7, 9.8, 'Your_Sig.SIG' 

Shorten the condition command with the reverse exclamation mark: 

#[!Type, A]SIG 4.7, 9.8, 'Your_Sig.SIG' 
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View Only 
This condition sets an object to View, but not to print.  This condition can be used to test the contents of a variable 
prior to printing. 

DATE & TIME FORMAT MASKS 

Many commands and functions allow the use of date format masks to define how a date is expressed or interpreted.  
In most cases, the date format is defined in the Windows Regional Settings for the Short Date if a date mask is not 
specified.  Here is a list of the mask symbols:  

Mask Description 

d Displays the day as a number without a leading zero (1 - 31). 

dd Displays the day as a number with a leading zero (01 - 31). 

ddd  Displays the day as a three character abbreviation (Sun - Sat) using the strings given by the 
ShortDayNames global variable. 

dddd  Displays the day as a full name (Sunday - Saturday) using the strings given by the 
LongDayNames global variable. 

ddddd 

 

Displays the date using Windows’ ShortDateFormat (no other symbol would be used with these 
5 ds). 

dddddd 

 

Displays the date using Windows’ LongDateFormat (no other symbol would be used with these 
6 ds). 

m  Displays the month as a number without a leading zero (1 - 12).  If the m specifier immediately 
follows an h or hh specifier, the minute rather than the month is displayed. 

mm  Displays the month as a number with a leading zero (01 - 12). If the mm specifier immediately 
follows an h or hh specifier, the minute rather than the month is displayed. 

mmm  Displays the month as a three character abbreviation (Jan - Dec) using the strings given by the 
ShortMonthNames global variable. 

mmmm  Displays the month as a full name (January - December) using the strings given by the 
LongMonthNames global variable. 

y or yy Displays the year as a two-digit number (00 - 99). 

yyyy Displays the year as a four-digit number (0000 - 9999). 

j Displays the day of the year as a number without a leading zero (1 - 365). 

jjj Displays the day of the year as a number with leading zeros (001 - 365). 
  

h Displays hours without a leading zero 0 - 24 (0 - 12). 

hh Displays 2-digit hours with a leading zero 00 - 24   (or 00-12). 

n  Displays minutes without a leading zero 0 - 59.  Note that within a time expression, m will be 
interpreted as minutes as well. 

nn  Displays minutes with a leading zero 00 -59.  Note that within a time expression, mm will be 
interpreted as minutes as well. 

s Displays seconds without a leading zero 0 – 59. 

ss Displays seconds with a leading zero 00 – 59. 
  

t Forces 12 hour clock with a  or p  in place of  t. 

T Forces 12 hour clock with A or P in place of T. 

tt Forces 12 hour clock with am or pm in place of  tt. 

TT Forces 12 hour clock with AM or PM in place of TT. 
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DELIMITING PARAMETERS 

Most PrintBoss Select commands require parameters.  Each parameter in a list of parameters is always separated 
with a comma.  If no delimiter is used to enclose a parameter, PrintBoss Select will trim leading and trailing spaces.  
In the following example, the final parameter will only be 8 characters long:   ''Test 123''. 

 #Text 4, 5, Arial/12,      Test 123 

Often it is necessary or safer to delimit parameters in case there may be a comma within the parameter or if you 
want to retain leading and trailing spaces.  This is especially true when you are delimiting variables, like an address, 
where you can’t be sure of the contents in the evaluated variable.   Suppose the above #Text command includes 2 
leading and 2 trailing spaces.  The final parameter should be 12 characters long.  This can be fixed with delimiters. 

 #Text 4, 5, Arial/12, ''  Test 123  '' 

The choice of delimiters is very important.  If the {CompName} variable in the following line resolves to O’Neil 
Decorating, Inc and the delimiter chosen is a single quote, a problem would occur. 

 #Text 4, 5, Arial/12, '{CompName}' |This expression evaluates to O 

The CompName would stop at O due to the apostrophe in the name.  A different delimiter needs to be used.  

 #Text 4, 5, Arial/12, «{CompName}» |This expression evaluates to O’Neil Decorating, Inc 

PrintBoss Select recognizes the following characters as delimiters.  Delimiters are normally used in pairs, though 
different pairs may be used in the same expression: 

Delimiter Description 

' Single quote (apostrophe) 

'' Double quote (Shift + apostrophe) 

~ Tilde (Shift + graves above left Tab key) 

[ ] Starting and ending square brackets 

÷ Divide symbol entered in PrintBoss editors by pressing CTRL + Apostrophe 

« » Double arrows entered in PrintBoss editors by pressing CTRL + Comma for left arrows and CTRL 
+ Period for right arrows 

The last two choices are the safest since they are extremely unlikely to occur in a text string.  A commonly used 
short cut is to omit the trailing delimiter if the parameter being delimited is at the end of a line
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Chapter 

10 
#TEXT COMMAND 
The #Text command has many options and can be qualified in different ways that are unique compared to all other 
commands.  Therefore, this command has a single chapter to explain the different options.  This chapter is divided 
into three sections.  The first section details the #Text command as accessed from the View of a form and the second 
section details the command when editing the textual scripts available in the Form Editor (normally in the Run Time 
Objects or Footer Objects sections).  The third section describes Substitute Functions that can be used by either edit 
method. 

EDIT #TEXT FROM A VIEW 

To edit, insert, or delete text, it is often easier to use the Document View of a Form File. 

1. Click on the Edit menu and select Form Files from the PrintBoss Master Application.   
2. Select the desired form and click the View button.  The View of the form opens.  Clarity will depend on the 

monitor's size and resolution. 

 See Chapter 9, Form Files – Modify from the Document View, for information on the layout of the View 
window. 

DATA PRESENT 
The form is void of accounting data when viewed from the Form File.  Bank account information displays 
depending on the form and based on the bank record selected from the drop down list at the bottom of the Form 
Select window.  Close the view, select a new account from the drop down menu, and click View again to display 
information from a specific bank account. 

 Any editing saved to a form in the View affects all bank accounts – not just the bank 
currently viewed. 

Other elements in the View consist of text, grid, and other objects used to create the Form File and are generated by 
PrintBoss.  This often includes logos, company information, bank information, signature lines, labels, and the format 
for the MICR line at the bottom of a check. 

DELETE TEXT 
Deleting text or objects from the View removes that object from ALL documents that use this form.  Click once on 
the text object to select it.  The text will be highlighted.  Right click and select Delete Current Object.  PrintBoss 
Select will prompt you for a confirmation.  The change is not permanent until you Close the view and confirm the 
changes should be Saved. 

 Deleting text from the view will delete it for all copies and accounts that use this document. 

EDIT TEXT 
There are two ways to select text in the form: 1) double click on the text or 2) click once to highlight, then right click 
and choose Edit Current Object.  A dialog box opens with properties specific to this text item.  Variable names 
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appear in the Text field enclosed in braces { } if the form text is the value of a variable.  This is common with bank 
and company information. 

 

Adjust the coordinates listed in the upper left are of the dialog box to change the placement of the text.  These 
coordinates are in INCHES and measure from the left edge of the paper to the edge of the text, depending on 
justification (Left, Center, Right), and from the top edge of the paper to the edge of the text, depending on 
justification (Top, Middle, Bottom).  The default justification is left and top.  You may also drag text to the desired 
location. 

NOTE: 

Text may be dragged to change its location unless there is a variable in the Left or Top fields.  See the graphic 
above for an example.  The {CompAdsLeft} variable adjusts the left edge of the company address objects 
when a logo appears on the form.  The distance from the left is specified by a #Assign command. 

The text dialog opens after text is dragged to verify the new location.  Click OK to accept the change. 

Click on the red question mark to the right of the Type Face field to change the style of the font and browse to any 
font available on your system.  You may also type the name of a font.  Adjust the point size and style of the font as 
desired.  Available font properties include: 

 Italics 
 Bold 
 Underlined 
 Strikeout 
 All Caps 
 Color (If you do not have a color printer, the text will appear on the paper in a shade of gray) 
 Reverse Print 
 Mirroring 
 Pitch Override for fixed pitched fonts only (Courier, Line Printer, Letter Gothic) 
 Orientation 
 Width 
 Full Justification (Available when a Width is entered) 
 Word Wrap (Available when a Width is entered) 
 Work Wrap Line Spacing (Available when Word Wrap is selected) 

A condition may be added to the text using the Condition field near the bottom of the dialog.  Type the condition or 
choose one from the selector button to the right of the Condition field.  Add "&&" after the condition to add another 
condition.  It is often best to edit complex conditions in the Form Editor. 
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 Please see Chapter 9, Form Files, for more detail on conditional commands. 

INSERT TEXT 
1. Right click anywhere in the View 
2.  Select Insert an Object  
3. Click Text  

The Text Command Properties dialog opens with the coordinates of the point where you right clicked.  Type your 
text in the Text field or enter a variable name in braces { }.  Typically the variable names are assigned in the 
RunTime Objects tab.  Change the text properties as needed. 

NOTE: 

Objects inserted from the View are placed on the last line of the Footer Objects tab of the Form File (or the 
Back Objects tab if viewing the back of the form).  Placements in other tabs or changes of order for proper 
formatting need to be made in the Form Editor. 

It may be convenient to view a list of available variables when inserting a new Text field.   

1. Close any open windows except View. 
2. Right click in the View. 
3. Select Display Assignments 

 

These steps open the Form Assignments window.  Move the Form Assignments window to the side for reference.  
Drag a variable from the Assignments made in form list or the Assigned Fields (Permanent) list onto the View of the 
form.  A Text Command Properties dialog opens for the variable.  The coordinates in the dialog are based on the 
drag location of the variable.   Edit and click OK to save your changes or click Cancel to undo. 

FORM EDITOR 

Though it is easier to Add/Edit/Delete text objects from the View of a form, sometimes it is advantageous to access 
the script behind the view.  A #Text command defines text properties for every text object in the script. The scripts 
are editable by opening the form editor and examining the RunTime, Footer, Page Back, or Proprietary Objects tabs 
of the form.  The basic syntax follows: 

#TEXT X, Y, "FontDescriptor", "TextString" 
Double click on an existing command or type #Text and double click on it and a line editor dialog will parse out the 
script and open the Text Command Properties dialog.  The following describes the parameters the parser expects. 

X, Y: 
These coordinates represent the location of the top left corner of the text from the left and top edges of the paper in 
inches.  These values may be entered in thousandths of an inch.  If the X coordinate is followed with the letter L, C, 
or R (case does NOT matter), PrintBoss Select will justify the text to the Left, Center, or Right.  The text is left 
justified by default.  Type the letter T, M, or B after the Y coordinate to justify the text Top, Middle, or Bottom.  
The text is top justified by default. 
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Only enter the letter representing justification in the script.  The Text Command Properties dialog has a 
corresponding line justification buttons. 

FONT DESCRIPTOR: 
The Font selection button on the Text Command Properties dialog in PrintBoss Select opens the Windows Font 
dialog.  Once a font is selected, the descriptor is built automatically.  The font descriptor can be typed in the script 
using the following components: 

'Typeface/Point Size/Options' 

'Arial/12/B' 

PrintBoss Select allows a few abbreviated Type Faces. 

UV Universal* 
TM Times Roman 
CR Courier 
LP Line Printer* 
LG Letter Gothic 

* Not recommended as not available in newer printers. 

The font options are: 

Font Option Description 

I Italics 

B Bold 

N Underline 

K Strikeout 

U All Caps 

R Reverse Print 

@nnn Rotation of fonts in degrees –360 …0 … 360.  Often 
used to change the orientation of text for Deposit slips 

+ Follows point size and specifies all mirrored blocks use 
original point size 

Pnn.nnn Overrides any Fixed or Proportional pitch with this pitch 

Xnn.nnn Sets width of text in inches when used with Full 
Justification (XJnn.nnn) 

A Word Wrap 

E.nn Specifies Word Wrap line spacing 

TEXT STRING:  
This is the actual string of text that prints and can be a variable name or specific text (i.e. 'Two Signatures 
Required').  The string should be delimited (see Delimiting Parameters at the end of Chapter 9).  Take care to 
choose a delimiter that will not occur in the string, especially when the text is an assignment from captured data. 
Example:  Don't use Single Quotes if the text could possibly contain an apostrophe. 

One unique delimiter available to PrintBoss Select is Ctrl+ ' (apostrophe) and appears as a ÷ (old division symbol).  
This delimiter is recommended when the other options may appear in the text string. 

Some examples of #Text commands commonly found in PrintBoss Form Files include: 

#Text .3, 7.8, "Arial/14/B", ÷{BCName}÷  |This places the company name in the upper left of the check in a 14 
point Bold Arial font. 

#[C,0]Text 4C, 10.5, "Times Roman/10/I", "Original"  |This places the label "Original" centered at the bottom of the 
original document, but not on copies. 
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SUBSTITUTE FUNCTIONS 

There are times when a text command needs to be limited, formatted, or altered to account for special circumstances.  
Substitute functions are available for the #Text command to accommodate those special situations. A list of 
substitute functions is available in the Form Editor by RIGHT clicking in an Objects tab and selecting List/Stuff 
Assignments.  Click on the plus sign in front of Substitution Functions to view the list. 

Substitute functions need to be enclosed in braces { }.  Each substitute function name is immediately followed by a 
colon and any required parameters.  Everything between and including the braces will be replaced with the 
evaluation of the function when it is encountered in a script.  

Functions may be embedded in functions.  Use caution.  Confusion may occur with delimiting the functions and 
parameters.  Sometimes it is preferable to create a value from a series of steps to eliminate confusion and make the 
command clearer.  For example, consider a field with leading and trailing spaces that is captured to a variable called 
{Dept}.  It may have the value:  "     SHIPPING     ".  Only the first 2 non-space characters of this field need to be 
printed (SH).  The following two scripts accomplish this goal.  The second is a bit longer, but it is clearer and safer. 

 #Text 4, 10.0, "Arial/12", "Dept Code: {SubStr: ÷{TrimAll: '{Dept}'}÷,1,2}" 

OR: #Assign DeptTrimmed, "{TrimAll: '{Dept}'}" 

 #Assign DeptCode, "{Substr: '{DeptTrimmed}',1,2}" 

 #Text 4, 10.0, "Arial/12", "Dept Code: {DeptCode}" 

Descriptions of the more common substitute functions follow. See Appendix C for a list of the remaining Substitute 
Functions. 

CurrentDate 
CurrentDate: 'mm/dd/yyyy' 

Inserts the current date formatted according to the mask.  If no mask is passed, the Windows Regional date mask 
will be used.  See Chapter 9, Form Files – Date & Time Format Masks, for more format options. 

CurrentTime 
CurrentTime: 'hh:mm:ss tt' 

Inserts the current time formatted according to the mask.  If no mask is passed, the Windows regional time mask 
will be used. See Chapter 9 Form Files – Date & Time Format Masks, for more format options. 

DocAmnt 
DocAmnt: /HideDec /Zero /Width:nn /Commas /Trim 

This function is used to specifically format the document’s amount as recorded in the work file Amount column.   

Parameter Description 

HideDec Determines if a decimal appears or not 

Zero Number of zeros or places following the decimal 

Width:nn  nn specifies maximum width of the value in characters  

Commas  Indicates whether or not commas separate thousands 

Trim Trims the value 

FormatDate 
FormatDate: '<DateInExpr>', 'mm/dd/yyyy' [, AddDays [, AddMonths [, AddYears [,/EOM/FOM]]]] 

This function is used to format a date.  <DateInExpr> represents the date to format (or a variable referencing a date) 
followed by the appropriate format mask.  The mask may change the order or the separators of the date.  By default, 
the AddDays/AddMonths/AddYears parameters are 0.  Insert positive or negative values for these parameters to 
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shift the date accordingly.  Include the "/EOM" option to return the end of month, or the last day of the month for 
the DateInExpr.  FOM will return the first day of the month for the DateInExpr. 

FormatDate2 
FormatDate2: '<DateInExpr>', '<DateInExprMask>', 'mm/dd/yyyy' [, AddDays [,AddMonths [, AddYears 

[,/EOM]]]] 

Same as FormatDate, except this function includes identifying the DateInExprMask format in case it is different 
than the Windows’ ShortDateFormat. 

FormatNum 
FormatNum: '<NumStr>', WholeDigits, DecimalDigits, '<LeftFill>', 'RtFill', 'HideDec/Commas' 

This function formats the structure of a numeric value and is often used for Positive Pay.  The following letters are 
used to represent HideDec/Commas: 

H Hide decimal (used in Positive Pay Scripts) 
C Comma is inserted as the thousands separator 

For Example: 

{FormatNum: '{DocAmnt}', 8, 2, '0', '0', 'H'} 

In this example, the number of Whole Digits is 8, the number of Decimal Digits is 2, zeros are used to fill Left, zeros 
are used to fill right, and the decimal is hidden.  If the DocAmnt is $123.40 it would appear as:  0000012340 

Here is an example of a #Text using the FormatNum substitute function: 

#Text 7.934R, 8.513, 'CR/12/B', ÷**${FormatNum:   '{DocAmnt}', 0, 2, '', '0', 'C}÷  |Here, the zero Whole Digits 
represents any number.  Notice there is no Left Fill. 

Pad 
Pad: '<Str>', <Len> [, <Left/Rt,/Trunc> [, <PadChar>]] 

This function defines the length of the string and adds extra characters when the string is short.  Spaces are the 
default characters when PadChar is not defined.  This function is often used with Positive Pay. 

The option parameter may specify L, R, or T for Leftpad, Rightpad, or Truncate.  The Truncate will truncate it to the 
length <Len> specified. 

For Example: 

{Pad: '{DocNo}', 10, R, '0'} or  

{Pad: '{DocNo}', 10,  , '0'} 

The {DocNo} is a variable for the document number.  If the check number was 1234, it would appear as:  
1234000000.  

RECAmnt 
RECAmnt: '#,###,##0.00' 

This function displays the amount of the document at the time the work file was generated.  The only parameter is 
the mask, and it is optional.  

Mask Description 

# Digit placeholders that are suppressed if not needed 

0 Digit placeholders that will force a zero when no value is present 

, Thousands separator (suppressed if not needed)  
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RECDate 
RECDate: 'mm/dd/yyyy' 

Inserts the date the PrintBoss work file was created.  The optional mask uses the characters defined in Chapter 9, 
Form Files – Date & Time Format Masks. 

RECTime 
RECTime: 'hh:mm:ss tt' 

Inserts the time the PrintBoss work file was generated.  The optional mask uses the characters defined in Chapter 9, 
Form Files – Date & Time Format Masks. 

StrExtract  
StrExtract: '<OrigString>', '<Delimiter>', <Occurrence> [,'<mode>'] OR 

StrExtract: '<OrigString>', 'CDF', <CommaDelimitedFldOccurrence> [,'<mode>'] 

This function extracts a substring from within a string.  The original string is divided into substrings separated by the 
specified delimiter.  The following example extracts asterisks from the string before printing the word amount. 

Example:   #Text 0.675, 9.102, 'Arial/10', ÷{StrExtract:«{WordAmnt}», «**»,1} Dollars÷ 

Parameter Description 

OrigString This is the original string with substrings delimited by the delimiter. 

Delimiter Delimits the substrings.  Often this is a comma or semi-colon, but it may be multiple characters.  
This parameter is Case Sensitive.  See CDF note below. 

Occurrence Identifies the substring to select within the original string.  If this value is negative, it will count 
occurrences from the right.  An occurrence of -1 returns the last substring in the original string. 

Mode Enter any of the abbreviations L, R, B or U to indicate Left trim, Right trim, All trim, or 
Uppercase. 

CDF NOTE: 

A special type of string is called a Comma Delimited String.  In this case, each substring is delimited by a 
comma, but the substring itself may also be delimited with double quotes.  This enables the substring to 
contain commas.  Enter CDF as the delimiter for a Comma Delimited String and PrintBoss will look for the 
double quote substring delimiters and treat them appropriately. 

StrTran 
StrTran: '<OrigString>', '<SearchKey>', '<ReplKey>'[, 'Options'] 

This function replaces a substring (SearchKey) with another substring (ReplKey).  A number entered in Options will 
limit the number of replacements starting from the left of the string.  A negative number will count from the right.   
An option of -1 will replace the last occurrence in a string.  The following example removes all the asterisks in the 
DocAmnt string by replacing the asterisks with nothing as symbolized by the two apostrophes. 

Example:   #Text 7.923R, 8.641, 'Arial/11', "{StrTran:  '{DocAmnt}',  '*', ''}" 

WordAmnt 
WordAmnt: <Amnt> [, <Line1or2> [, <LineLength90> [, <CurrencyDollars> [, <Style A or B>]]]] 

This function takes the numeric value of a variable and translates it into English text.  PrintBoss places the returned 
text on line 1 based on the length provided, but it will wrap to line 2 if necessary.  If an entry in the form specifies 
both line 1 and line 2, each line must use the same specified max line length.  All parameters except <Amnt> have 
defaults, so any parameter may be left blank and the default value will be used. 

Example:  #Text 0.66, 9.10, 'Arial/10', ÷{WordAmnt: {DocAmnt}}÷ 
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Parameter Description 

Amnt Amount to be converted to a text expression 

Line 1 or 2 Identifies the location for the returned text.  Default is 1 

LineLength90 Length of line based on characters in the line.  Default is 90 

CurrencyDollars The currency phrase will use this value in the text.  Default is Dollars 

Style AorB: Default style is A 

Style A example: Ten and 11/100 Dollars 

Style B example: Ten Dollars and Eleven Cents 
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Chapter 

11 
SECURITY FEATURES 

The PrintBoss Select security features allow an administrator to restrict access to specified functions within the 
program.  Accessibility can be gained through password and user disk, and each user can have a different level of 
access. 

Windows users need FULL CONTROL of the PrintBoss directory for the PrintBoss Select application to function 
properly.  If there is a need to lock down access to the program, it should be set through PrintBoss Select security.  
Security settings are not required, but are available if desired.  PrintBoss Select will function normally if security is 
not activated. 

Security settings only need to be defined once for all workstations when PrintBoss Select is installed on a network.  
Multiple users can access PrintBoss Select simultaneously from different workstations when PrintBoss Select is 
installed on a shared network drive.  If the PrintBoss Select application is installed locally on workstations, then 
security settings need to be defined for each workstation. 

SETTING UP SECURITY 

SECURITY ACCESS 
The Administrator or Supervisor determines the restricted functions.   

1. Open the PrintBoss Master Application. 
2. Click on the Options menu and select Security.  The Security Access window opens.   
3. Enter the Master Password or insert the original registration disk shipped with your copy of PrintBoss 

Select. 
a. Enter ADMIN (upper case) in the Master Password field for first time installations.   
b. OR Insert the registration floppy (older installations that have updated) into the drive and enter the 

correct drive letter in the Insert Distribution Disk in drive field. 
4. Click OK.  The Security Settings window opens. 

There are three tabs on the Security Settings window, but the Basic User Rights tab changes name and function 
when the Security Method on the General Settings tab is changed to Advanced.  The fields on each of these tabs are 
explained in more detail in Appendix D of this manual. 

SET BASIC USER RIGHTS (STANDARD) 
A set of Basic User Rights can be created that applies to all PrintBoss Select users.  Additional rights can be 
assigned to individual users.  These users will need to be created on the Advanced User Rights tab and assigned a 
password.  The restricted features will only be available to the user when they Log-In to PrintBoss Select. 

1. Open the PrintBoss Master Application. 
2. Click on the Options menu and select Security. 
3. Enter the Master Password 
4. Click on the Basic User Rights tab.  This tab is available when Standard is selected as the Security Method 

on the General Settings tab. 
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5. Check only the features you want all users to access. 
a. All features are selected by default. 
b. Click the Uncheck All button to remove all checkmarks and then check only the features you 

want all users to access.  You may also uncheck specific features you want to restrict without 
using the Uncheck All button. 

6. Click OK when you are finished. 

SET SECURITY REQUIRED (ADVANCED) 
Advanced security adds another layer of security by requiring the user to insert an encoded floppy disk into the 
computer to access specified features.  This method can only be used if the computer has a floppy disk drive. 

1. Open the PrintBoss Master Application window and access Security. 
2. Click on the Security Method drop down menu on the General Settings tab and choose Advanced. 
3. Select the Security Required tab.  This tab is only visible when the Advanced security method is chosen. 
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4. Check only the features you want to restrict from all general users. 
a. Enter a check in the User Logged In column to require a login to use the feature. 
b. Enter a check in the User Disk column to require the user insert an encoded floppy disk to use the 

feature. 
c. A check in both columns requires both a user login and insertion of an encoded floppy disk. 
d. Items NOT checked do not require a login or encoded floppy disk to access the feature. 

5. Click OK when you are finished. 

CREATE USER ACCOUNTS 
The steps used to create user accounts are basically the same for both the Standard and Advanced security methods.   

1. Open the PrintBoss Master Application window and access Security. 
2. Click on the Advanced User Rights tab. 
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3. Click on the Plus sign (+).  The User Edit window opens.  The following is an example of the Standard 
security method. 

 

Here is an example of the Advanced security method. 
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4. Enter a User Name.  Enter the user's Windows User Name if you would like to enable Auto Login on the 
General Settings security tab. 

5. Enter a Password for this user.  Passwords are visible to anyone who has the Master Password to access 
Security. 

6. Check the appropriate features to provide secure access to this user.  
a. These features will be available to the selected user after he/she successfully logs in to PrintBoss 

Select when the Standard security method is selected. 
b. The Advanced security method indicates how the user can access these features when they are 

checked. 
i. L – Login required 

ii. D –Disk required 
iii. B – Both a login and distribution disk are required for access 

7. Advanced Only – Create a user Disk if the letters B or D appear next to any of the features on the User 
Edit screen. 

a. Insert a floppy drive into your computer. 
b. Enter the drive letter for the floppy in the User Disk Floppy Drive field. 
c. Enter an expiration date for the floppy in the Valid Through field.   
d. Click the Write User Disk button to encode the floppy. 
e. Remove the floppy when you are done. 

8. Click OK on the User Edit window when you are done. 

ACCESSING SECURED AREAS 

Once security levels and users are defined, Users must log in to access those functions.  Select File / User Log-In 
from the main PrintBoss Select Master Application window.  Enter your User/Operator Name.  Enter the correct 
password.  If only a disk is required, make sure it is in the correct drive before selecting OK. 

CHANGING USERS 
When one PrintBoss Select user is finished and a second would like to access security on the same workstation, the 
current user does not need to log out.  The new user just logs in.  Only one user is ever considered logged in to 
PrintBoss on the same workstation.  Select File / User Log-Out when all users are finished to exit the security 
features. 

A user is automatically logged out of PrintBoss Select on a workstation when the PrintBoss Select application is 
closed.  No user is logged in when PrintBoss Select is first launched unless the option to Auto Login Matching 
Windows Users is selected from the Security / General Settings tab and there is a match in the PrintBoss Select 
Advanced User Rights tab. 

OTHER SECURITY OPTIONS 

Other security options can be selected on the General Settings tab of the Security Settings window.  Brief 
descriptions of these options are provided in the following table. 

Security Option Description 

Suppress printing signatures in 
Archive Reprints 

Prevents a secure signature (file with the extension of .sig) on a document from 
printing when the document is reprinted from PrintBoss Select Archives 
(File/Open Document Archives). 

Master Password Change the Master Password the first time you use Security and anytime the 
Supervisor position changes. 

Auto Login Matching Windows 
Users 

PrintBoss Select will automatically login a user when their Windows User name 
matches an entry on the PrintBoss Advanced User Rights tab (Options/Security). 

Display ONLY primary fields 
in the bank list browse 

Select this option to suppress account information on the PrintBoss Select Bank 
List (Edit/Bank List) and only display Bank Code, Bank Prompt, and Bank 
Name. 

Enable/Disable User Security in Enable or Disable the Security tab on the PrintBoss Select Bank Edit window 
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Banks (Edit/Bank List). See Chapter 8, Bank Accounts – Bank Security, for more 
information. 

Signature Disk Log (Enterprise 
Only) 

Select Logging Active and set the retention period for the log in days. 

TEXT SECURITY 

Another way to help prevent fraudulent changes is to secure the text on the document. Typically, the text that needs 
the most security is the amount on a check.   The following features discourage or make it impossible for anyone to 
change the check amount once the document is printed. 

SECURETEXT COMMAND 
This special text command automatically formats text (alpha or numeric) in a graphical layout.  There are two types 
of secure text: Custom and Standard Block Numeric. 

The Custom option creates a rectangle behind the text object and can be used for alpha and numeric text objects.  
The Std Block-Numeric option is used for numeric text only.  The words Pay Only are added and the numbers are 
formatted, shaded, and the word for each number is added.  This is typically used for check amounts. 

 See Chapter 9, Form Files, for more information on the Secure Text and Rectangle commands. 

RECTANGLE COMMAND 
The rectangle command can display a pattern behind a text object or signature, making it difficult for anyone to 
modify it once printed.  This same command can be used in front of text to mask it.  One example is masking or 
hiding the first 5 digits of the social security number on the advice of a payroll check. 

White text (or negative printing) can be used with this command to make it more difficult to modify the text.  The 
Vertical Fade or Horizontal Fade pattern should be used with negative printing. 
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Chapter 

12 
SIGNATURE DISKS 

PrintBoss Select can place digitally scanned signatures on checks during the print process.  These signatures can be 
printed conditionally based on a number of variables.  The most common conditions are bank account or dollar 
value of the document.  PrintBoss Select reads BMP, JPG, and PCX file types. 

Saving a signature file to a disk adds a level of security by requiring the disk be inserted in the computer to add the 
signature file(s) to checks.  Wellspring Software offers a PrintBoss Signature Disk that provides additional levels of 
security to the signature printing process.  First, the signature file type (SIG) can only be read by the PrintBoss 
Select software.  Second, the file is encoded so it requires the secure disk/CD/USB be inserted in the computer to 
use the PrintBoss signature.  The PrintBoss Signature Disk is the key to unlock the encoded signature file.  The disk 
is also encoded so a standard Disk Copy will not duplicate the disk.  This additional security level prevents the 
scanned signature file from being used fraudulently in other programs or by unauthorized personnel in PrintBoss 
Select. 

PRINTBOSS SIGNATURE DISKS, CDS, OR USB DRIVES 

PrintBoss Signature Disks are custom created for specific files.  These disks and signature files are encoded so the 
disk cannot be copied using a simple Disk Copy command nor can the signature file be read by standard graphics 
programs.  The signature files have a .SIG extension.  The disk may be a floppy, CD, or USB key. 

 If two signatures are to print on the same check, both signatures must be encoded for the 
same PrintBoss Signature Disk. 

Copy the actual signature files to the PrntBoss\Logos directory.  PrintBoss Select reads the file and looks for the disk 
key to unlock the file at the point of printing or viewing.  The signature can be viewed or printed when the encoding 
on the disk and signature file match.  Otherwise, the signature file will not display or print. 

NOTE: 

Terminal Server and Citrix environments need the disk in the drive of the server or the user session must have 
the drive of the local workstation mapped. 

Please contact Wellspring Software to order a PrintBoss Signature Disk. 

DUPLICATING PRINTBOSS SIGNATURE DISKS 

The original PrintBoss Signature Disk and Security Master Password, along with access to the PrintBoss Select 
application, are necessary to make a copy of a PrintBoss Signature Disk. 

1. Open the PrintBoss Master Application. 
2. Click on the Utilities menu and select Install Modules. 
3. Select the Signature Disk Duplication tab. 
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4. Enter the PrintBoss Master Password as defined under Option / Security. 
5. Click on the active 1 button after entering the password.  The 1 will fade and 2 will become active. 
6. Insert the PrintBoss Source Signature Disk. 
7. Enter the correct drive letter for the Source Signature Disk.  This may be a floppy, CD, or USB flash drive. 
8. Click on the active 2 button. 
9. Insert a new blank disk.  This does not need to be the same type of media as the original.  If you are using 

the same type of media, remove the original disk before inserting the new disk. 
10. Enter the correct drive letter for the Destination disk. This may be the same as the original disk.  
11. For a signature CD**, select the Store Encoded File in {PrntBossHome}\ SigDisks check box. 
12. To add a Password to the NEW signature disk, check Use Password on the right side of the screen.  Enter 

the password in the field provided under the check box.  This password will not impact the original disk. 
13. Click on the active 3 button. 
14. Click Done when you are finished. 

The newly created signature disk has the required encoding.  Signature files from the source disk may also be copied 
to the destination disk (except if it is a CD) through Windows Explorer, but are not required.  Signature files do not 
need to reside on the disk since they are normally read from the PrntBoss\Logos folder and PrintBoss Select will 
verify the matching encoded disk. 

NOTE: 

**The encoded file is created from the specific CD, but no file is written to the CD during the duplication 
process.  If you would like the signature files on the CD, burn the signature files to the CD before following 
the signature disk duplication process. 

ADDING A PASSWORD TO AN EXISTING PRINTBOSS SIGNATURE DISK 

A password may be added to an encoded PrintBoss signature disk.  Users will be prompted to enter the password 
before PrintBoss Select accesses the disk.  Adding a password is similar to the process of duplicating a disk except 
the existing disk is used for both the source and destination. 

1. Open the PrintBoss Master Application. 
2. Click on the Utilities menu and select Install Modules. 
3. Select the Signature Disk Duplication tab. 
4. Enter the PrintBoss Master Password as defined under Option / Security. 
5. Click on the active 1 button after entering the password.  The 1 will fade and 2 will become active. 
6. Insert the existing PrintBoss Select disk as the Source Signature Disk. 
7. Enter the correct drive letter for the Source Signature Disk. 
8. Click on the active 2 button. 
9. Select the Use Password check box on the right side of the screen.  Enter the Password in the field 

provided under the check box. 
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10. Enter the same drive letter for the Destination as the Source drive. 
11. Click on the active 3 button. 
12. PrintBoss Select will warn the source and destination disks are the same.  The only change will be to 

add/edit the signature indicated. 
13. Click OK. 
14. Click Done when you are finished. 

CREATING NON-ENCRYPTED SIGNATURE DISKS 

PrintBoss Select reads BMP (bitmap), JPG, PCX and PICT files.  Scan a signature and save it as one of these 
formats.  PrintBoss Select can print color images in these file formats as long as you are using a color printer.  Color 
signatures will print in shades of gray when printing to a printer using MICR toner. 

Save the scanned file onto a disk and reference the file in the appropriate Form File or Bank record.  Be sure to 
reference the entire path and filename, not just the filename.  For example, enter A:\my_boss.bmp in the appropriate 
Form File or Bank record.  There is a 40 character limit for the filename and path. 

Make sure the disk with the signature file is in the specified drive before printing checks to PrintBoss.  An error will 
pop up (unless this option has been turned off in the Pic Command Properties dialog for the form) when checks are 
printed or viewed and the signature disk is not in the specified drive. 

ADDING A SIGNATURE TO A CHECK  

Signatures must be referenced by the PrintBoss Select form in order to print on a check.  Add a #PIC command 
referencing the signature file to each form that prints the signature (such as AP and Payroll).  Add a second #PIC 
command when you need to print two signatures. 

If the same signature is used for every bank account, the signature file name and path can be added directly to the 
#PIC command on the form.  Otherwise, add the signature file name to the PrintBoss bank record and add the 
variable name associated with the field in the bank record containing the signature file name to the #PIC command.   

PrintBoss provides sample signature commands near the bottom of the Footer Objects tab on all standard forms.  

1. Locate the PrntBoss Home directory.  You can determine the location by clicking on the PrintBoss Help 
menu and choosing About.  The location for Home is listed under the Directories section towards the 
bottom of the window. 

2. Copy your signature files, including *.sig encrypted signature files, into the Logos folder in the PrntBoss 
Home directory. 

3. Open the PrintBoss Master Application. 
4. Add the Signature File 

a. Bank Record 
i. Click on the Edit menu and select Bank List. 

ii. Select the appropriate Bank record and click the Edit Bank button. 
iii. Select the Signatures_Logos tab. 
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iv. Click on the browse button next to the Signature Properties field.  PrintBoss 
automatically opens the Logos folder in the PrntBoss home directory.  You may browse 
to a different location if your files are not in this folder. 

v. Select the desired signature and click Open. 
vi. Repeat for Signature 2 Properties if two signatures may appear on the check. 

vii. The Position coordinates properly place signatures on the bottom stub of a check. 
viii. Set a Hi Range Condition if desired.  For example, enter 5000.00 if the signature should 

not print when the check amount exceeds $5,000.   
ix. Set a Lo Range Condition if desired.  For example, enter 5000.00 if Signature 2 only 

prints when the check amount is $5,000 or more. 
x. Click OK to save the values and exit the PrintBoss Bank Edit window. 

xi. Click Done to exit the PrintBoss Bank List. 
b. Form File 

i. Click on the Edit menu and select Form Files. 
ii. Select your form from the list and click the Editor button. 

iii. Select the Footer Objects tab. 
iv. Scroll to the bottom of Footer Objects and locate the Sample Signature section. 

1. Use the command starting with #PIC to add a signature file directly to the form.  
Remove the pipe symbol (|) if it appears before the # sign to activate the 
command. 

2. Use the command starting with #[FileExists if you added the signature file 
through the bank record. 

5. Double click on the appropriate command in the Footer Objects window.  The Pic Command Properties 
dialog opens.  
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6. Enter appropriate values into the fields. 
a. Inches from Left – Enter the inches from the left side of the page to begin the signature file.   

i. {BSIGX} is the default value and refers to the value entered in the X Position field in the 
Bank record.   

NOTE: 

Click the Edit Bank button at the bottom of the Pic Command Properties dialog to change this value.  DO 
NOT enter a specific value in place of the {BSIGX} variable.  This may adversely affect other signatures files 
using this same form. 

ii. {BSIG2X} is the default value associated with Signature 2 in the Bank record. 
b.  Inches from Top – Enter the inches from the top of the page to the top of the signature file. 

i. {BSIGY} is the default value and refers to the value entered in the Y Position field in the 
Bank record. 

ii. {BSIG2Y} is the default value associated with Signature 2 in the Bank record. 
c. Size Adjust – Enter inches to adjust the width and height of the signature file to size the width 

differently than the height or enter a Percent value to adjust the width and height by the same ratio. 
i. Wdt/Ht 

1. {BSIGWD} and {BSIGHT} are the default values referencing the Wdt and Ht 
values entered in the Bank record. 

2. {BSIG2WD} and {BSIG2HT} are the default values associated with the width 
and height values for Signature 2 in the Bank record. 

ii. Percent 
1. Enter {BSIGSIZE} in both the Horizon. and Vertical fields to reference the 

Percent value entered in the Bank record. 
2. Enter {BSIG2SIZE} in both the Horizon. and Vertical fields to reference the 

Percent value associated with Signature 2 n the Bank record. 
d. Graphic File – Enter the signature file name and path.  Only the file name is required if the 

signature is located in the Logo folder of the PrntBoss Home directory. 
i. {BSIGFile} is the default value and refers to the file name entered in the Signature 

Properties field in the Bank record. 
ii. {BSIG2File} refers to the file name entered in the Signature 2 Properties field the Bank 

record. 
e. Sig Disk Drive Letters – Enter the letter(s) associated with the drive containing the signature disk 

if this is an encrypted file (*.sig).  A series of letters may be entered if there is more than one 
possible choice, such as DEFG.   
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f. Condition – Enter any required conditions.  The example above prints the signature file if it exists 
and if the check amount meets the range condition.  The values for the range condition in this 
example are entered in the Bank record.  

7. Click OK to save changes and close the Pic Command Properties window. 
8. Click OK to save changes and close the Form Editor. 

Typically, placement for the signature is relatively close to the signature line.  Signatures from a disk in the 
computer will appear in the View if there are no conditions on the signature. Amount conditions can be simulated in 
the View by entering a value in the Dollar field at the top of the window.  (See Chapter 9, Form Files – Modify 
From the Document View).  Drag the signature to adjust placement or double click on the signature to edit the 
properties, including size.  Location and size will display as variables for signatures stored in bank records.  It is best 
to make these adjustments to the bank record, though the variables can be overwritten by numeric values.  Numeric 
values will overwrite the variables for all bank records, not just the currently selected bank record. 

Repeat the steps for a second signature file.  Verify the coordinates for the second signature file are higher on the 
page so it does not print on top of the first signature. 

 See Chapter 9, Form Files, for more information on the #PIC Command. 

USING PRINTBOSS SIGNATURE DISKS 

Follow the instructions sent with the secured signature or refer to the instructions above in the Adding a Signature to 
a Check Form section. 

Make sure the disk is inserted in the drive before checks are sent to PrintBoss.  An error will pop up (unless that 
option has been turned off in the Pic Command Properties dialog for the form) when checks are printed and the 
PrintBoss Signature Disk is not in the specified drive.  The error allows the disk to be inserted into the drive before 
continuing or allows the user to skip the use of the disk and signature(s).  The checks will print without the 
signature(s) when the disk is skipped. 
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Chapter 

13 
WORK FILES 

PrintBoss Select captures documents to a work file.  Documents stay in the work file until they are overwritten.  
Work files can be reprinted and sorted.  PrintBoss also allows you to create reports to view or print lists of these 
documents. 

CONFIGURE WORK/ARCHIVE FILES 

Work and Archive files can be saved by user. 

1. Open the PrintBoss Master Application. 
2. Click on the Options menu and select Configuration. 

 

3. Locate the Private Folder Names section on the Settings tab. 
a. Work Files – The recommended setting for Work Files is {WinUserName}.  PrintBoss will 

create folders by Windows User Name in the Work folder of the PrntBoss Home directory.  This 
allows each user to track their own documents and prevents other users from accidentally 
overwriting the work files. 

4. Select the Set Globally check box to save the {WinUserName} setting for all PrintBoss Select users.  This 
applies to both the Work Files and Archive Files when they display the {WinUserName} setting. 
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5. Select Allow temporary folder change when browsing work file when individual folders are used for 
users and a Supervisor or Wellspring technician needs to browse and view the files of another user.  
Browsing these files is explained later in this section. 

6. Click OK when you are finished. 
7. Click on the Edit menu and choose Form Files. 
8. Select the desired form and click the Editor button. 

 

9. Click on the Immediate Print Dialog Method drop down menu on the Settings tab and choose a Print 
method. 

a. Prompt to start printing – PrintBoss Select will prompt the user before printing begins.  This 
provides time to put check stock in the printer tray or verify the printer destination. 

b. Start printing w/out prompt – PrintBoss Select will send the print job from the HAS directly to 
the printer with no prompt. 

10. Click OK on the Form Editor to save your changes. 
11. Click Done to exit the Form Select window. 

OPEN DOCUMENT WORK FILES 

Documents are temporarily stored in the Work File between print jobs.  These documents may be Printed, Browsed, 
Indexed, or printed in a Report list. 

1. Open the PrintBoss Master Application. 
2. Click on the File menu and select Open Document Work Files. 
3. Select a form from the list and choose an action from the buttons on the right side of the window. 

a. Print – Reprint a selected document or all documents in the Work File.  A range can be selected 
from the Scope.  Be sure to select the Allow Reprints and Original check boxes or any other 
available copies before clicking the Print Start button. 
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Select the Close on completion checkbox to automatically close this window after reprinting a 
doucment 

b. Browse – View a list of the documents in the selected Work file and confirm their Printed status.  
Capital letters in the Printed column indicate successful printing.  Lower case letters indicate 
printing was not successful. 

 

The following is a list of print codes: 

1. O – Positive Pay 
2. P – Print  
3. S – Skipped (intentionally) 

 
i. Select a document and click the View button to preview the entire document.  See 

Chapter 9, Form Files – Modify from the Document View, to learn more about this 
feature. 

ii. Click the Print button to print the selected document. 
iii. Click on the drop down menu to the left of the View button or click on a dark gray 

column heading to sort the list.  Sorting is only available when the Work or Archive File 
has been Indexed. 

iv. Right-click on a document in the list to view additional choices: 
1. View – View the selected document(s) 
2. Print – Print the selected document(s) 
3. Edit – Open the Work File Edit window 
4. Hold Record – moves selected document(s) to a new work file with the same 

name and appended with ‘- HOLD’. 
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5. Delete – Delete the selected document(s) 
6. Edit Form – This is a shortcut to open the Form Editor 

c. Delete – Delete documents in the selected Work or Archive File that meet one of the following 
conditions.  This action cannot be reversed. 

i. Delete Only Completed Records (original and all copies printed). 
ii. Delete Records Created Between a specified data range. 

iii. Delete All Records. 
d. Index – Index the documents in the Work or Archive File for sorting. 

i. The two choices presented when no Index exists are: 1) Leave with no index; and 2) 
Index file.  Choose Index file to sort the documents in the File Browse window. 

ii. The choices change when a Work or Archive File has been Indexed:  1) Disable Indexes; 
and 2) Rebuild Existing Index. 

iii. Select Pack Database on the Index Maintenance window to resize a file after many 
documents have been moved or deleted. 

e. Report – Work/Archive Reports creates a list of reports 
that meet the specified criteria.  This is a great auditing and 
search tool.  Click the View/Print Report button after 
entering your criteria to View and Print a list of the results. 

i. Order – Only Natural Order is available in 
PrintBoss Select.  This is the order the documents 
were sent to PrintBoss Select. 

ii. Bank – Select a bank record to report on 
documents associated with a specific bank 
account.  An asterisk (*) can be used as a wildcard 
to select all bank records or bank records that start 
with the same name. 

iii. Date/Time Range – Use the calendar buttons or 
type in the fields to specify a data range.  Type in 
the far right fields to enter a time range.  This is 
particular helpful for audit trails. 

iv. Recipients – The recipient range is alphabetical.  
Enter Lockhaven and Sloan to select all recipients 
that appear alphabetically between these two 
names. 

v. Document Numbers – This range is alpha-
numeric. 

vi. Document Amount – This range is only numeric. 
vii. Document Misc. – This range is alpha-numeric. 

viii. A sample of the report results is displayed below. 

 

4. Select the Print button to print this list. 



PrintBoss Select 99 Electronic Copy 

5. Click Close to close the Batch print window. 
6. Click Close to close the PrintBoss Work/Archive Reports window. 
7. Click Done when you are finished with Work/Archive File Select 

BROWSE WORK FILE SELECT 

You can browse for Work files created by other PrintBoss users when Allow temporary folder change when 
browsing work file is selected on the Configuration dialog under the Options menu. 

1. Open the PrintBoss Master Application. 
2. Click on the File menu and choose Open Document Work Files. 

  

3. Click on the browse (folder) button at the bottom of the window. 

NOTE: 

The folder button is not present unless the Allow temporary folder change when browsing... option is selected 
on the Configuration dialog under the PrintBoss Select Options menu. 

4. Select a different user from the Browse for Folder list.  Occasionally there are files under the main Work 
folder as well. 

5. Click OK.  The work/archive files for the selected user will display in the Work/Archive File Select list. 

WORK FILE EDIT 

The Work Edit window for Work Files contains useful information and functionality. 

1. Open the PrintBoss Master Application. 
2. Click on the File menu and choose Open Document Work Files. 
3. Select a Form from the list and click the Browse button. 
4. Right-click on a document in the list and select Edit.  The Work File Edit window opens. 
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 The fields are Read Only except for the Form, Misc (Fax Phone), and Misc2 (Email Address) fields. 

5. A description of these fields follows. 
a. Batch Date/Time – Displays the date and time the work file was created. 
b. Record Date/Time – Displays the date and time the selected document was created. 
c. Form – Displays the Form used to process this document.  Edit this field to display and print this 

data on a different form. 
d. Bank – Displays the name of the bank used to process this document.  Changes to this field will 

not update the document. 
e. Document Number – Displays the check number.   
f. Document Amount - Displays the check amount.   
g. Document Recipient – Displays the Payee or Recipient if this is a check. 
h. Printed – Displays the status for each copy of this document.  Upper case characters indicate the 

document was successfully printed or skipped.  Lower case characters indicate a print failure.  
Blank indicates no printing was attempted. 

i. Misc (Fax Phone) – Displays the contents of the DocMisc field.  Enter a fax number to refax or 
manually fax a document copy set to <Fax Service>. 

j. Misc2 (Email Address) – Displays contents of DocMisc2.  This is often used for email addresses 
in the Standard or Enterprise editions of PrintBoss. 

k. Status Log – Displays status information for E-mail and Fax Service copies sent from PrintBoss. 
6. Click OK when you are finished.
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Chapter 

14 
DEPOSIT SLIPS 

Deposit Slips can be printed from a Form File or as a Utility.  This section describes the Utility. 

PrintBoss Select Deposit Slips are often printed independently of the accounting software.  This is the more 
conventional sense of a deposit slip.  The Deposit Slips can include the MICR, bank information, and company 
information from a PrintBoss bank record.   The detail (description and amount) is hand entered on the screen. 

Any number of deposit slip files may be created.  Each file typically specifies the bank record and a form (Deposit1 
or Deposit3).   

NOTE: 

Printing deposit slips from PrintBoss Select does NOT update the accounting software's database. 

CREATING/EDITING DEPOSIT SLIPS 

1. Open the PrintBoss Master Application. 
2. Click on the Utilities menu and select Deposit Slips.  A list of deposit slip specs defined by others may 

appear in the Deposit Slip Selection window.  Otherwise, the list will be blank. 
3. Select a deposit slip from the list or click the Create button and enter a Name for the deposit slip.  Long 

names may be truncated based on the width of the Deposit Slip Selection window. 
4. Click OK.  The new name appears in the Deposit Slip Selection list. 

 

5. Select your deposit slip and click the Editor button. 
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6. Fill in the following fields. 
a. Bank Information – This information will update once you select a bank record from the Bank 

Selection drop down menu.  The Bank Information fields are not editable. 
b. Company / Account Information – This information will update once you select a bank record 

from the Bank Selection drop down menu.  These fields are not editable. 
c. Bank Selection – Choose the correct bank account for this Deposit Slip. This menu lists all the 

bank records from the PrintBoss Bank List.   
d. Form Selection – In most cases, this should be set to either the Deposit1 or Deposit3 form.  

Deposit1 prints a single deposit slip with a copy above the actual slip.  The copy does not print the 
MICR line.  Deposit3 prints a deposit slip with two copies – all of the slips print the MICR line.   

NOTE: 

This Deposit Slip form is different than the form that is used to print deposits directly from QuickBooks.  The 
form that is triggered from QuickBooks is QB_Dpst2 and is available in Top, Middle, and Bottom deposit 
formats. 

e. Print Deposit Date – Check this option to print a date on the deposit slip.  This field can be edited 
once it is selected.  

f. Print Copy – This option is only available when Printer is selected as the output. A copy of the 
deposit slip is sent to the printer with the words Deposit Slip Copy printed on the second page 
where the MICR line appears on the first page. 

g. Send output to – There are two options on this drop down menu. 
i. Printer –Send the deposit slip(s) directly to the printer.  No work or archive file is 

created.  The destination printer is defined by the selected form. 
ii. Work File – Process the deposit slip(s) using the form's settings for print time and 

copies.  A work file is created.  This is the recommended setting. 

 See Chapter 9, Form Files, for more information on form settings. 
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7. Description and Amount entries made on the right-hand side of this dialog do not carry over to the Print 
function.  They are only for Preview purposes. 

8. Select Preview to view the deposit slip layout before printing. 
9. Click Close on the Deposit Slip Print Utility dialog when you are finished making changes. 

NOTE: 

There should be one Deposit Slip created for each bank account that prints deposits. 

PRINTING DEPOSIT SLIPS 

1. Open the PrintBoss Master Application. 
2. Click on the Utilities menu and select Deposit Slips.  A list of deposit slip specs appear in the Deposit Slip 

Selection dialog.  If the list is blank or the deposit slip needed is not in the list, return to Creating/Editing 
Deposit Slips above for instructions on how to create a deposit slip. 

3. Select the desired deposit slip and click Print.  The specification fields are displayed in the Deposit Slip 
Print Utility dialog. 

4. Confirm the Bank Selection is correct.  This field determines the Bank Information and Company / 
Account Information. 

5. Enter the appropriate Descriptions and Amount detail.  PrintBoss will keep a running total at the bottom 
of the screen.  The final total will be printed on the deposit slip.   

6. Click Preview to view the deposit slip before printing.   
7. Click the Print button to create the deposit slips. 
8. Click Close on the Deposit Slip Print Utility dialog when you are finished. 
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Chapter 

15 
POSITIVE PAY 

An increasing number of banking institutions are offering a service often called Positive Pay.  This is a specially 
formatted file listing all valid checks written on the bank account.  The file is sent to the bank and only checks 
identified in this file are cashed by the bank.  If the bank receives checks that are slightly different, the bank will not 
accept the checks.  This feature is offered for fraud prevention. 

PrintBoss Select can generate a Positive Pay file for each check in a batch.  The form must be edited to add and 
assign a copy to enable this feature.  The copy is designated as a Positive Pay file.  The structure of the Positive Pay 
file is designed to match individual bank requirements.  Rarely are requirements the same for different banks. 

The Positive Pay specifications become part of the Form File.  The specifications can be exported to a PrintBoss 
Positive Pay file (extension of ".ppp" in the PosPay subdirectory of PrintBoss).  This file can then be imported into 
another form.  Note that the .ppp files imported and exported from within the PrintBoss Form Editor are NOT the 
actual Positive Pay files sent to the bank.  They are simply the scripts PrintBoss Select uses to create the file. 

SETUP IN PRINTBOSS 

1. Open the PrintBoss Master Application. 
2. Click on the Edit menu and select Form Files.   
3. Highlight the appropriate form and click the Editor button. 
4. Increase the number of Copies by 1on the Settings tab.   
5. Click on the Multi-Parts & Printers tab and select <Positive Pay File> as the Destination for the new 

copy.  A page symbol will appear in the column to the right of the Destination column. 
6. Click on the page symbol to open the Positive Pay Editor. 

 



PrintBoss Select 106 Electronic Copy 

7. It is usually easier to import an existing Positive Pay spec and modify it to meet the specifications of the 
current bank.  Click on the Import button on the Master tab of the Positive Pay Editor.  The browse opens 
to the PosPay folder in the PrntBoss Home directory 

8. Select the Sample Bank Spec included with PrintBoss Select and click Open if you do not have another 
positive pay spec to use.  Otherwise, choose your positive pay spec. 

9. Enter a File Name and path for this Positive Pay file.  The Enterprise edition of PrintBoss allows macro 
characters to be used in the file name to create a dynamic file name when a batch of checks is printed. 

10. Select Confirm Path/Filename at runtime.  (This can be skipped in the Enterprise edition). 
11. Choose a New File Name Generation method.  The default is Start of Batch.  The choices are: 

a. Start of Batch 
b. Each new page 
c. Each new DocNo – Select this option when using variables in the file name  The use of variables 

in file names is only available in the Enterprise edition of PrintBoss. 
12. Select the File Type.  The default of Standard should always be used when creating Positive Pay files. 
13. Choose Append Overwrite Method.  The default is Overwrite existing File.  The choices are: 

a. Overwrite existing File 
b. Append to existing File 
c. Prompt for Overwrite, Append, Cancel 

14. You may select the Exclude records with zero amount option.  . 
15. Select Auto add CR/LF to each script only when you are creating a new Positive Pay File and would like 

PrintBoss Select to automatically add this carriage return/line feed command at the end of each script. 
16. The Comments field is optional and for your use. 
17. The SignOn tab is provided for the rare occasion when a sign on or introduction to the Positive Pay file is 

required by the bank. 
18. Fill in the Header section when a header is required by the bank.  This information usually includes: 

a. Account number 
b. Company name 
c. Batch date 

19. Fill in the Details section according to the bank's specifications.  This section is always required for a 
Positive Pay file and often includes: 

a. Account number 
b. Check number 
c. Check amount 
d. Check date 
e. Check recipient 

20. Fill in the Footer section according to the bank's specifications.  This section is often required and provides 
a summary of the batch.  This may include: 

a. Batch count 
b. Batch amount sum 
c. Batch date 

21. The SignOff tab is provided for the rare occasion when a sign off is required to indicate the end of the 
Positive Pay file.  This tab can also be used to display a File Count or File Amount value. 

22. Click OK at the bottom of the Positive Pay Editor to save changes and close the window. 
23. Click OK on the Editing Form window. 

NOTE: 

The following are tips for the Header, Details, and Footer sections.   

 Each line is usually treated as a field with the content enclosed in quotes. 
 Often it is helpful to add comments to the end of a line, starting the comment with the pipe character ( | ).  

The pipe character is the Shift and \ keys on your keyboard. 
 Substitution functions are available within PrintBoss Select.  Right click on any Positive Pay tab except 

Master, select List / Stuff Assignments, and then select the arrow sign next to Positive Pay / ACH Fields 
to view a list of available substitution functions specific to Positive Pay.  PrintBoss Select evaluates each 
function and substitutes the resulting value in place of the function including the braces that surround the 
function.  Functions can be nested within other functions.  Use caution.  Confusion may occur with 
delimiting the functions and parameters.  Sometimes it is preferable to create a value from a series of steps 
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with delimiters to eliminate confusion and make the command clearer.  See Chapter 10, #Text Command – 
Substitute Function Description, for an example. 

 Most sections usually end with a Carriage Return/Line Feed.  This is represented with the expression 
Chr(13)+Chr(10) or {CF/LF}. 

 Often there are fields relative to a bank account that need to be entered into the Positive Pay file.  It is 
helpful to make use of the miscellaneous 1 through 5 fields in the PrintBoss Select bank record and 
reference the information using the variable names {BMisc1} … {BMisc5}. 

ENTERING ACCOUNT/ROUTING NUMBERS 

There are 3 ways to enter an Account Number or Routing number into a Positive Pay spec. 

1. Explicitly type the Account or Routing number into the spec.  This is the most direct method, but it 
becomes a problem when more than one bank account is used by the same form since these values will not 
change dynamically. 

2. Enter the Account or Routing number into one of the five MISC fields on the bank record.  An advantage to 
this method is that you can type the number exactly as the bank wants it to appear.  On rare occasion, the 
display of these values on the MICR line is not the way the bank wants them expressed in the PosPay file.  
The down side is remembering to keep the MISC field current in the bank record. 

3. Use the calculated fields, {BMicrAcctNo} and {BMicrRoutNo}, in PrintBoss Select.  The values of these 
fields are calculated each time they are accessed by examining the full MICR line and pulling out the 
appropriate sections.  The advantage is no additional support is needed.  The disadvantage is that on rare 
occasion the format of the account number in the Positive Pay file needs to be a little different than the 
MICR line. 

OPERATION 

Once the Positive Pay file is configured, it is treated as another printer.  Select the Multi-Parts & Printers tab in the 
Form Editor and set the Print Time to print Immediately or as a Batch.  Click on the File menu, select Open 
Document Work Files and select the form name to print when the Print Time is set to Batch.  Print the whole file or 
set a range in the Scope to print only part of the file.  

The work file may also be used to reprint or test print portions of the file.  Be sure to check Allow Reprints as well 
as the copy marked Positive Pay when reprinting checks from the work file. 

NOTE: 

The Printed column in the Browse list of the work file indicates the status of the printed documents.  Positive 
Pay copies display the letter O (for pOsitive pay) when printing is successful.  The capital O turns into a small 
case "o" when the copy has been reprinted. 

It is important that the form’s Auto Archiving method on the Settings tab is NOT set to Overwrite Work File 
at Start of Batch when the Print Time for the Positive Pay copy is set to Batch on the Multi-Parts & Printers tab 
of the Form Editor.  You could potentially overwrite a work file before the Positive Pay copies have been 
printed to a file. 

 See Chapter 9, Form Files. 

COMMON SUBSTITUTE FUNCTIONS USED 

There are a number of functions in PrintBoss Select that are helpful when setting up the Header, Details, and Footer 
sections.  A list of these functions can be accessed by right clicking in the scripting areas and choosing List / Stuff 
Assignments.  
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A few of the most commonly used functions are defined in Chapter 10, #Text Command, under Substitute Functions.  
These include: CurrentDate, CurrentTime, FormatNum, Pad, RECDate, and RECTime.  See Chapter 10 for the 
complete explanation of these functions. 

In addition, there are several substitute functions specific for Positive Pay files.  Descriptions of these functions 
follow. 

BatchAmnt 
{BatchAmnt} 

This function provides the sum of all the checks in a batch and is usually placed in the Footer tab of the Positive Pay 
File Editor. 

Example:  "{FormatNum: '{BatchAmnt}', 8, 2, '0', '0', Hide}"  |This function formats the batch amount to 8 digits to 
the left of the decimal, 2 digits to the right of the 
decimal, fill left with zeros, fill right with zeros, 
and hide decimals. 

BatchChkNoSum 
{BatchChkNoSum} 

This function provides the sum of the check numbers in a batch and is usually placed in the Footer tab of the 
Positive Pay File Editor. 

BatchCount 
{BatchCount} 

This function provides the number of checks in a batch and is usually placed in the Footer tab of the Positive Pay 
File Editor. 

Example:  "{FormatNum: '{BatchCount}', 10, 0, ' ', '', Hide}"  |This function formats the batch count to 10 digits to 
the left of the decimal, 0 digits to the right of the 
decimal, fill left with spaces, no fill right, and 
hide decimals. 

CommaDelimit 
{CommaDelimit: ÷<string>÷[,<ForceQuotesY/N>]} 

This function prepares a string for a csv file and encloses commas occurring in the string in double quotes as well as 
quotes occurring in the string in double quotes.  This allows all the data in the field to display.  Otherwise, the field 
will cut off at the comma or double quote.  The function can be used in the Detail or Footer tab of the Positive Pay 
File Editor and only applies to files that are saved to a csv format.  An option allows forcing a field without quotes 
to be encapsulated in double quotes if double quotes may occur in the field for uniformity in displaying the data. 

Example:  "{CommaDelimit: '{DocRecip}'}"  |A name enclosed in quotes in the DocRecip field will evaluate 
properly instead of cutting off part of  the line.  The name Robert 
"Bud" Shipman displays in full instead of stopping after the 
name Robert.  The same example would work if there was a 
comma in the DocRecip field, such as James King, III. 

CR/LF 
{CF/LF} 

This function adds a carriage return / line feed at the end of each Positive Pay tab that is used.  This is the same as 
using: Chr(13)+Chr(10).  Unlike most of the other functions, there are no double quotes around CR/LF. 
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CSV or TSV 
{CSV: ÷<string>÷[,<ForceQuotesY/N>]} 

This function creates a complete line for csv fields and encloses commas occurring in the string in double quotes as 
well as quotes occurring in the string in double quotes.  Unlike the CommaDelimit and DBQuotes functions, quotes 
are not used to offset this function.  An option allows forcing a field without quotes to be encapsulated in double 
quotes if double quotes may occur in the field for uniformity in displaying the data. 

Example:  {CSV:÷{DocRecip}÷,'Y'}  |Forces all DocRecip fields to be enclosed in double quotes.  Note there are no 
quotes surrounding this function. 

DBQuotes 
{DBQuotes: '<string>'} 

This function is similar to the Comma Delimit function, but it only looks for double quotes in the string and applies 
to Positive Pay files saved to the .txt format.  The function can be used in either the Detail or Footer tab of the 
Positive Pay File Editor. 

Example:   "{DBQuotes: '{DocRecip}'}"  |The name Robert "Bud" Shipman will display fully in the Positive Pay 
file using this function.  Otherwise the name would display as Robert 
only. 

FileAmnt 
{FileAmnt} 

This function returns the sum of all checks in a file and is usually placed in the SignOff tab of the Positive Pay File 
Editor. 

FileBatches 
{File Batches} 

This function returns the sum of all batches in the Positive Pay file and is usually placed in the SignOff tab of the 
Positive Pay File Editor. 

FileChkNoSum 
{FileChkNoSum} 

This functions provides the sum of all check numbers in the Positive Pay file and is usually placed on the SignOff 
tab of the Positive Pay File Editor. 

FileCount 
{FileCount} 

This function returns the number of records in a file and is usually placed in the SignOff tab of the Positive Pay File 
Editor. 

PosPayFileCounter 
{PosPayFileCounter: '<ZeroFillDigits>'} 

This function adds a unique file creation number for those banks who require this feature and is normally added to 
the Header tab of the Positive Pay File Editor.  The value after the function indicates the number of characters in the 
file counter.  PrintBoss Select will automatically increment the counter by 1 every time a Positive Pay file is printed. 

Example:  "{PosPayFileCounter: '8'}"  |This function creates a unique file creation number filled with zeros up to 8 
characters. 
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PosPayFileExt 
{PosPayFileExt} 

This function provides the extension of the current positive pay file that is created by PrintBoss Select. 

PosPayFileName 
{PosPayFileName} 

This function provides the name that is being used for the current positive pay file.  

 See Chapter 10, #Text Command, for additional information on Substitute Functions.
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Chapter 

16 
ACH SETUP 

ACH file specifications are established by NACHA – The National Automated Clearing House Association.  
PrintBoss 5.65.1 and above contains a file with the standard NACHA specifications for use with PrintBoss.  This file 
is accessed through the Positive Pay feature in PrintBoss Select. 

Company (originator) specific data is stored on the ACH Definition tab of the Bank Records in PrintBoss.  Receiver 
specific data can be stored in a Payee List in PrintBoss and associated with a bank record. 

BANK SETUP 

This is outlined in Chapter 8, Bank Accounts, under item ‘4f’ of the ‘Create A Bank Record’ section. 

PAYEE LIST SETUP 

PrintBoss Select can use data required to create the Detail records for the ACH file from the Payee List.  This 
section covers setting up the Payee List. 

1. Open the PrintBoss Master Application. 
2. Click on the Edit menu and choose Payee Lists. 
3. Click Create to start a new Payee List. 

a. Enter a File Name for the list.  There are no requirements for the File Name. 
b. Click OK to create the list entry. 

4. Select the list you created and click the Editor button.  The Payee List Browse opens. 
5. Entries can be made one at a time in the list by clicking on the + sign, or imported from a csv file.  This 

section covers exporting a template to a csv file and importing back into the Payee List when completed.  
The first step is to create 1 record in the list to export the column headings. 

a. Click the plus sign (+) to create the first record.  The Payee List Edit window opens. 
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b. Select Active in the top right corner. Enter the first Payee as it was entered in the accounting 
software. 

c. Click O.K. to save this record. 

6. Right click on the gears  in the top left corner of the Payee List Browse grid and choose Export.  
PrintBoss will indicate 1 record is selected. 

7. Click Yes. 
8. Enter a name and location to save this file.  PrintBoss will save it as a Comma Delimited (*.csv) file. 
9. Navigate to the save location and open the *.csv file. 

10. Enter values in the following fields.  Many of these fields are associated with the Detail tab of the ACH 
File Editor: 

a. Payee – Enter the payee name as it appears in the accounting software.  PrintBoss Select uses this 
field to match the payee name on the check. 

b. Payee ID – Enter an ID for this payee if there are two or more identical names.  This field is 
optional. 

c. Active – Enter Y to activate this record.  N denotes an inactive record. 
d. Email – Ignore this field.  The Email feature is not available in PrintBoss Select. 
e. Mode1 – Enter the Mode for Account 1 to determine the amount of the ACH transfer.  The most 

common choice is 1, Remainder of Check, to pay the entire amount of the check. This choice 
requires no additional Amount/Percent entries.  The choices are: 

i. Inactive – Enter 0 (zero). 
ii. Remainder of Check – Enter 1. 

iii. Percent – Enter 2. 
iv. Set Amount – Enter 3. 

f. Amnt1 – Enter a fixed Amount or Percent for Account 1 for this payee.  Leave blank if 
Remainder of check is selected for the Mode.  The field name is {ACHAmount} and contains 10 
characters, 8 dollar places and 2 cents places. 

g. BnkID1 – Enter the routing number for Account 1 for this payee.  This matches the Bank ID field 
on the Payee List.  The field name is {ACHRecvBankID} and contains 9 characters, 8 for the 
routing number and a check digit added by PrintBoss in accordance with ACH Rules. 
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h. BnkAct1 – Enter the account number for Account 1 for this payee.  This matches the Bank 
Account Num. field on the Payee List.  The field name is {ACHRecvBankAcct} and contains 17 
characters. 

i. Name1 – Enter the Individual/Company Name for this payee as it appears on Account 1.  The 
field name is {ACHRecvName} and contains 22 characters. 

j. ID1 – Enter the Individual/Company ID for this payee if there are two or more identical names.  
The field name is {ACHRecvID}, contains 2 characters, and is optional. 

k. Disc1 – Enter an optional 2-digit code for this account that is meaningful only to the originator.  
The field name is {ACHRecvDisc}, contains 2 characters, and is optional. 

l. TransCode1 – Enter a code to identify if the Account Type.  The field name is 
{ACHTransCode} and contains 2 characters.  The values are: 

i. 22 = Checking 
ii. 32 = Savings 

m. PRE1 – Only select PreNote (Y) if this account is added after the PreNote file has passed the 
bank. 

n. The following is an image of the Details tab for the ACH File Spec where these fields are used: 

 

11. Only enter Account 2 or Account 3 if the amount of the check is to be divided between more than one bank 
account. 

12. Save changes to this file and click Yes to keep the features. 
13. Return to PrintBoss Select, click on the Edit menu, and choose Payee Lists. 
14. Select the appropriate Payee List and click Editor. 

15. Click on the gears  in the top left corner of the Payee List Browse grid and select Import. 
16. Select the appropriate csv file and click Open.  The list will populate with the csv entries. 

17. Select a record and click the up arrowhead  to make changes to the selected file. 
18. Click the Done button when you are finished. 

FORM SETUP 

In addition to the Bank and Payee Lists, the PrintBoss Form needs to be setup to print the ACH file.  First, we will 
add a copy to the PrintBoss form to create the ACH file. 

1. Open the PrintBoss Master Application. 
2. Click on the Edit menu and choose Form Files. 
3. Select the appropriate PrintBoss form and click the Editor button.  The Editing Form window opens. 
4. Select the Settings tab. 
5. Increase the number of copies by 1.  For example, if the current Copies value is zero, type1 in the field. 
6. Select the Multi-Parts & Printers tab. 
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7. Click on the Printer & Tray Selections Saved In… drop down menu and select <Form> to save these 
changes for all users. 

  

8. Locate the new copy, click on the Destination Printer/Device drop down menu, and select <Positive Pay 
File>.  This feature supports ACH files in addition to Positive Pay files.  The ACH file is Embedded in the 
Form. 

9. Click on the Source Tray drop down menu and choose ACH Sample.  This is the NACHA file that comes 
with PrintBoss. 

a. In the above sample, the ACH Sample has been embedded in the Form.  The following are steps to 
embed the ACH Sample in the Form. 

i. Click on the Source Tray drop down menu for the ACH copy and choose <Embedded in 
Form>. 

ii. Click on the page symbol to the left of the Source Tray to open the Positive Pay / ACH 
File Editor.  The following is an image of the Master tab. 
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1. File Name – Set the destination path and file name for the ACH file in the File 
Name field.  The browse button at the end of this field can be used to navigate to 
a location and will save the path when a file name is entered. 

2. Confirm Path / Filename at runtime – Select this option to verify the 
destination location or file name before PrintBoss saves the ACH file. 

3. New File Name Generation – The default is to generate a new file at Start of 
Batch.  This is the recommended setting. 

4. File Type – The file type should be set to ACH. 
5. Append Overwrite Method – The default is Overwrite existing File.  The 

choices are: 
a. Overwrite existing File 
b. Append to existing File 
c. Prompt for Overwrite, Append, Cancel 

6. Exclude records with zero amount – This option is typically not used with 
ACH files. 

7. Auto add CR/LF to each script – This feature adds a carriage return to the end 
of each script and should ALWAYS be checked for ACH. 

8. Import – Click this button to import the ACH Sample to embed in the PrintBoss 
form. 

9. Export – This feature is used to save a file created as embedded in form.  It is 
usually not used with ACH. 

10. Comments – Provides comments associated with the ACH file. 
iii. Click the Import button and select ACH Sample to embed this file into the current form.   

b. The ACH Sample can be embedded into more than one PrintBoss Form and each embedded file 
can utilize a different file path and name. 

10. There are 7 tabs associated with the ACH File.  The first 5 have been described previously in this 
document.  The last two are as follows: 

a. Footer – The Footer tab contains fields for the “8” record(s) and apply specifically to a batch. 

 

i. ACH Service Class Code – The information for this field is entered in the ACH 
Definition tab of the PrintBoss bank record.  The variable name is 
{bACHSvcClasscode}. 

ii. Batch Count – Generates the total number of entries for the preceding batch.  The 
variable name is {BatchCount}. 

iii. ACH Batch Hash – This variable generates a value from the routing numbers entered for 
each detail record in the batch.  The value provides a check against inadvertent alteration 
of data contents.  The variable name is {ACHBatchHash}. 

iv. Batch Amount – Generates the sum of all check amounts for the preceding batch.  The 
variable name is {BatchAmnt}. 

v. ACH Company ID – The information for this field is entered in the ACH Definition tab 
of the PrintBoss bank record.  The variable name is {bACHCompID}. 
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vi. Originating DFI ID – The information for this field is entered in the ACH Definition tab 
of the PrintBoss bank record.  The variable name is {bACHOrgDFIID}. 

vii. Batch Number – PrintBoss generates a sequential number for each batch in the file 
beginning with 0000001.  The variable name is {FileBatches}. 

b. SignOff – The SignOff tab contains fields for the “9” record and applies to the entire file. 
i. File Batches – Generates the total number of batches in the file.  The variable name is 

{FileBatches}. 
ii. ACH Block Count – Generates the correct number of lines to create complete blocks of 

10 lines or 940 characters.  These appear as rows of 9 at the end of the file. The variable 
name is {ACHBlockCount}. 

iii. File Count – Generates the total number of entries in the file.  The variable name is 
{FileCount}. 

iv. ACH File Hash - This variable generates a value from the routing numbers entered for 
each detail record in the file.  The value provides a check against inadvertent alteration of 
data contents.  The variable name is {ACHFileHash}. 

v. File Amount – Generates the sum of all check amounts in the file.  The variable name is 
{FileAmnt}. 

11. Changes should not be made to the ACH file without consulting a Wellspring Software technician as these 
variables are defined by NACHA..  

12. Click OK to save changes to the Editing Form. 

Additional setup may be needed in the Form including: 
 Setting up E-mail. 
 Assigning ACH fields in the Form instead of using the Payee List. 
 Adding Process Page commands to determine when to print the ACH file when live checks are included in 

the print batch from the accounting system. 

Please contact Wellspring Software’s Technical Support for assistance with additional Form setup 

CREATING THE ACH FILE 

The ACH file is created automatically during the print process.  No further steps are necessary..
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Appendix 

A 
APPENDIX A:  PRINTBOSS BANK LIST 

The following detail describes the fields on the tabs of the Bank List.  Rarely will all of the fields in a bank record be 
used.  Each field in the PrintBoss bank record can be referenced in the PrintBoss form as a variable.  The data in a 
field will not be used unless the PrintBoss Form references the associated variable.  You only need to reference the 
fields you want to use.  Place and hold you cursor over a field in the PrintBoss Bank Edit window to view a pop up 
indicating the field's variable name.  Variable names are NOT case sensitive.  A #Text command is typically used 
to reference a variable in a form or the variable may be used as part of a Condition. 

 See Chapter 9, Form Files. 

One of the fields that are required is the Bank Code.  Enter the exact name used for this account in the accounting 
software if your accounting software can print data that can be used for a bank code (see the Installation Notes 
printed during the PrintBoss installation).  This code is used to synchronize your accounting software with 
PrintBoss.  Do not leave the Bank Code field empty. 

NOTE: 

The Standard and Enterprise editions of PrintBoss prompts the user to select an account from a list when 
printing checks from accounting software that can print data used for a bank code when no entry in the 
PrintBoss list matches the code from the accounting software.  A check box in the lower right of the prompt 
indicates PrintBoss will update the selected bank code to match the bank code sent from the accounting 
software.  This box is checked by default. 

Follow these steps to view the tabs: 

1. Click on the Edit menu on the main PrintBoss window and select Bank List. 
2. Select a Bank Record (any line in the list) and click the Edit Bank button. 

The PrintBoss Bank Edit window opens on the Primary tab. 

Primary 
This tab contains the company and bank information printed on the checks.  The Next Check Number field is often 
used with PrintBoss Select.  Please check the Installation Notes specific to the accounting software to determine if 
this field should be used. 

BANK CODE 
This field identifies the desired bank account.  Either the accounting software or the Request List identifies the 
appropriate bank account by matching this code.  PrintBoss requires an exact match of the database code with the 
code passed from the accounting software (though it is not case sensitive) to automatically select the bank account.  
This is not common in PrintBoss Select. 

There is an option in PrintBoss to allow Partial Matches.  This is not recommended, but is available for special 
cases – usually legacy PrintBoss installs.  To activate this setting, navigate to the main PrintBoss window and click 
on OPTIONS / CONFIGURATION.  Select the Internal tab.  The name of the setting is Method of matching a Bank 
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Code and is found near the bottom of the screen.  Change the setting to Allow Partial Match of Bank Code that 
follows colon:.  Once this is selected, the Bank Code must match exactly up to the colon, if a colon exists.  The 
match is not case-sensitive.  Following the colon, there must be a character-by-character match with the PrintBoss 
Bank Code until all characters in the Bank Code are used. The following chart illustrates successful matches: 

Bank Code in PrintBoss Bank Code from Accounting System Match 

Main Checking Main Checking Yes 

Main Checking Main Checking:ABC Yes 

Main Checking Main Checking:XYZ Yes 

Main Checking Main Check No 

Main Checking:A Main Checking No 

Main Checking:A Main Checking:ABC Yes 

Main Checking:A Main Checking:XYZ No 

Notice the first three scenarios are all a match for PrintBoss.  If there are bank codes that are very similar, set the 
Configuration / Internal setting to Enforce Exact Bank Code Match.  

There may be an instance where more than one account with the exact bank code is passed from the accounting 
software, such as multiple payroll accounts for the same company.  In this case, check the box labeled Allow for 
Selection when multiple Bank Codes match on the Internal tab of the Configurations Dialog.  This box is found in 
the Bank Application Properties section.  Enabling this check box alerts you to duplicates and possible mistakes 
even if you do not expect to have identical bank accounts. 

The variable associated with the Bank Code field is: 

Field Name Variable  Name Additional Description Length 

Bank Code {BCode} 
Code used to define record.  This should match the 
bank name in your accounting software. 

30-60 

ALIAS 
PrintBoss Select can work with more than one accounting software package using the same bank account, but the 
accounting software packages may need different Bank Codes.  Instead of entering all of the information twice, you 
may use the ALIAS option.   The Alias option allows two different Bank Codes to be used with the same bank 
account.  This option will only work if both accounting packages use the same variable for the check number (see 
the Installation Notes printed during the PrintBoss Select installation for each accounting software package).  If the 
check number variable must be different, two separate bank list entries need to be created in the PrintBoss Select 
bank list.  An Alias will use one entry within the PrintBoss Bank list.  This is important when considering the 
purchase of Bank Modules. 

 See the MICR Tab section later in this chapter for more information about the check number variable. 

BANK PROMPT 
The Bank Prompt provides a user friendly definition for the account.  This field is often used to give the account a 
nickname.  It should not be left blank, but it can be filled with the same value as the Bank Prompt field.  The 
variable associated with the Bank Prompt field is: 

Field Name Variable  Name Additional Description Length 

Bank Prompt {BPrompt} 
Name given for user recognition.  PrintBoss will 
automatically copy the information entered in the 
Bank Code field when this field is left blank 

25 

BANK INFORMATION NORMALLY PRINTED ON CHECK 
Enter the bank information that should be printed on the check.  This does not need to match the information in the 
accounting software database.  Leave a field blank if it is not needed.  There are some interfaces that do not use the 
bank information from the bank list.  See the Installation Notes that were printed during the PrintBoss Select 
installation or the Comments tab of the Form Files Editor for more detail. 
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The variables associated with the fields in the Bank Information section are: 

Field Name Variable  Name Additional Description Length 

Bank Name {BName} Name of bank 40 

Bank Address 1 {BAds1} Address Line 1 of bank (usually city, state) 40 

Bank Address 2 {BAds2} Address Line 2 of bank (often left blank) 40 

Bank Address 3 {BAds3} Address Line 3 of bank (often left blank) 40 

COMPANY INFORMATION NORMALLY PRINTED ON CHECK 
Enter the company information you would like printed on the checks.  This does not need to match the information 
in the accounting software database.  Leave a field blank if it is not needed.  There are some interfaces that do not 
use the company information from this list.  See the Installation Notes printed during the PrintBoss Select 
installation or the Comments tab of the Form File Editor for more detail. 

The variables associated with the fields in the Company Information section are: 

Field Name Variable  Name Additional Description Length 

Company Name {BCName} Company Name as it is to appear on the checks 60 

Company Name 2 {BCName2} 
2nd Company Name as it is to appear on the checks.  
This field is optional 

60 

Company Address 1 {BCAds1} Company Address Line 1 40 

Company Address 2 {BCAds2} Company Address Line 2 40 

Company Address 3 {BCAds3} 
Company Address Line 3.  This may be used for a 
telephone number, fax number, or email address 

40 

Company Address 4 {BCAds4} 
Company Address Line 4.  This may be used for a 
telephone number, fax number, or email address 

40 

FRACTIONAL CODE 
The fractional code is the group of bank numbers that is often printed in a small font near the bank information on 
the check or near the check number.  Not all banks require this information.  Often, this information is represented 
as a number over a second number, similar to a fraction.  PrintBoss places the first number next to the second with a 
slash ( / ) between.  This method is perfectly acceptable to the American Banking Association and Canadian 
Payments Association. 

Contact your bank if you do not know the fractional code.  The variable associated with the Fractional Code 
field is: 

Field Name Variable  Name Additional Description Length 

Fractional Code {BFrac} Fractional Code 20 

NEXT CHECK NUMBER 
This field is only relevant for accounting software that does not pass a check number to PrintBoss, such as 
QuickBooks.  PrintBoss Select will increment this number by 1 for each document that is processed by PrintBoss 
Select with this bank account, even if this field is not used.  PrintBoss will pop up the check number for the bank 
record during printing when the Confirm Check # at start of batch is set to Auto.. and the Check Number on the 
MICR tab is set to a value beginning with "B" or the Confirm Check # at start of batch is set to YES...  If the pop up 
number is edited, the PrintBoss bank record will be updated.  Editing this field will not update the accounting 
software.  The variable associated with the Check Number field is: 

Field Name Variable  Name Additional Description Length 

Next Check Number {BChkNo} 
Next Check Number Counter (only used if Check # 
is not sent from the accounting software) 

10 
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CONFIRM CHECK # AT START OF BATCH 
This is set to Auto… Confirm. For accounting software that passes the check number to PrintBoss, setting this field 
to Yes.. is IRRELEVANT since editing the number in the PrintBoss Bank List will NOT impact the actual check 
number used on the document.  We recommend setting this option to No.. Rely on Chk# from host accounting for 
accounting software that prints check numbers. 

INCLUDE BANK ON POPUP BANK REQUEST LIST 
For interfaces that use the PrintBoss Request List to prompt the user to select a bank, this option can restrict an 
account from appearing in the list.  Often, this option is used when adding a bank account prior to the actual start 
date for use.  The options are: 

 Suppress if "Unused" in BankCode – Suppresses this record from the Select Bank Account popup list when 
the word Unused appears in the Bank Code field.  This is the default. 

 Suppress this bank – Suppress this record from the Select Bank Account popup list.  It will still appear on 
the Bank List and on the Bank Select for non-matched Bank Codes list when a bank field is passed to 
PrintBoss and a match is not found on the Bank List. 

 Include this bank always – This bank will always appear in the Select Bank Account popup list. 

PASSWORD REQUIRED AT START OF BATCH 
A password may be added to a bank account either for security purposes or as an additional confirmation that the 
correct account has been selected.  There are 3 options to require a password.  No selection indicates no password is 
required. 

When picking Popup Bank Request List 
This option requires a password to be entered when a bank is selected from the Select Bank Account list. 

During Un-Matched Bank Selection 
This option requires a password to be entered when selecting a match from the Select Bank Account list when no 
match is found by PrintBoss Select. 

Every time bank is auto-picked 
This option requires a password to be entered any time a bank account is automatically selected by PrintBoss Select.  
This option is primarily used for security purposes. 

ACCOUNT AUTO SELECT OPTIONS 
This section contains options for PrintBoss when it is automatically selecting a bank account. 

Always Confirm Auto Selection 
This option requires the user to always confirm the selected account when it is auto selected and is usually selected 
when two or more bank accounts have identical Bank Codes.  This setting is grayed out unless the Allow for 
Selection when multiple Bank Codes match option is enabled at the bottom of the Internal tab on the Configuration 
dialog.   Once both bank accounts exist and a request is made for the shared Bank Code, a popup allows the operator 
to make a selection.  The popup occurs even when only one bank is identified.  This allows the operator to select the 
single account or cancel and identify another account that will share the code. 

Enable "Payroll" alias name 
Some accounting software only prints the Company Name for a bank code match in the Payroll module, while AP 
typically prints Bank ID and Company Name.  The difference in the bank code matching when only one bank 
account is used for both AP and Payroll triggers PrintBoss to constantly rename the Bank Code.  Select this option 
to allow PrintBoss to "ignore" the Bank ID when looking for a match on a Payroll account and only use the 
Company Name for a match.  The Bank ID or checking account name is normally assigned to "Payroll" in these 
situations.  This option is often selected for QuickBooks users. 

MICR 
This tab holds the MICR information for the selected Bank record.  There are Routing Number, Account Number, 
and Check Number fields. 

Obviously, it is important the MICR line is accurate.  Enter the Routing Number and Account Number exactly as 
they are provided by the bank.  Use periods to represent spaces and a single dash ( - ) to represent the three dash 
MICR symbol (see Substitute Characters later in this section). 
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The PrintBoss variable {CChkNo} is normally used to capture check numbers passed from accounting software.  
The {BChkNo} variable is normally used for accounting software that does not pass check numbers, such as 
Quicken and QuickBooks.   The {BChkNo} variable will use the check number from the PrintBoss bank record. 

STANDARD FORMAT FIELDS 
Instead of entering the MICR line directly, each component may be entered separately. One advantage is PrintBoss 
Select will automatically suggest proper placement of special characters based on American Banking Association 
(ABA) standards.  These provide a starting suggestion and may still be adjusted. 

At the very bottom of the MICR tab is the same MICR line in the actual MICR font characters.  This is a visual 
confirmation of the components entered above.  The MICR characters will update to reflect any changes made on 
the MICR tab. 

Routing Number 

Enter the correct routing number for the bank account. Do not use any substitute characters.  The variable associated 
with the Routing Number field is: 

Field Name Variable  Name Additional Description Length 

Routing Number {BMICRRoutNo} Routing Number from bank 9 

Account Number 

Enter the account number. Use a period to designate a space.  It is very common to have a leading space (period). 
Use a dash if there is a three dash character in the account number.  The variable associated with the Account 
Number field is. 

Field Name Variable  Name Additional Description Length 

Account Number {BMICRAcctNo} Account Number from bank 20 

Check Number 
One portion of the MICR line is the Check Number.  A variable needs to be entered since this value changes from 
check to check.  The available variables are: 

{BChkNo} Check number pulled from bank record. 

{CChkNo} Check number printed from accounting software. 

{DocNo} Check number passed from accounting software (Does not appear in drop down menu). 

 Often {DocNo} and {CChkNo} are interchangeable. 

BBBBBB Check number pulled from bank record with the number of digits specified by the number of 
letters. Left filled with zeros.  You can choose 6 or 8 digits. 

CCCCCC Check number passed from accounting software with the number of digits specified by the 
number of letters. Left filled with zeros.  You can choose 6 or 8 digits. 

Select the appropriate variable from the drop down menu.  See the Installation Notes specific for the accounting 
software for a recommendation. 

Include US Funds flag… 

See Character 45 below. 

CHECK FORMAT TYPE 
The check style only determines the order of the components for the MICR line on the check. This does not 
impact the actual style of the check form.  Select the appropriate style for the check stock that is going to be used. 

Standard 8.5" Business Check 
Standard interfaces use this style.  Usually this is for a check between 7" and 8.5" wide. 

Small 6" Wallet Size Type 1:  
This option is for a wallet-sized check with the check number on the far right of the MICR line. 

Small 6" Wallet Size Type 2:  
This option is for a wallet-sized check with the check number in the middle of the MICR line. 
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Deposit Slip: 
This option is for printing deposit slips that do not have a check/document number.  Only the bank routing number 
and account number will appear. 

Custom (enter MICR line directly): 

The MICR line may be edited directly instead of editing the individual components.  This allows any formatting 
required by your bank. This option enables the "Custom Format" field at the bottom of the window.  The MICR 
characters will adjust accordingly. 

CUSTOM FORMAT 
This section displays how the MICR line will appear when printed.  The field updates to reflect changes made in the 
individual components.  On rare occasions, it is better to modify the line directly rather than use the individual 
components.  This requires selecting the Custom option under Check Format Type. 

Each character (including blank spaces) must be entered exactly as it is received by the bank.  A common MICR 
string would be similar to the following: 

 /{BChkNo}/ [123456789[ 123-12345/ 

The variable associated with the MICR Line is: 

Field Name Variable  Name Additional Description Length 

MICR Line {BMICR} MICR Line (See #MICR in Chapter 8) -- 

SUBSTITUTE CHARACTERS 
Whether the MICR line is entered directly or through the individual components, substitute characters and check 
number variables must be used.  Substitute characters replace the special MICR characters with keyboard strokes. 
Check number variables are used to place the correct check number on each check. 

Four characters that may appear in the MICR line of a check cannot be reproduced with any computer keyboard key. 
Therefore, we have assigned replacement characters for the MICR line characters as listed in the following table: 

Symbol Description Represented By 

 
Transit [ 

 
On Us / 

 
Dash - 

 
Amount $ 

MODULUS 9 
On occasion, a bank will request a modulus 9 character to follow the check number.  PrintBoss Select will perform 
the modulus 9 calculation and insert the digit when it sees an asterisk ( * ) at the end of the check number.  To add 
the modulus 9 calculation to the MICR line, simply insert an asterisk immediately following the check number 
variable. This can be done by typing in the Check Number field or, if you have the Custom check format type 
selected, directly in the Custom Format field. 

CHARACTER 45 
The new Canadian Payments Association regulations suggest a "Character 45" in the MICR line of accounts printing 
checks drawn on US Dollars. Select the Include US Funds flag… option to add this character. 

Miscellaneous 
This tab provides miscellaneous variables that can be customized for specific needs.   

MISCELLANEOUS INFORMATION 
The Misc fields are optional and may contain a string, numeric value, or a logo file path and name.  The description 
for each of these fields is editable to add a reminder for the contents of the field.  Roll your mouse over the Values 
field to view the name of the associated variable.  The following table outlines all the variables in this section 
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Field Name Variable  Name Additional Description Length 

2nd Logo {BMisc1} Often used to place a 2nd Logo on a check 40 

Misc  Field 2 {BMisc2} Miscellaneous Field 2 40 

Misc Field 3 {BMisc3} Miscellaneous Field 3 40 

Misc Field 4 {BMisc4} Miscellaneous Field 4 40 

Misc Field 5 {BMisc5} Miscellaneous Field 5 40 

MISCELLANEOUS FLAGS 
The Miscellaneous Flags return a value of TRUE when checked.  The first flag, {BFlag1}, is assigned to the 2nd 
Signature Line on the Form.  Check the flag to enable a second signature line on checks for this specific bank 
record.  Misc Flags 2 – 5 are user definable and have description fields that may be edited as a reminder of their 
purpose.  Roll you mouse over the Values field to view the name of the associated variable.  The following table 
outlines all the variables in this section. 

Field Name Variable  Name Additional Description Length 

2nd Signature Line {BFlag1} Use for a 2nd signature line – YES if checked -- 

Misc Flag 2 {BFlag2} Miscellaneous Flag 2 – returns TRUE if checked -- 

Misc Flag 3 {BFlag3} Miscellaneous Flag 3 – returns TRUE if checked -- 

Misc Flag 4 {BFlag4} Miscellaneous Flag 4 – returns TRUE if checked -- 

Misc Flag 5 {BFlag5} Miscellaneous Flag 5 – returns TRUE if checked -- 

Miscellaneous Information and Flags are independent of each other. 

SPECIAL ITEMS 
Check the Canadian Style Date/Amount box if this bank account requires the newer Canadian format (often referred 
to as the CPA06 style).  This activates conditional formatting in standard PrintBoss Forms.  For additional 
information regarding Canadian check requirements, please see our web site's SUPPORT DOCUMENTS page for 
Canadian Customers. 

Signatures & Logos 
This tab allows the assignment of bank account specific signature and logos. 

If unique placement, resizing, or conditional use based on a required amount is needed, use the appropriate fields to 
assign properties to the specified file.  Entering values in these fields alone has no affect on the forms.  Commands 
must explicitly reference the variables associated with these fields in order to activate the conditions in a form.  Hold 
your cursor over a field to view a pop up hint showing the variable name associated with the field.  The variable 
name can be used in a form to reference the field.  

 See Chapter 9, Form Files, for further information.                                                        

LOGO PROPERTIES 
PrintBoss can read logo files in BMP, PCX, and JPG file formats.  PrintBoss will assume the location of a file 
entered in this field is the LOGOS folder under the PrintBoss HOME DIRECTORY.  Otherwise, the full path and 
file name need to be entered. Use the browse button (folder icon) to select a file and enter the correct path and file 
information.  The variable associated with the Logo Properties field is: 

Field Name Variable  Name Additional Description Length 

Logo Properties {BLogoFile} Logo file name, Ex: Mycompany.jpg 40 

NOTE: 

Logos will not view or print when the file path and name exceeds 40 characters. 
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SIGNATURE AND SIGNATURE 2 PROPERTIES 
PrintBoss can read signature files in BMP, PCX, SIG, and JPG file formats.  PrintBoss will assume the location of a 
file entered in this field is the LOGOS folder under the PrintBoss HOME DIRECTORY.  Otherwise, the full path 
and file name need to be entered. Use the browse button (folder icon) to select a file and enter the correct path and 
file information.  The variables associated with the Signature Properties fields are: 

Field Name Variable  Name Additional Description Length 

Signature Properties {BSigFile} Signature File Name , Ex: JohnSmith.sig 40 

Signature 2 
Properties 

{BSig2File} 
Second Signature File Name; this signature will 
appear on the top signature line 

40 

NOTE:  

Signatures will not view or print when the file path and name exceeds 40 characters. 

POSITION 
These coordinates are used to place files of any size on a form.  Coordinates are measured from the edge of the 
paper to the top left corner of the file, not the graphic, by default.  A different justification can be set in the 
associated command (i.e. #PIC).  The variables associated with the Position fields are: 

Field Name Variable  Name Additional Description 

Logo X {BLogoX} X Coordinate for logo 

Logo Y {BLogoY} Y Coordinate for logo 

Signature X {BSigX} X Coordinate for signature  

Signature Y {BSigY} Y Coordinate for signature 

Signature 2 X {BSig2X} X Coordinate for signature 2 

Signature 2 Y {BSig2Y} Y Coordinate for signature 2 

OPTIONS 
These fields are for additional options available for the file, such as size or watermark. 

 See Chapter 9, Form Files, for further information on the #PIC command. 

The variables associated with the Options fields are: 

Field Name Variable  Name Additional Description 

Logo Options {BLogoOp} Optional properties for logo file 

Signature Options {BSigOp} Optional properties for signature file 

Signature 2 Options {BSig2Op} Optional properties for signature 2 

RANGE CONDITION 
Typically used for signatures, this option can indicate a low and high dollar amount to limit when the signature 
prints.  The variables associated with the Range Condition fields are: 

Field Name Variable  Name Additional Description 

Logo Hi {BLogoHi} 
Maximum $ for AmountRange condition – typically used only if 
the logo is an additional signature 

Logo Lo {BLogoLo} 
Minimum $ for AmountRange condition – typically used only if 
the logo is an additional signature 

Signature Hi {BSigHi} Maximum $ for AmountRange condition (optional) 

Signature Lo {BSigLo} Minimum $ for AmountRange condition (optional) 

Signature 2 Hi {BSig2Hi} Maximum $ for AmountRange condition (optional) 

Signature 2 Lo {BSig2Lo} Minimum $ for AmountRange condition (optional) 
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SIZE 
PrintBoss Select is able to resize a file down to 10% and up to 300% of the original size.  These fields indicate a 
change in either the specific size in inches using width (Wdt) and height (Ht) or a percent.  Either percent or inches 
should be used – not both.  The variables associated with the Size fields are. 

Field Name Variable  Name Additional Description 

Logo Width {BLogoWd} The Logo Width in inches 

Logo Height {BLogoHt} The Logo Height in inches 

Logo Percent {BLogoSize} Logo size adjusted by Percent from 10% - 300%  

Signature Width {BSigWd} The Signature Width in inches 

Signature Height {BSigHt} The Signature Height in inches 

Signature Percent {BSigSize} Signature size adjusted by percent from 10% - 300%  

Signature 2 Width {BSig2Wd} The Signature Width Size in inches 

Signature 2 Height {BSig2Ht} The Signature Height Size in inches 

Signature 2 Percent {BSig2Size} Signature size adjusted by percent from 10% - 300% 

Security 
Security can be added to each Bank Record to define the users who may access the Bank Record.  This process is 
outlined in Chapter 8, Bank Accounts and is separate from the Password section on the Primary tab. 

ACH Definition 
The ACH Definition tab may be used to enter data to be used in creating an ACH file for this bank record according 
to the NACHA Operating Rules and Guidelines. 

FILE HEADER RECORD FIELDS 
These fields are used in the SignOn tab of the ACH File and are defined in the bank record.  They apply to every 
record in the file. 

Field Name Variable  Name Additional Description 

Immediate 
Destination 

{bACHImdDstNo} 
Contains a space followed by the 9 digit routing number of 
the ACH Operator or receiving point where the file is being 
sent. 

Immediate Origin {bACHImdOrgNo} 
Contains a space followed by the 9 digit routing number of 
the ACH Operator or sending point that is sending the file. 

Immediate 
Destination Name 

{bACHImdDstName} 
Optional.  The name of the ACH receiving point; 23 
characters. 

Immediate Origin 
Name 

{bACHImdOrgName} 
Optional.  The name of the ACH sending point; 23 
characters. 

File Mode ID {bACHFileIDMode} 
Increments beginning at A for multiple files in a day; 1 
character. 

Pre-Note Override {ACHPreNote} 
Global override of the PreNote setting.  This should only be 
used once, the first time an ACH batch is processed.  The 
values are N or Y. 

COMPANY BATCH RECORD FIELDS 
These fields are used in the Header tab of the ACH File and are defined in the bank record.  They apply to every 
record in a batch. 

Field Name Variable  Name Additional Description 

Service Class 
Codes 

{bACHSvcClassCode} Identifies type of ACH file; 3 characters. 
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Company Name {bACHCompName} Name of the Company or Payee; 16 characters. 

Company 
Discretionary Data 

{bACHCompDisc} 
Optional.   Allows Company to include codes of 
significance only to them to enable specialized handling 
of all entries in the batch; 20 characters. 

Company 
Identification 

{bACHCompID} 
An alphanumeric code used to identify the Originator; 10 
characters. 

Standard Entry 
Class 

{bACHStdEntryClsCod} 
This field holds various predefined character 
abbreviations representing standard descriptions.  Ex:  
CCD (Corporate Credit or Debit). 

Company Entry 
Description 

{bACHCompEntry} 
Provides a description for the purpose of the transaction.  
Ex:  Payroll; Water Bill; etc., up to 10 characters. 

Originating DFI 
Identification 

{bACHOrgDFIID} 
Bank routing number plus ABA number with no leading 
space; 8 characters total. 

SAVED BANKS 

Banks are saved in a file located at the root of the PrintBoss Home directory.  The main bank file is Banks.pbb.  You 
may also see Banks.smt and Banks.nsx.  A history of changes is also kept at the root of the PrintBoss Home 
directory.  There files are numbered sequentially beginning with Banks000.pbb.  It is prudent to keep a backup of 
the most current version of Banks.pbb in the event your server of computer crashes. 
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Appendix 

B 
APPENDIX B:  FORM EDITOR 

The following detail applies to PrintBoss Select Form Files.  Form Files capture data from accounting software and 
use scripts to add additional objects or format captured text. 

FORM EDITOR 

The Form Editor has several tabs and options for customizing forms or handling special needs.  Some of the tabs 
only display when they are selected.  The following provides descriptions for the options available on each of the 
primary tabs on the Form Editor. 

Settings 
This tab contains general settings for the form including the form size and orientation, the number of copies, 
archiving options, and whether the form will require a keystroke acknowledgment to start printing.  The order copies 
of the form will print is determined here as well. 

DESCRIPTION 
This field contains a brief description of the purpose of the form and often identifies the accounting software 
associated with the form.  This information is kept when a new form is copied from an older form. 

FORM DATE 
The date & time the original form was created.  This information is kept when a new form is copied from an older 
form. 

INTER FORM DELAY 
This field inserts a pause between each page processed with the form.  The length of the pause is measured in 
seconds.  Zero indicates no pause. 

FORM NEXT NUMBER 
This field is used to provide independent numbering on the form.  This is NOT recommended for checks.  This field 
is typically used for other types of forms, such as invoices.  Once the option is activated (check the box), a next 
number can be designated.  Each time a document is created with this form, PrintBoss Select will increment the 
number by one.  There is no confirmation dialog for the number. 

The number can be used in the form by referencing the variable {FormNextNumber} in a command.  More 
information about variables is provided in the Form File Commands section later in this chapter. 

CAPTURED TEXT TREATMENT 
This section allows PrintBoss Select to format the font of the text captured from the accounting software, changing 
the original font.  These settings are global for all of the data from the accounting software using this form. This 
DOES NOT override #TEXT commands. 
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X, Y Text Offset 
This option provides a global offset of the placement of all the data from the accounting software. This is typically 
used for centering data on the page. 

Font Override 

This option designates a specific font style to be used for the data from the accounting software in place of the font 
passed with the data.  This does not override #TEXT commands. 

Point Adjust 

This field increases or decreases the original font size by the number indicated:  0 = original size, 2 = increase the 
original size by 2 points.  A negative number decreases the original size.  The Point Adjust field will be ignored 
when there is a font description in the Font Override field. 

Ignore Text Between 
PrintBoss Select will remove any incoming data on the page within the vertical coordinates of this option.  The full 
width of the page is assumed.  The coordinates measure in inches from the top edge of the page. 

TEXT / IMAGE CAPTURE MODE 
This field is set to Text Only is captured for PrintBoss Select users. The alternative options are irrelevant for 
PrintBoss Select. 

FORM WIDTH, LENGTH 
This is the measurement of the form's size in inches followed by the standard paper size option.  The paper size 
option can be changed if it does not match the data sent from the accounting software. 

SIZE/ORIENTATION ALERTS 
PrintBoss Select has a feature to alert the user when the page size and orientation do not match the information 
passed by the accounting software.  The choices are:  Suppress Alerts (no alert will be provided), Orientation Mis-
Match, and Orientation or Size Mis-Match. 

PRINTER PAPER SIZE 
When PrintBoss Select prints this form, it will NOT tell the printer what paper to select when this options is set to 
Default. The other options will tell the printer to use the specified paper size. 

COPIES 
Enter a value from 1 to 7 in this field to set the number of COPIES PrintBoss Select should generate:  0 = 1 original 
and no copies, 1 = 1 original AND 1 copy (2 pages), etc.  PrintBoss Select can generate the original plus up to 7 
copies. 

If at least 1 copy is designated, the order of the copies needs to be set.  Click on the drop down menu for the field 
after copies and select Documents to print the original and all of the copies for the first page prior to the second 
page.  Copy Type prints the originals for all pages first, then copy 1 for all pages, then copy 2 for all pages, and so on 
for as many copies as are specified for the form. 

SPECIAL HANDLING 

No Special Handling 
PrintBoss will not pause between copy types 

Pause Printing Between Copy Types 
PrintBoss Express will pause between copies to allow paper to be changed when Copy Type is selected and this 
option is checked.  The user will be prompted to confirm the paper has been changed before printing the next copy 
type.  This is typically used when only one paper tray is available and check copies are printed on blank paper.  
Another common use is with Invoice type documents where each page requires a different paper color and the paper 
needs to be changed in the tray after each copy.   

This option is only available when printing one or more copies and Copy Type is selected. 

Send as a single print job 
PrintBoss will send all of Copy 1, then all of Copy 2, etc., but it will not pause the process to change paper.  This is 
often helpful when sending a print job to a printer with a stapling function or when using Copy Type to streamline 
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the creation of Positive Pay or ACH files. 

FORMS PER PAGE 
Enter a value to determine the number of forms printed on a single piece of paper.  This might be more than 1 when 
printing wallet sized checks.  A value of zero is not valid and will generate an error message. 

ASK 1ST PAGE 
This option is only available when printing more than one form per page.  The feature is most commonly used when 
printing 3 checks per page and the last check run only printed one or two checks on the last page.  PrintBoss Select 
prompts the user to enter the number of checks to print on the first page of the run to allow all portions of the page to 
be used. 

ORIENTATION 
No orientation request is sent to the printer when this option is set to Default.  Choose portrait or landscape to send 
an orientation command change to the printer.  This command overrides the default of the printer at time of printing. 

WORK/ARCHIVE FILE COMPRESSION 
This feature is rarely used.  It allows for slight compression of the work and archive files to save space. 

WORK FILES INDEXED AT CREATION 
Indexing the work file automatically prepares it to be sorted in an order other than generation.  Generation is the 
order the work file batch was sent by the accounting software.  

DEFAULT PRINT ORDER 
If either the archive or work files are indexed at creation, this option will designate the order the documents should 
be printed.  The default value (Natural Order) is the order generated by the accounting software.  The other choices 
are Recipient, Amount, Doc Number, Misc Field, and Bank. 

IMMEDIATE PRINT DIALOG METHOD 
Typically, this field is set to start printing without a prompt.  A prompt may be preferred to confirm printer 
availability.  In this case, select Prompt to start printing.  PrintBoss Select will open the Print Copies Dialog and 
wait for the user to click on the Print Start button before the print job is sent to the printer. 

COLLAPSED WHEN OPENED 
Select this checkbox to collapse the bottom portion of the Print Copies Dialog from the Scope down when it is 
opened by PrintBoss. 

Special Controls 
This tab gives note to special requirements for the form. 

MINIMUM PRINTBOSS VERSION REQUIRED FOR THIS FORM 
This field identifies the oldest version of PrintBoss Select that can successfully use this form.  Older versions of 
PrintBoss Select do not have all of the features accessed by this form.  An error message will appear if this form is 
accessed by an older version warning PrintBoss Select should be updated to allow full functionality of the form. 

REQUIRES INPUT FROM PB50 PRINTER DRIVER 
Features on some forms may require the use of the PB50 printer driver to work correctly instead of the NT40 printer 
driver.  This option will be checked when the PB50 printer driver is required for full functionality of the form. 

LOG FILE MODE 
This field is usually set to No Logging.  Change the setting to Text Log to create a text file that will record each 
printing/processing action of a document page.  Each line will include the date, time, and operator name. 
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LOG FILE NAME 
This field displays the name of the file created when the Log File Mode is set to Text Log.  The default value may be 
changed. 

WELLSPRING STOCK NO 
This field displays the Wellspring paper stock item number to use with this form.  Click on the link for the 
Wellspring Software web site to order additional checks and paper stock.  The link opens to the check stock page of 
the online store. 

ZERO FILL CHECK NUMBER 
This field will add the designated number of zeros to the left of the check number for all accounts that use this form. 

DOCUMENTS PER INPUT PAGE 
This field indicates the number of documents passed by the accounting software on a single page.  Often this is used 
with wallet style checks.  Enter the height of the document in the Input Document Height field.  The value in this 
field is 1 when only one document per page is passed. 

INPUT DOCUMENT HEIGHT 
Indicate the height of each document when more than one document per page is passed from the accounting 
software.  This field is not available when there is only one document per page.  (See Documents Per Input Page 
above). 

ENABLE PRINTING ON BACK OF PAGE 
This is the duplex printing option in PrintBoss Select and allows printing on the back of a form.  A duplex printer is 
required to use this option and the duplexer option on the printer must be activated.  An additional tab called Page 
Back Objects will appear in the form editor when this option is checked.  Commands entered on this tab will appear 
on the reverse side of the form. 

If this feature is activated while using a printer that does not have an activated duplexer, the back page will print as a 
separate page. 

PRE-PROCESS ASSIGNMENTS 
Click on the drop down menu and select Special to cause PrintBoss Select to process the assignments in the 
Runtime, Footer, Page Back, and Design Objects tabs before processing the rest of the document. 

 This must be active when there is a #PaperBin, #SkipPage, or #ProcessPage command in 
use. 

Activation of the Pre-process Assignments feature may slow the printing process slightly. 

SCAN FORM FOR {BANKCHKNUMINC} 
Select this field to include the {BankChkNumInc} variable in the pre-processing of assignments when Pre-process 
Assignments is active. 

SUPPRESS CONFIRMATION OF CHECK NUM. 
Check this field to suppress the Check Number Confirmation pop up for the form.  This is especially helpful when 
using two accounting packages – one that passes check numbers and one that does not.  This setting can always be 
checked on the forms for the accounting packages that DO pass check numbers. 

FLIP TOP TO BOTTOM WHEN PRINTING 
Check this setting to print the bottom edge of the document first.  This is often used when the bottom margin of the 
printer is too large for correct placement of the MICR line.  Check paper needs to be rotated 180 degrees in the 
paper tray for this to work.  

ACCESS 
This feature is used to limit some tabs from appearing in the Form Editor.  Most notably, the Design Objects and 
Proprietary tabs are not currently used on standard forms.  RunTime, Footer, and Page Back Objects tabs can also be 
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disabled.  This button requires an access code to enable or disable tabs.  The Access Code is the same as the Security 
Master Password. 

STANDARD SHADE 
Adjust the shade often used in many graphic objects, such as the legend area of a grid, with this option.  It may be 
desirable to lighten or darken shaded areas when using some printers. 

SECURITY STAMP STRING 
This field is an additional security feature.  Select a security stamp from the drop down menu and reference the 
{SecurityStamp} variable in the form (usually with a #Text command) to place the security stamp information on 
each document using this form. 

WORK FILE NAME SUFFIX 
Select or enter a suffix to attach to each work file name (optional). 

 Dynamic components can be used as the suffix in the Enterprise edition.  For example, enter 
{YYYY_MM} in this field for the QB_CHK4 form to date stamp the work file.  A new work file will be 
created each month stamped with the year and month:  QB_CHK42007_09. 

Block Mirrors 
This tab defines an area of the form and copies it to another area of the same page.  Define the top and bottom edge 
of an area (or Block).  The entire width of the page is automatically included in the defined area.  The mirrored copy 
can be the same height or it can be resized either smaller or larger.  Check Enable any mirror copies to use Block 
Mirrors. 

This feature is most frequently used to duplicate a stub section or, as in many standard interfaces, to copy the check 
and stub sections into the mini copy at the top of the page. 

SUPPRESS BLOCK MIRROR ON THESE COPIES 
Enter a copy number, such as 1, to suppress Block Mirrors on that copy.  This is often used when Overflow is 
printed with the check batch. 

START OF SOURCE BLOCK 
Enter the top edge of the area to be copied. 

END OF SOURCE BLOCK 
Enter the bottom edge of the area to be copied. 

DESTINATION SIZE 
Enter the height of the destination area to place the copy.  PrintBoss Select will compress or stretch the original 
block to fit within the designated space. 

TOP OF DESTINATION 1 
Enter the top edge of destination area where the mirrored copy should start. 

TOP OF DESTINATION 2 
Enter the top edge of a 2nd destination where the mirrored copy should start.  (Optional.  Enter zero to disable). 

TOP OF DESTINATION 3 
Enter the top edge of a 3rd destination where the mirrored copy should start.  (Optional.  Enter zero to disable). 

TEXT FONT SIZE CALCULATION IN DEST BLOCK 
This section adjusts the font size in the mirrored copy section.  By default, the font size is reduced (or enlarged) 
using the same percentage applied to the whole block.  This default value is displayed in gray and cannot be edited.  
Often, the text is hard to read when the block is a reduced.  This setting allows you to increase the font size a little 
for readability.  The down side of increasing the font is at some point the lines of text will start overlapping each 



PrintBoss Select 132 Electronic Copy 

other or the outline of the destination block.  A bit of trial and error will allow you to pick a reasonable compromise 
between readability and staying true to the original block. 

FORCE FONT SIZE TO THIS PERCENT OF ORIGINAL 
Enter a different percent to override the automatic sizing when text is difficult to read.  It can be helpful to 
separately control the reduction percentages between captured text and text that is part of the form design in 
PrintBoss Select. 

Captured 
Adjust the size of captured fonts as a percent of the original size.  This field is not available if the capture font has 
an override that indicates no compression in copies (indicated as a + after the font size in the captured font 
description). 

#Text 
Adjust the size of text items placed with #Text commands.  This will not impact any items that have a font 
description forcing no compression in the copies. 

 See Chapter 10, #Text Command, for more information. 

Multi-Parts & Printers 
These settings relate to individual copies of the form. 

COPIES 
This is a list all of the copies activated for this form, including the original. (See Settings / Copies).  Copies are 
numbered sequentially. 

PRINT TIME 
Select whether a copy (or original) prints immediately, is sent to a batch in the work file to be processed later, is 
never prints. 

DESTINATION PRINTER/DEVICE* 
Define the destination or printer for the selected copy.  The destination choice defines the Source Tray selections. 

Destination options include printers as well as other PrintBoss Select functions such as Positive Pay. 

 See Chapter 16, Positive Pay, for additional information. 

BLANK 
A page symbol will appear in the blank column between Destination Printer/Device and Source Tray when 
Destination Printer/Device is set to <Positive Pay>.  Click on the page symbol to open the Positive Pay/ACH File 
Editor. 

SOURCE TRAY 
Choose the appropriate paper tray for the selected copy.  The tray options are defined by the printer selected in the 
Destination Printer/Device column.  The tray names are sent by the selected printer driver and do not always 
correspond to the tray names on the hardware.  Test each tray to find the one desired.  Note that anytime the printer 
is changed (like in the Destination Printer/Device column or by changing the PrintBoss Default printer) the tray 
selection will be reset to Default. 

This field also allows the selection of Embedded or an existing Positive Pay or ACH File when Destination is set to 
<Positive Pay File>. 

NOTE: 

Selection of a manual tray will result in a physical prompt from the printer hardware for each document.  Find 
a tray selection that pulls from the correct tray without the prompt.  This can still be the manual feed tray. 
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COPY NAME 
This field is provided as a label for the different copies and can be used as a reminder.  The copy name will appear 
in the Print Documents dialog.  This value can also be referenced by a command in the form using the {CopyName} 
variable.  For example, #Text can use this variable to print Original or Packing Slip on the associated documents. 

PRINTER & TRAY SELECTIONS SAVED IN.. 
PrintBoss Select allows the settings on the Multi-Parts & Printers tab to be saved by Form or User.  Form is a global 
setting that shares the features marked with an asterisk ( * ) on this tab with everyone using this PrintBoss Select 
license.  If one person in the group changes the destination of a form to a new printer, all users will print to the new 
destination.  Locally is also a global setting, but it allows each user to save their own settings.  If an individual 
changes the print destination, no one else is affected.   

A third option, Independent, allows individual users to choose between the global Form settings or their own Local 
settings.   When Independent is selected, a second drop down menu appears to allow the user to choose the Form 
setting or Local setting for each situation. 

FORM PRINTER/DEVICE* 
This feature appears in versions of PrintBoss Select prior to 5.3 and is available after 5.3 as a setting on the Legacy 
tab under Options / Configuration. 

Set the printer/device for this form.  Any copy whose Destination Printer/Device is set to <Form Printer> will use 
this value as its destination.  If the value of this field is set to <Default PrintBoss Printer>, PrintBoss Select will use 
the printer selected under File / Printer Setup from the main screen of the PrintBoss Select application. The drop 
down menu will list all printers available to this workstation or user. 

The default Destination Printer/Device setting for most forms is <Form Printer> and the default Form 
Printer/Device is <Default PrintBoss Printer>.   In this case, the printer selected under File / Printer Setup will 
determine the printer for all copies of the form. 

NOTE: 

PrintBoss Select is very literal with printer names.  If a printer name changes by a single character, PrintBoss Select 
will see it as a new printer. 

Comments 
The Comments tab contains notes associated with this form – often a version number or customization reminders. 

RunTime Objects 
This edit group allows the user to implement any of the PrintBoss Select commands listed later in this chapter. These 
commands provide the ability to create any form design the user may require. 

Assignments made in this tab can only be used in the Footer or Page Back Objects tabs unless the Pre-process 
Assignments option is selected on the Special Controls tab. 

 See Chapter 9, Form Files, for more information on #Assign. 

Footer Objects 
This group of design objects is processed at the end of printing the form.  The same commands are available in this 
group but they are processed after all of the other commands. 

Variables assigned in the RunTime Objects tab can be referenced here (see #Assign in Chapter 9). 

Misc  
The Misc tab allows users to import and manage jpg or bmp files to use in the background of a PrintBoss form.  A 
#Pic command must reference this file in the RunTime Objects section of the form in order to view or print the 
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graphic.  The graphic is selected by clicking on the button at the end of the Graphic File option on the Pic Command 
Properties window. 

This tab also includes special treatment of key fields during the creation of the PrintBoss Work File.  These fall into 
the following two categories. 

KEY FLDS RE-CALC FORWARD 
This section provides options that allow PrintBoss to carry forward or re-calculate values from selected fields under 
special circumstances.  This area is primarily for use by a Wellspring Software Technician. 

KEY FLDS RE-CALC BACKWARDS 
This section provides options that allow PrintBoss to process documents backwards immediately after they are 
processed forward for the purpose of counting or calculating values from the end of a group or file.  This area is 
primarily for use by a Wellspring Software Technician 

Page Back 
This tab only appears when the Enable Printing on Back of page option is enabled on the Special Controls tab.  This 
script uses commands the same way as Footer Objects, but all items will appear on the reverse side of the page. 

A printer with duplexing capabilities is necessary for this page back feature to function properly.  If duplexing is not 
activated, the page back information will be printed on a separate page. 

Positive Pay 
Positive Pay is no longer a tab on the Form Editor.  Instead, a separate window can be opened by clicking on the 
page symbol to the right of the <Positive Pay File> Destination. 

 See Chapter 16, Positive Pay, for additional information. 

FORM FILE COMMANDS 

Form File commands are used to accomplish various tasks in PrintBoss.  These commands are entered on the Object 
tabs for the Form Editor.  The following is a description commands not included in Chapter 9. 

#AssignLines 
#AssignLines <VarName> 

This is used to assign several lines of data at one time. This is very similar to the #Paragraph command.  It appends 
all lines after the #AssignLines command until another #command is encountered.  It is recommended that a #Rem 
command be placed at the end of the paragraph of lines after the #AssignLines command. 

For example: 

 #Assign Lines FaxMsg 
Thank you for your order from Wellspring Software, Inc. 
The invoice for your order is attached to this fax for your convenience. 
The original paper invoice is being mailed. 

  
Please call us with any questions. 
#Rem – end of FaxMsg 

Once assigned, the variable is actually a multiple line variable. See the Multi-Line Variables section in Chapter 9. 
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#AssignmentsBlock 
#AssignmentsBlock X1, Y1, X2, Y2     or    #AssignmentsBlock Y1, Y2 

This command is used to capture a group of assignments made in a specification or report.  It allows variable names 
and values to be assigned dynamically from the host.  The first text object on any line within this block becomes a 
variable name and the following text objects become the value (more than one object is appended together).  All text 
within the block can be blanked out after capturing. 

For example, assume the following lines are in the defined block: 

DocNo 1234 
DocRecip John Smith 
DocAmnt $1,200.00 

PrintBoss Select reads the first text object in each line (i.e. DocNo, DocRecip, and DocAmnt) as the variable names 
and the second text object in each line (i.e. 1234, John Smith, and $1,200.00) as the variable values. 

#Assigns 
#Assigns 'VarName', 'Value' [, CaptXRange, CaptYRange [, Options]] 

The parameters for #Assigns are identical to the #Assign command (without the ending “s”) and is used to assign a 
multi-line variable.  There are 2 methods to assign a value, though they differ from the #Assign command. 

The first method is to simply provide the value by entering the Value parameter.  Each time an additional #Assigns 
command occurs with the same VarName, an additional line is added to the multi-line variable.  For example:  

#Assigns FaxMsg, "Thank you for your order from Wellspring Software, Inc." 
#Assigns FaxMsg, "The invoice for your order is attached to this fax for your convenience." 
#Assigns FaxMsg, "The original paper invoice is being mailed." 
#Assigns FaxMsg, " " 
#Assigns FaxMsg, "Please call us with any questions" 

The second method to assign a value is to supply coordinates to capture data.  Of course it is expected that the 
vertical range includes a region large enough to capture more than one line.  If the option Add together fields in 
horizontal range is checked, each ROW of text objects will be added together and treated as a single element in the 
multi-line variable. For example, to capture a variable for the payee lines in a check that occur between 8 and 9.5 
inches down the page, the following command might be used: 

 #Assigns PayeeAds, "", 1.183/.0100, 8000-9.500, LRB1WS  |This command captures several lines of text 
at once.  These lines can be printed as a 
group using the VText command. 

The first value range defines the CaptXRange and the second defines the CaptYRange.  The letters and number 
represent various options for the captured text.  For example, B indicates the raw data is blanked out after capture. 

 See Chapter 9, Form Files – Multi-Line Variables and Form File Commands, for more information.  

#BMP 
#BMP X, Y, "GraphicFileName"[, Options] 

This command prints a graphic on the document and operates the same as the #PIC except that it expects a .BMP 
file type.  It has been replaced in favor of the #PIC command.  See #PIC in Chapter 9 for more information. 

#Disable / #Enable /#SetEnable 
The #Disable and #Enable command pair allow for deactivation of sections of commands.  When #Disable is 
encountered, all commands following it will be ignored until #Enable occurs.  At least one of the 2 commands will 
logically have a condition.  (See Conditional Commands in this Chapter 9).  It is not necessary to have matching 
pairs. 
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The #SetEnable [Condition] is an alternate way to enable or disable the processing of commands.  For example, 
#SetEnable[true] is equivalent to #Enable and, likewise, #SetEnable [false] is equivalent to #Disable.  

Here is a simple example of using these commands to create blocks of commands (in this case just one text 
command) that run based on a condition.  It must be unconditionally enabled so all further lines will be processed 
normally. 

 #SetEnable [Copy, 0] 

  #Text 1, 10, Arial/12, ‘This is my message for Copy 0’ 

 #SetEnable [Copy, 1] 

  #Text 1, 10, Arial/12, ‘This is my message for Copy 1’ 

 #Enable 

Use of the #If / #Endif commands is recommended instead of using #Enable / #Disable / #SetEnable when 
reasonable.  These newer commands are clearer and can be nested more logically. 

#Else 
See #If / #ElseIf / #Else / #Endif  

#ElseIf 
See #If / #ElseIf / #Else / #Endif  

#Enable 
See #Disable. 

#EndIf 
See #If / #ElseIf / #Else / #Endif  

#FileErase 
#FileErase <FileName/Path> 

This command will erase the file(s) specified by the FileName/Path.  The FileName may include an * (asterisk) or ? 
(question mark) as a wildcard(s).  It is mainly used internally by PrintBoss Select, but is available if needed. 

#For N = 
#For N = <starting number> TO <ending number> [STEP n.nn] 

This command provides a loop to repeat the number of times indicated by the starting and ending numbers. 
Designate the end of the loop with a #Next N command.  By default, each loop will increment the value of n by 1.  
Append the phrase STEP to the end of the line followed by the desired increment to change the step.  All three entry 
values (Starting Number, Ending Number, and Step) may be decimal numbers (i.e. 1.456).  The loop will end at the 
matching #Next command when the value of n is greater than the ending number after it is incremented by the 
STEP. 

#ForceWinPrintJob 
#ForceWinPrintJob 

This command forces the Windows print job to end and a new print job to start with a specified page.  Typically, a 
condition is placed on this command.  Otherwise, a new print job would be forced with every single page.  An 
example of using this command is to start a new Print Job with each new invoice number so all the pages of the 
same invoice number can be stapled by an advanced printer that supports stapling by print jobs.  The Pre-process 
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Assignments option must be set on the Special Controls tab of the Form Editor for this command to work.  For 
example: 

#[Copy,0][!=e, ÷{DocNo}÷, ÷{Prev.DocNo}÷]ForceWinPrintJob 

 See Chapter 9, Form Files – Conditional Commands. 

#GoToMarker / #Marker 
#GoToMarker <MarkerName> 

#Marker <MarkerName> 

The GoToMarker command jumps FORWARD in the RunTime Objects, Footer Objects, or Page Back Objects tabs 
without considering ANY commands in between this command and its Marker.  Even #Enable/#Disable and 
#If/#Endif commands are ignored.  The #GoToMarker must be used in conjunction with a #Marker command to 
identify where PrintBoss Select should jump.  The GoToMarker should not be used to jump into or out of matched 
pairs of #If / #Elseif/ #Else/#Endif commands. 

#HGrid 
#HGrid X1, Y1, X2, Y2, Ya, Yb, ...Yz [, Options] 

This command creates a frame and then draws horizontal lines to fit into the frame.  Options provide further 
modifications with corner radius, shadow, and edge shading.  This is command had been largely replaced by the 
#Grid command. 

X1, Y1 
These are the coordinates for the top left corner of the frame in inches from the left edge and top of paper.  The 
coordinates may be entered in thousandths of an inch. 

X2, Y2 
These are the coordinates for the bottom right corner of the frame. 

YA, YB…YZ 
This parameter represents any number of lines drawn horizontally across the frame.  Each line is defined as the 
distance in inches from the top of the page. 

OPTIONS 

Radius 
/Rnnn where nnn is the radius size.  For example, /R.1 is a corner radius of 1/10 of an inch. 

Edge Shading 
/STnnn (Shade Top), /SLnnn (Shade Left), /SBnnn (Shade Bottom) or /SRnnn (Shade Right) where nnn is the width 
of the edge shade in inches. 

Shadow 
/SHDnnn where nnn is the width of the shadow in inches. 

Line Color 
/0LC followed by a number representing a color.  The color number can be 4 to 8 digits. 

#If, #ElseIf, #Else, #Endif 
#If [Parameter] 

#ElseIf [Parameter] 

#Else 

#EndIf 

Blocks of code can be conditionally processed based on the parameters that follow #IF and #ElseIf commands.  
There must be a matching #Endif whenever a #If [Parameter] occurs.  Optionally, any number of #ElseIf 
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[parameter] sections can follow the original #IF.  Finally, a single #Else may occur after the #IF and all #ElseIf, but 
before the #Endif.  

#If/#Endif structures may be nested.  They may not stretch from one section to the next, such as going from the 
RunTime to the Footer section. 

Use of the #If / #Endif is encouraged over the #Enable/#Disable/#SetEnable, and neither constructs should pass 
across the boundaries of the other type. 

#Lines 
#Lines X1, Y1, X2, Y2, … Xn,Yn [,/Wn.nnn] [,/C<color>] 

This command draws a line from point X1, Y1 to Xn, Yn, passing through all the points in between. The width and 
color are set as options 

#LineSet 
#LineSet StartingY, LineSpacing 

This command is useful in formatting a series of commands with coordinates that follow one after another.  Use this 
command prior to the first line to define the starting Y coordinate as well as the consecutive line spacing.  This is 
especially helpful in eliminating blank lines from an address used in conjunction with conditional #Text statements. 

This command overrides any internal variable, such as {LineY}.  The variable {LineY+} will use the current 
coordinate and increment it internally by the LineSpacing amount. 

The following example uses the #LineSet to place the Bank Fractional Code directly under the last non-blank bank 
address line. 

 #LineSet 7.9, .15 
 #Text 3.8, {LineY+}, 'Arial/12', '{BName}' 
 #[!Empty, BAds1]Text 3.8, {LineY+}, 'Arial/12', '{BAds1}' 
 #[!Empty, BAds2]Text 3.8, {LineY+}, 'Arial/12', '{BAds2}' 
 #[!Empty, BAds3]Text 3.8, {LineY+}, 'Arial/12', '{BAds3}' 
 #Text 3.8, {LineY+}, 'Arial/12', '{BFrac}'  

NOTE: 

It is more common to use the {LastLineY+n.nnn} variable instead of using this command 

#Macro 
#Macro X, Y, PrinterMacroCode 

This command calls a Hewlett-Packard printer macro using Windows Passthrough printer escape sequence.  If X 
and Y are passed as non-zero, then the cursor control commands will be executed to place the cursor prior to calling 
the macro. 

#Marker 

 See #GoToMarker. 

#Next N 
This command indicates the end of a loop.  

 See #For N =. 
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#PaperBin 
#PaperBin <PaperBin number> 

This command conditionally selects the source paper bin based on dynamic values and overrides the value set in the 
Multi-Parts & Printers tab of the Form.  For example: 

#[C,1]PaperBin 261 

NOTE: 

The Pre-process Assignments property on the Special Controls tab of the Forms MUST be selected to use the 
#PaperBin command (EDIT / FORM FILES / <highlight form> / EDITOR / SPECIAL CONTROLS). 

The command expects the numeric ID of the tray in the PaperBin parameter. To determine the numeric ID of the 
tray: Select FILE / PRINTER SETUP in PrintBoss Select.  Choose the printer (this may be temporary, and when 
finished, set back to the desired default printer.)  Click on the Printer Setup button at the bottom of the screen.  Find 
the Source field, select the appropriate tray, and click OK.  Notice the PrintBoss Printer Setup screen shows the 
selected Paper Source tray with a number preceding it in parentheses. Take note of this number to enter in the 
command as the PaperBin number. 

If PaperBin number (or Tray ID) evaluates to 0, the command is ignored and the tray is selected based on the 
parameters specified in the Multi-Parts & Printers tab or the printers default tray. 

#Paragraph 
#Paragraph X, Y, "Font/Size", Spacing 

This command places a paragraph of text without printing each line as a separate #Text command.  The paragraph 
command ends as soon as the program encounters the next #.  A good practice is to use the remark #REM or 
#ParagraphEnd command to end a paragraph. 

The properties of the font in the paragraph are set like the #Text command. 

The paragraph will NOT automatically word wrap.  Lines appear exactly as they are entered in the command.  Set a 
Width to the paragraph to cause lines to append and apply word wrap.  New paragraphs within the text will occur 
after blank or indented lines.  Be sure to start the text in the first column in the editor if the width is set to initiate 
word wrap.  If the width is enabled, the justification box may also be checked to force the right edge of paragraphs 
to align.  

For Example: 

 #Paragraph 3.500, 5.500, "Arial/10", .167, N, 
 This is the first line of the paragraph. 
 This is the second line of the paragraph. 

 #ParagraphEnd 

Add //XJ2.00 immediately after the font size to right justify and set a width of 2 inches.  The N indicates the Strict 
Paragraph End Flag is not checked. 

#PassThru 
#PassThru X, Y, PassThroughString 

The character string is passed directly through to the printer.  The Windows’ printer driver does nothing to the 
string.  If the X or Y parameters are non-zero, the cursor position will be set to the X and Y location prior to the 
PassThru and then the cursor position will be popped.  If the ASCII character number 127 appears in the string, it 
will be replaced with ASCII character 27to allow Escape sequences in the string. 

This is rarely used and its operation differs between printers due to differences in the way the Windows 
PassThrough escape sequence was built into the printer drivers. 
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#PCX 
#PCX X, Y, "GraphicFileName" [, Options] 

The PCX command prints a graphic on the document.  It operates the same as the #PIC except that it expects a PCX 
or SIG file type.  See #PIC in Chapter 9 for details on the operation of this command. 

#Pie 
#Pie <CenterX>, CenterY>, Radius, Start Degree, End Degree [, Options] 

This command creates a circle (or part of a circle) in the Form.  Zero degrees points to 12 o’clock. 

For example: 

#Pie 5.00, 4.00, 1.00, 0, 180 

The object appears as: 

 

OPTIONS 
/F<FillString> – This option defines the contents of the pie shape. 

#Polygon 
#Polygon X1, Y1, X2, Y2, X3, Y3, X4, Y4, …. (up to 20 different points) [/F<FillString>] 

This command creates a polygon on the Form. Each point of a polygon is a different coordinate. The last coordinate 
connects with the first coordinate, enclosing the polygon. The command can have up to 20 different coordinates. 

For example: 

#Polygon .75, 1.15, 2.45, 5.00, 7.00, 6.35 

The object appears as: 

 

#Rem 
Anything that follows #Rem is a remark or comment. Though any line without a # is a comment, there are times, 
like at the end of a paragraph, when it is helpful to enter #Rem to end a command. 

#SetEnable 
See #Disable / #Enable / #SetEnable. 

The center point 
would be 5 
inches from the 
left and 4 inches 
from the top of 
the page. 
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#SIG 
#SIG X, Y, "GraphicFileName" [, Options] 

#Sig prints a signature graphic on a document.  This command is virtually the same as #PIC, except the #SIG Hide 
File Errors option is forced to true and cannot be changed.  Use of #PIC instead of #Sig is recommended. 

#SubCopyCount 
#SubCopyCount SubCopyNo 

The SubCopyCount command was created to print multiple copies of a specified PrintBoss Form Copy.  For 
example, Copy 0 on the PrintBoss form needs to be printed multiple times based on a value that is printed on form.  
Copy 1 always needs to be printed 3 times.  The commands may look like the following: 

#[C,0]SubCopyCount {SubCopyNo} – Print the number of copies for Copy 0 based on the value assigned to 
{SubCopyNo}. 

#[C,1]SubCopyCount 3 – Always print 3 copies of Copy 1. 

The variable {SubCopyNo} is usually assigned on the RunTime Objects tab of the PrintBoss form.  This value may 
change with each document. 

#VGrid 
#VGrid X1, Y1, X2, Y2, Xa, Xb, ... Xz [, Options] 

This command creates a frame and then draws vertical lines to fit into the frame.  Options provide further 
modifications with corner radius, shadow, line color and edge shading.  This is command had been largely replaced 
by the #Grid command.   

This command creates a frame and then draws vertical lines to fit into the frame.  This command is useful when 
creating the background columns for the detail section of an invoice.  Options provide further modifications with 
corner radius, shadow, and edge shading.  This is command had been largely replaced by the #Grid command  since 
the internal dimensions of the #Grid are relative, making it easier to move the grid. 

X1, Y1: 
These are the coordinates for the top left corner of the frame in inches from the left edge and top of paper.  The 
coordinates may be entered in thousandths of an inch. 

X2, Y2: 
These are the coordinates for the bottom right corner of the frame. 

XA, XB … XZ: 
This parameter represents any number of lines drawn vertically across the frame.  Each line is defined as the 
distance in inches from the left edge of the page. 

For example, the VGRID command could be used as follows to create a box the width of the check with four 
columns: 

#VGRID 0.250, 0.500, 8.250, 4.000, 2.000, 4.000, 6.000 

This command produces a frame with three vertical lines inside.  The first vertical line is at 2 inches from the left 
edge of the page, the second vertical line is at 4 inches from the left edge of the page, and the third vertical line is at 
6 inches from the left edge of the page. 

PRINTBOSS CONDITIONAL COMMANDS & PARAMETERS 

The following table lists the conditions available for use with the form commands. 
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Condition Parameters Notes 

=   'String1', 'String2' Compares only as many characters as in string2 

=u 'String1', 'String2' 
Same as "=", with Upper case CompareOption 
(not case sensitive) 

=e 'String1', 'String2' 
Same as "=", with Exact match CompareOption 
(case sensitive) 

=ue 'String1', 'String2' 
Same as "=", with Upper case and Exact match 
CompareOptions 

== 'NumericValue1', 'NumericValue2' Compares 2 numeric values 

<> 'NumericValue1', 'NumericValue2' Compares 2 numeric values 

<= 'NumericValue1', 'NumericValue2' Compares 2 numeric values 

>= 'NumericValue1', 'NumericValue2' Compares 2 numeric values 

< 'NumericValue1', 'NumericValue2' Compares 2 numeric values 

> 'NumericValue1', 'NumericValue2' Compares 2 numeric values 

AmntRange LoRange, HiRange, TestAmount Confirms DocAmnt is within the range 

Assigned '<Name of assigned variable to test>' 
True if assigned by #Assign or PB#Assign (Do 
Not Include Braces!) 

Captured '<Name of captured variable to test>' 
True if successfully captured from raw data (Do 
Not Include Braces!) 

Copy 'String of Digits' True if current copy is in string of digits 

Dates= '<Date1>', '<Date2>' True if dates are equal 

Dates> '<Date1>', '<Date2>' True if Date1 is greater than Date2 

Empty 'StringToTest' True if StringToTest is empty 

False  Always false, helpful for debug purposes 

FileExists '<FilePathName>' True if the specified file name exists 

Flagged '<Bank Flag Name>' 
True if expression starts with T,Y,t,y (True or 
Yes) 

In 'StringFragment', 'StringToSearchIn' 
True if Fragment is anywhere in SearchIn, case 
sensitive 

Inu 'StringFragment', 'StringToSearchIn' Same as In, but not case sensitive 

InsideOfCreation  True when adding record to work file 

InsideOfForwardCalc  True when re-calculating key fields forward 

InsideOfBackwardCalc  True when re-calculating key fields backward 

InsideOfRender  
True when rendering or processing from work 
file 

PreLoadLoop  
True when Pre-process Assignments is selected 
on the Special Controls tab of the Form Editor 

True  Always true, helpful for debug purposes 

Type 'SourceTypeName' True if current source is in SourceTypeList 

View Only  Sets an item to View, but not to print 
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NOTE: 

Although it is helpful for us humans to see the condition names spelled out completely, only as many 
characters as is needed to make the condition unique are required. For example, Fi is enough to register as the 
FileExists condition, or As is enough to register as the Assigned condition, or E as the Empty condition.  
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Appendix 

C 
APPENDIX C:  #TEXT FEATURES 

SUBSTITUTE FUNCTIONS TABLE 

There are times when a text command needs to be limited, formatted, or altered for special circumstances.  
Substitute functions are available for the #Text command to accommodate those special situations.  A list of 
substitute functions is available in the Form Editor by RIGHT clicking on an Objects tab and selecting List/Stuff 
Assignments.  Click on the plus sign in front of Substitution Functions to view the list.  A table of these functions 
follows. 

Function Description 

Chr: '<ASCII Value>' 

CityStateZip: 'City State Zip string' 

CurrentDate: 'mm/dd/yyyy' 

CurrentTime: 'hh:mm:ss tt' 

Delete: '<Str>', <StartingCharIndex>, <NumToDelete> 

DocAmnt: /HidDec /Zero /Width:nn /Commas /Trim 

Eval: '<Numeric Str>'[, <Num of Decimal Places>] 

FormatNum: '<NumStr>', WholeDigits, DecimalDigits, '<LeftFill>', 'RtFill', 'HideDec/Commas' 

FormatDate: '<DateInExpr>', 'mm/dd/yyyy' [, AddDays [, AddMonths [, AddYears [,EOM ]]]] 

FormatDate2: '<DateInExpr>’,’<DateInExprMask>', 'mm/dd/yyyy' [, AddDays [,AddMonths [, AddYears [,EOM]]]] 

If: '<Condition>', '<TrueStr>', '<FalseStr>' 

Pad: '<Str>', <Len> [, <Left, Rt, and/or Trunc> [, <PadChar>]] 

PutDashInZip: '<ZipCodeString>' 

RECAmnt: '#,###,##0.00' 

RECDate: 'mm/dd/yyyy' 

RECTime: 'hh:mm:ss tt' 

StrExtract '<OrigString>', '<Delimiter>', <Occurrence>[, '<mode>'] 

StrExtract '<OrigString>', 'CDF', <CommaDelimitedFldOccurrence>[, '<mode>'] 

StrStuff: '<OrigString>', '<StrToStuff>', <StartCharIndex> 

StrTran: '<OrigString>', 'SearchKey', 'ReplKey', ['Options'] 

SubStr: '<Str>', '<StartCharNo>', <Length> 

Trim: '<Str>' [, <Left/Right/Both>] 

TrimAll '<Str>' 

WordAmnt: <Amnt>,[ <Line1or2>[, <LineLength90>[, <Currencydollars>[, <Style AorB>]]]] 
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NOTE: 

Parameters enclosed in brackets [ ] are optional. 

SUBSTITUTE FUNCTION DESCRIPTIONS 

The following is not a complete list.  See Chapter 10, #Text Command, for descriptions of the more common 
Substitute Functions. 

Chr 
Chr: '<ASCII Value>' 

Sometimes it is necessary to insert a specific ASCII character regardless of the font used.  This function inserts these 
ASCII characters and is often used for carriage returns in Positive Pay. 

CityStateZip 
CityStateZip: 'city state zip string ' 

This function is used to clean up data when all three fields are included in a single text string.  It removes extra 
spaces (over three consecutive spaces) and adds a comma after the city if necessary. 

Delete 
Delete: '<Str>', <StartingCharIndex>, <NumToDelete> 

Sometimes it is necessary to delete some of the characters in a string.  This function deletes characters starting at a 
specific location for the number of characters indicated.  This is most often used to eliminate extra spaces in the 
middle of a string that repeat at the same location. 

Eval 
Eval: '<Numeric Str>'[, <Num of Decimal Places>] 

This function evaluates mathematical equations.  The second parameter sets the number of decimal places to which 
the answer is carried.  Zero is the default when the Num of Decimal Places parameter is missing.  For example: 

#Assign X, ÷{Eval:"2.85+({n}*0.2)",3}÷ 

This function assigns the X value for placing detail on a deposit slip.  The value is calculated to 3 decimal places.  
This assignment is included in a #For loop where {n} is defined as 1 to 27.  The loop starts at 1and increments on 
each pass until it reaches 27. 

If 
If:  '<Condition>', '< TrueStr >', '<FalseStr>' 

This function is used to define both results when a condition is evaluated.  For example: 

If:  "[Flagged,{BFlag2}]", "Canadian Funds", "US Funds" 

Pos 
Pos:  '<SubStr>', '<LookinStr>' [,<Occurances> [,Uppercase]] 

This function returns the position of a sub sting within a string.  For example: 

#[View Only]Text 8.200R, 6.825, 'Arial/12', «{Pos:'$',÷{Deposit}÷, 1,}» 

Returns the character position of the first instance of a dollar sign in the string Deposit and displays it in the view at 
the specified coordinates  
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PutDashInZip 
PutDashInZip:'<ZipCodeString>' 

This function inserts a dash into a zip code.  This is usually used when the accounting software database sends a zip 
code with the complete 9 digit American zip code minus the proper formatting. 

StrStuff 
StrStuff: '<OrigString>', '<StrToStuff>', <StartCharIndex> 

This is used to "stuff" a character or characters (StrToStuff) into a string (OrigString) before the specified number of 
characters starting from the left.  If the StartCharIndex is 1, the character(s) will be stuffed in front of the OrigString.  
If the StartCharIndex is negative, PrintBoss Select will locate the insertion point by counting characters from the 
right. 

SubStr 
SubStr: '<Str>', '<StartCharNo>', <Length> 

This function pulls a designated number of characters from a string.  The following example removes asterisks after 
the check amount: 

 #Text 8.00R, 8.7, "Arial/12", «{SubStr: ÷{DocAmnt}÷,2,}»|Canadian Style cheque  

Trim 
Trim: '<Str>' [, <Left/Right/Both>] 

This function eliminates spaces at either end of a string based on L, R, or B as a second parameter.  The default is R 
when no second parameter is entered. 

TrimAll 
TrimAll: '<Str>' 

This function trims the spaces from both ends of the string.  It is the same as using the Trim function with the option 
of B for both. 
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Appendix 

D 
APPENDIX D:  SECURITY SETTINGS 

GENERAL SETTINGS  

SECURITY METHOD 
The recommended security is the Standard method.  The Advanced method allows User Disks and User Logins to be 
used to access secured features.  The Advanced method may be selected by default in older versions of PrintBoss 
that had security activated and then upgraded to the newer version. 

SUPPRESS PRINTING SIGNATURES IN ARCHIVE REPRINTS 
Check this option to prevent a secure signature (file with the extension of .sig) on a document from printing when 
the document is reprinted from the Archive files. 

MASTER PASSWORD 
The Master Password is used to access the security settings within PrintBoss.  The initial password is ADMIN and it 
is case sensitive beginning with PrintBoss version 5.71.3.  A dialog box will confirm any changes to this field.  This 
password is also used for duplicating signature disks. This password is NOT linked to logging in to PrintBoss as a 
user.  It is recommended that an administrator user account be defined with a different password to have full access 
to the PrintBoss program once security has been activated. 

CONFIRM MASTER PASSWORD 
This confirmation dialog box only appears if the Master Password is changed. If the confirmation does not match the 
new password exactly, the security window will not close.  An error message will warn that the two passwords do 
not match and that both must be re-entered.  The password is CASE SENSITIVE. 

DRIVE WHERE USER DISK RESIDES 
This option is only available when the Advanced security method is selected.  Indicate the system wide drive letter 
for user disks. 

AUTO LOGIN MATCHING WINDOWS USERS 
PrintBoss will automatically login a user based on their Windows User name if there is a match in the PrintBoss 
users list (on the Advanced User Rights tab) when this option is selected. 

DISPLAY ONLY PRIMARY FIELDS IN BANK LIST BROWSE AND ENCRYPT KEY FIELDS IN THE BANK LIST 
Select this check box to only display primary bank fields (Bank Code, Bank Prompt and Bank Name) in the Bank 
List (EDIT / BANK LIST) and encrypt key fields so they cannot be viewed or copied. 

ENABLE USER SECURITY IN BANKS 
Access to each bank account can be controlled by the Administrator when bank security is enabled.  This button will 
read Disable User Security in Banks when the security is enabled. 
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SIGNATURE DISK LOG 

 Logging Active 

Select this check box to activate a log file for your signature disk(s). 

 SigDisk Log Retention in Days 

Set the retention period for the SigDisk log file. 

BASIC USER RIGHTS (STANDARD SECURITY MODE) 

Determine security by menu function.  Check all functions you want all users to access.  Functions that are not 
checked require specific permission assigned to a user on the Advanced User Rights tab.  Otherwise, the function is 
not available to the user. 

SECURITY REQUIRED (ADVANCED SECURITY MODE) 

This tab is only available when Advanced is selected as the Security Mode on the General Settings tab.  Select the 
menu functions that require security.  There are two types of access – password and user disk.  No security is 
required to access a function if there is no check in either the User Logged In or User Disk columns.  Functions 
checked in the User Logged In column require the user to login to PrintBoss with a password to access the function.  
Otherwise, it will not be available on the menu.  Functions checked in the User Disk column require an encoded disk 
be used for access.  Select check boxes in both columns to require User Login along with the use of a disk. 

ADVANCED USER RIGHTS (STANDARD SECURITY MODE) 

The administrator can define users on this tab and assign access to specific features not available to all users.  Click 
the Plus (+) button to add a user.  Enter the User Name and Password in the User Edit dialog box.  All features that 
are grayed out are automatically available to all users.  Select additional options to assign to the current user.  The 
Uncheck All button will deselect all optional features (those that are bold).  The Check All button selects all optional 
features.  Click OK to save changes after selecting the appropriate features. 

ADVANCED USER RIGHTS (ADVANCED SECURITY MODE) 

The administrator can define users and assign access to specific features not available to all users.  The type of 
access (password and disk) is also defined.  Click the Plus (+) button to add a user.  Enter the User Name and 
Password in the User Edit dialog box.  All features that are grayed out are automatically available to all users.  
Check features on the list to provide access for this user.  An L next to a field indicates a user password is required 
for access.  A D next to a field indicates a user disk is required for access.  A B next to a field indicates BOTH a user 
login AND a user disk are required for access.  If this user only needs a password for access, click OK. 

WRITE A USER DISK 
If this user needs a User Disk, enter the destination drive and set the expiration date for the disk.  Enter a password 
in the field under the User Name to password protect the disk.  Place a floppy disk in the drive and Write User Disk.  

READING A USER DISK 
The user name and expiration date of a user disk may be verified.  Open Security in PrintBoss and enter the Master 
Password.  The security method should be set to Advanced on the General Settings tab.  Select the Advanced User 
Rights tab and either edit a current user or add a new user by clicking on the plus symbol.  Put the disk in the floppy 
drive and choose Read User Disk.  The user properties will appear in the User Edit window.  Click OK after reading 
the disk.  You may edit the user properties or click Cancel to exit without saving changes. 
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Appendix 

E 
APPENDIX E: VARIABLES BY CATEGORY 

ACH VARIABLES 

The following is a list of variables associated with the ACH function of PrintBoss, but not included in the Bank List 
or the Payee List. 

Field Name Variable  Name Additional Description Length 

ACH Check Amount ACHChkAmnt 
Provides the remaining amount to be paid by check.  The 
value is zero when there is no remaining amount 10 

Effective Entry Date {ACHEfctvDate} 

This optional field allows a date to be assigned in the 
form.  Otherwise, the date the file is created is used.  
Add ‘!’ to the end of the variable and a calendar will pop 
up to select a date on the fly when saving the ACH file  

6 

ACH Status {ACHStatus} 
Numeric value of the active account status.  Values less 
than 1 indicate the record is inactive 

1 

ACH Total Amount {ACHTotAmnt} 
Provides the calculated ACH total amount from all 
accounts for this check. 

10 

BANK VARIABLES 

The following is a list of variables associated with the Primary tab of a PrintBoss Bank Record. 

Field Name Variable  Name Additional Description Length 

Bank Code {BCode} 
Code used to define record.  This should match the 
bank name in your accounting software. 

50-60 

Bank Prompt {BPrompt} 
Name given for user recognition.  PrintBoss will 
automatically copy the information entered in the 
Bank Code field when this field is left blank 

25 

Bank Name {BName} Name of bank 40 

Bank Address 1 {BAds1} Address Line 1 of bank (usually city, state) 40 

Bank Address 2 {BAds2} Address Line 2 of bank (often left blank) 40 

Bank Address 3 {BAds3} Address Line 3 of bank (often left blank) 40 

Company Name {BCName} Company Name as it is to appear on the checks 60 

Company Name 2 {BCName2} 
2nd Company Name as it is to appear on the checks.  
This field is optional 

60 

Company Address 1 {BCAds1} Company Address Line 1 40 
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Field Name Variable  Name Additional Description Length 

Company Address 2 {BCAds2} Company Address Line 2 40 

Company Address 3 {BCAds3} 
Company Address Line 3.  This may be used for a 
telephone number, fax number, or email address 

40 

Company Address 4 {BCAds4} 
Company Address Line 4.  This may be used for a 
telephone number, fax number, or email address 

40 

Alias {BankAliasedFrom} 
Identifies the Bank Code of the bank record used as 
the source for the Alias 

50-60 

Fractional Code {BFrac} Fractional Code 20 

Next Check Number {BChkNo} 
Next Check Number Counter (only used if Check # is 
not sent from the accounting software) 

10 

The following is a list of variables associated with the MICR tab of a PrintBoss Bank Record. 

Field Name Variable  Name Additional Description Length 

Routing Number {BMICRRoutNo} Routing Number from bank 9 

Account Number {BMICRAcctNo} Account Number from bank 20 

Check Number {BChkNo} 
Check number pulled from bank record; also known as 
Next Check Number 

10 

Check Number {CChkNo} Check number printed from accounting software 10 

Check Number {DocNo} 
Check number passed from accounting software (Does 
not appear in drop down menu of MICR tab) 

10 

MICR Line {BMICR} MICR Line (See #MICR in Chapter 8) -- 

The following is a list of variables associated with the Miscellaneous tab of a PrintBoss Bank Record. 

Field Name Variable  Name Additional Description Length 

2nd Logo {BMisc1} Often used to place a 2nd Logo on a check 40 

Misc  Field 2 {BMisc2} Miscellaneous Field 2 40 

Misc Field 3 {BMisc3} Miscellaneous Field 3 40 

Misc Field 4 {BMisc4} Miscellaneous Field 4 40 

Misc Field 5 {BMisc5} Miscellaneous Field 5 40 

2nd Signature Line {BFlag1} Use for a 2nd signature line – YES if checked 1 

Misc Flag 2 {BFlag2} Miscellaneous Flag 2 – returns TRUE if checked 1 

Misc Flag 3 {BFlag3} Miscellaneous Flag 3 – returns TRUE if checked 1 

Misc Flag 4 {BFlag4} Miscellaneous Flag 4 – returns TRUE if checked 1 

Misc Flag 5 {BFlag5} Miscellaneous Flag 5 – returns TRUE if checked 1 

Canadian Style 
Date/Amount 

{bCDN_CkStyle} Returns TRUE if checked 1 

The following is a list of variables associated with the Signatures & Logos tab of a PrintBoss Bank Record. 

Field Name Variable  Name Additional Description Length 

Logo Properties {BLogoFile} Logo file name, Ex: Mycompany.jpg 40 

Logo X {BLogoX} X Coordinate for logo 5 

Logo Y {BLogoY} Y Coordinate for logo 5 

Logo Options {BLogoOp} Optional properties for logo file 10 

Logo Hi {BLogoHi} 
Maximum $ for AmountRange condition – typically used 
only if the logo is an additional signature 

10 
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Field Name Variable  Name Additional Description Length 

Logo Lo {BLogoLo} 
Minimum $ for AmountRange condition – typically used 
only if the logo is an additional signature 

10 

Logo Width {BLogoWd} The Logo Width in inches 4 

Logo Height {BLogoHt} The Logo Height in inches 4 

Logo Percent {BLogoSize} Logo size adjusted by Percent from 10% - 300%  3 

Signature Properties {BSigFile} Signature File Name , Ex: JohnSmith.sig 40 

Signature X {BSigX} X Coordinate for signature  5 

Signature Y {BSigY} Y Coordinate for signature 5 

Signature Hi {BSigHi} Maximum $ for AmountRange condition (optional) 10 

Signature Lo {BSigLo} Minimum $ for AmountRange condition (optional) 10 

Signature Options {BSigOp} Optional properties for signature file 10 

Signature Width {BSigWd} The Signature Width in inches 4 

Signature Height {BSigHt} The Signature Height in inches 4 

Signature Percent {BSigSize} Signature size adjusted by percent from 10% - 300%  3 

Signature 2 
Properties 

{BSig2File} 
Second Signature File Name; this signature will appear 
on the top signature line 

40 

Signature 2 X {BSig2X} X Coordinate for signature 2 5 

Signature 2 Y {BSig2Y} Y Coordinate for signature 2 5 

Signature 2 Options {BSig2Op} Optional properties for signature 2 10 

Signature 2 Hi {BSig2Hi} Maximum $ for Amount Range condition (optional) 10 

Signature 2 Lo {BSig2Lo} Minimum $ for Amount Range condition (optional) 10 

Signature 2 Width {BSig2Wd} The Signature Width Size in inches 4 

Signature 2 Height {BSig2Ht} The Signature Height Size in inches 4 

Signature 2 Percent {BSig2Size} Signature size adjusted by percent from 10% - 300% 3 

ACH FILE HEADER RECORD FIELDS 

The following is a list of variables associated with the ACH Definitions tab of a PrintBoss Bank Record.  These 
fields are used in the SignOn tab of the ACH File and are defined in the bank record.  They apply to every record in 
the file. 

Field Name Variable  Name Additional Description Length 

File Mode ID {bACHFileIDMode} Increments beginning at A for multiple files in a day 1 

Immediate 
Destination Name 

{bACHImdDstName} Optional.  The name of the ACH receiving point. 23 

Immediate 
Destination 

{bACHImdDstNo} 
Contains a space followed by the 9 digit routing 
number of the ACH Operator or receiving point where 
the file is being sent 

10 

Immediate Origin {bACHImdOrgNo} 
Contains a space followed by the 9 digit routing 
number of the ACH Operator or sending point that is 
sending the file 

10 

Immediate Origin 
Name 

{bACHImdOrgName} Optional.  The name of the ACH sending point. 23 

Pre-Note Override {ACHPreNote} 
Global override of the PreNote setting.  This should 
only be used once, the first time an ACH batch is 
processed. 

1 
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ACH COMPANY BATCH RECORD FIELDS 
These fields are used in the Header tab of the ACH File and are defined in the bank record.  They apply to every 
record in a batch. 

Field Name Variable  Name Additional Description Length 

Company 
Discretionary Data 

{bACHCompDisc} 
Optional.   Allows Company to include codes of 
significance only to them to enable specialized 
handling of all entries in the batch 

20 

Company Entry 
Description 

{bACHCompEntry} 
Provides a description for the purpose of the 
transaction.  Ex:  Payroll; Water Bill; etc. 

10 

Company 
Identification 

{bACHCompID} 
An alphanumeric code used to identify the 
Originator 

10 

Company Name {bACHCompName} Name of the Company or Payee 16 

Originating DFI 
Identification 

{bACHOrgDFIID} 
Bank routing number plus ABA number with no 
leading space 

8 

Standard Entry 
Class 

{bACHStdEntryClsCod} 

This field holds various predefined character 
abbreviations representing standard descriptions. 

Ex: CCD (Corporate Credit or Debit). 

 

3 

Service Class 
Codes 

{bACHSvcClassCode} Identifies type of ACH file 3 

ACH BALANCE RECORD FIELDS 

These fields are used in the Balance Record tab of the ACH File and are defined in the bank record. 

Field Name Variable  Name Additional Description Length 

Bank Account 
Number 

{bACHBalAcct} DFI (Bank) Account Number for balancing entry 17 

Balanced File {bACHBalFile} 
This is the checkbox that determines whether a balanced 
file is used for ACH.  The value is either Y or N 

1 

Account Name {bACHBalName} Receiving Company Name for balancing entry 22 

Routing Number {bACHBalRout} Receiving DFI Bank Routing Number for balancing entry 8 

FORM VARIABLES 

The following standard variables are related to the PrintBoss Form. 

Field Name Variable  Name Additional Description Length 

Destination Device {DestDevice} 
Returns the name of the Destination for the 
specified copy 

-- 

Destination Device 
Status 

{DestDeviceStatus} 
Returns the Status Log information from the 
Work File Edit window. 

-- 

Document Amount {DocAmnt} 
Returns the amount, usually the check amount, 
assigned in the form. 

-- 

Bank {DocBank} 
Used to assign values to allow PrintBoss to 
automatically select a bank record. 

-- 

Font Override {CapturedTextFontOverride} 
Assigns the font specified in the Font Override 
field under the Captured Text Treatment section 
on the Settings tab of the form 

-- 
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Field Name Variable  Name Additional Description Length 

Check Number {CChkNo} 
Returns the check number assigned in the form, 
similar to DocNo. 

-- 

Copy Name {CopyName} 
Returns the name of the specified PrintBoss 
copy, such as Copy 0 or Copy 1.  C,0 and C,1 
may also be used. 

-- 

Form Next Number {FormNextNumber} 

Provides an incremental value that can be 
accessed in the Footer Objects tab of the Form.  
Must be enabled on the Settings tab of the Form 
to be used. 

-- 

Page Options {PageOptions} 
Assign this variable with /S to Suppress Block 
Mirrors.  This is the same as Enable check box 
on the Block Mirrors tab of the form. 

-- 

Positive Pay File 
Extension 

{PosPayFileExt} Displays the Positive Pay file extension -- 

Positive Pay File 
Name 

{PosPayFileName} Displays the Positive Pay file name -- 

Security Stamp 
String 

{SecurityStamp} 

Used to print information, such as Operator, 
Current Date, Current Time, etc., on the check as 
a security measure.  The string is added on the 
Special Controls tab of the Form. 

-- 

Sub Copy Number {SubCopyNo} 
Used to assign any number of copies to the Sub 
Copy Count function. 

-- 

MISCELLANEOUS VARIABLES 

The following variables are miscellaneous variables available in PrintBoss. 

Field Name Variable  Name Additional Description Length 

Operator {Operator} 
PrintBoss Login name or WinUserName when not 
logged in 

-- 

PrintBoss Home 
Directory 

{PBDir} Returns the path of the PrintBoss Home Directory -- 

PrintBoss Serial 
Number 

{PBSerialNo} 
Returns the serial number for the current copy of 
PrintBoss 

-- 

PrintBoss Version {PBVersion} Returns to version for the current copy of PrintBoss -- 

Windows Computer 
Name 

{WinCoputerName} Returns name of computer where PrintBoss is used. -- 

Windows User Name {WinUserName} Returns Windows login name -- 

PAYEE LIST VARIABLES 

The following variables are associated with the Payee List in PrintBoss. 

Field Name Variable  Name Additional Description Length 

Active {ACHActive} Resolved to Y when checked an N when not checked 1 
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Field Name Variable  Name Additional Description Length 

Amount {ACHAmount} 

Returns the amount of the ACH after it is calculated 
or zero when PreNote is selected.  This applies per 
account.  See ACHTotAmnt for a total of all 
accounts. 

10 

Mode {ACHMode} 
Returns the numeric value of the Mode, i.e. 0 = 
Inactive; 1 = Remainder of Check, etc. 

1 

ACH PreNote {ACHPreNote} 

PreNote may be set globally in the Bank Record or 
on an individual record in the Payee List.  This field 
is Optional.  The values are Y or N and the default is 
N (blank). 

1 

ACH PreNote Print 
Check 

{ACHPreNotePrint} 
Prints a check when PreNote AND Print Check are 
selected.  .  The values are Y or N and the default is 
N (blank). 

1 

DFI (Bank) Account 
Number 

{ACHRecvBankAcct} 
Account number for the receiving company or 
individual 

17 

Receiving DFI 
(Bank) ID 

{ACHRecvBankID} Routing and ABA Number for the receiving bank 9 

Discretionary Data {ACHRecvDisc} Optional data that can be defined by the sender 2 

Receivers ID  {ACHRecvID} Optional ID for the receiving individual /company 15 

Receivers Name {ACHRecvName} Receiving individual/company name 22 

Transaction Code {ACHTransCode} 
Code indicates Credit or Debit to Checking or 
Savings account 

2 

Bank Payee List {BPayeeList} Defines the Payee List associated with a bank record -- 

Email Address {PLEmail} Email address entered in the Payee List 50 

Payee ID {PLPayeeID} 
ID for Payee; defined by DocPayeeID in the form 
and is used to match a check with a Payee List entry. 

50 

Payee Name {PLPayeeName} 
Name of the Payee; defined by {DocRecip} in the 
form and is used to match a check with a Payee List 
entry. 

50 

Payment Type {PLPaymentType} Payment type entered in the Payee List 1 

POSITIVE PAY VARIABLES 

The following variables are associated with the Positive Pay function in PrintBoss. These are Read Only variables 
and are only available in the Positive Pay File Editor. 

Field Name Variable  Name Additional Description Length 

Batch Amount {BatchAmnt} 
Sum of all the checks in a batch or the sum of Credit 
ACH transactions in a batch 

-- 

Batch Amount2 {BatchAmnt2} Sum of the Debit ACH transactions in a batch -- 

Batch Check 
Number Sum 

{BatchChkNoSum} Sum of all the check numbers in a batch -- 

BatchCount {BatchCount} Count of all records in the batch -- 
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Destination Device 
Status Code 

{DestDeviceStatusCode} 
Returns the codes from the Printed column of the 
work file 

8 

File Amount {FileAmnt} 
Sum of all the checks in a file or the sum of Credit 
ACH transactions in the file 

-- 

File Amount2 {FileAmnt2} Sum of the Debit ACH transactions in the file -- 

File Batches {FileBatches} Count of all batches in the file  

File Check Number 
Sum 

{FileChkNoSum} Sum of all the check numbers in a file -- 

FileCount {FileCount} Count of all records in the file -- 

Positive Pay File 
Counter 

{PosPayFileCounter} 

Provides a unique numeric value that increments 
with each new Positive Pay file.  The format is 
PosPayFileCounter: ‘4’, where the ‘4’ represents the 
numeric value indicating number of digits for the 
counter 

-- 

Positive Pay Line 
Count 

{PosPayLineCount} 
Increments with each new Positive Pay line in the 
file.  The value starts over with each new file 

-- 

Positive Pay 
Sequence Number 

{PosPaySeqNo} 
Provides a unique ascending value for each new 
Positive Pay line.  This value does not start over 
until it reaches 9999999. 

7 

WORK FILE VARIABLES 

The following table provides the field lengths for the Work File Browse window: 

Field Name Variable  Name Additional Description Length 

DocNo {DocNo} Document Number 12 

Recipient {DocRecip} Payee Name 30-60* 

Misc (FaxNo) {DocMisc} 
Miscellaneous field that is sometimes used to store the Fax 
number printed from the accounting software 

40 

Misc2 {DocMisc2} 
Additional miscellaneous field that is sometimes used to store 
the E-mail address printed from the accounting software 

60 

Amount {DocAmntStr} 
Document amount string is the value of the check amount saved 
in the work file. 

12 

BankCode {BCode} 
PrintBoss automatically populates the Bank Code field in the 
work file. 

50 

PayeeID {DocPayeeID} ID number to use with the Payee List 12 

* NOTE: 

The DocRecip length is set under the Options menu in PrintBoss.  Select the Internal Tab to locate the DocRecip 
Length field. 
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Appendix 

F 
FAQS 

CAN PRINTBOSS PRINT CANADIAN CHEQUES? 
Yes!  PrintBoss is distributed with standard forms that allow checks to be printed in both the standard American 
format and Canadian format as desired.  In most cases, the only modification necessary is to check the Canadian 
Style Date/Amount box in the Special Items area on the Miscellaneous tab of the Bank.  Please consult the Support 
Documents section on our website for a complete list of standard PrintBoss forms that have been modified to 
comply with the new standard. 

 See Chapter 9, Form Files, for more information on #CanadianDate. 

CAN PRINTBOSS PRINT OTHER DOCUMENTS BESIDES CHECKS? 
Yes!  PrintBoss can print a variety of accounting forms such as invoices, picking slips, or statements.  These forms 
are printed on blank paper.  PrintBoss specializes in printing multiple part forms.  Each copy of a form is printed on 
plain copy paper saving money over carbon-less forms and making it easier to disperse the form copies. 

WHAT KIND OF PRINTER IS NEEDED TO PRINT DOCUMENTS WITH PRINTBOSS? 
PrintBoss requires a PCL5 compatible Laser printer (100% HP Compatible).  PrintBoss can access any font that is 
available to the printer.  Either internal fonts or cartridge fonts can be used to improve the look of the form. 
Compatibility with MICR toner cartridges is important for check printing so PrintBoss can produce a MICR line 
readable by magnetic scanners.  Be sure to investigate before purchasing a non-HP LaserJet printer. 

Be sure to use the PCL5 driver for the printer you select. 

HOW SHOULD THE PRINTBOSS PRINTER DRIVER BE CONFIGURED? 
Install the PrintBoss printer driver through the PrintBoss setup program.  This process will configure the driver 
properly for all systems.  DO NOT change the properties of the PrintBoss printer driver. 

Do not alter the Laser printer driver to use the PrintBoss driver. 

SHOULD PRINTBOSS BE THE DEFAULT PRINTER? 
NO.  The only time the PrintBoss printer driver should be selected is for printing the specific documents required to 
pass through PrintBoss.  PrintBoss may be set as the default only for your specific accounting software reports. 

The PrintBoss printer driver SHOULD NOT be designated as the Windows system default nor should it be set as the 
accounting software’s default printer. The PrintBoss printer driver should also never be selected as the PrintBoss 
default printer since PrintBoss needs to print to an actual physical printer. 

CAN DIFFERENT COPIES BE PRINTED TO DIFFERENT TRAYS ON THE SAME PRINTER? 
Yes.  This selection is made within the PrintBoss form.  Edit the Form file and select the Multi-Parts & Printers tab. 
For each copy, including the original, there is a setting for the Source Tray.  Select the desired tray from the drop 
down menu.  The tray names are defined by the printer, so the tray names may change based on the printer model 
selected within PrintBoss. 
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CAN DIFFERENT COPIES BE PRINTED TO DIFFERENT PRINTERS? 
Yes.  This selection is made within the PrintBoss form. Edit the Form File and click on the Multi-Parts & Printers 
tab.  Select a printer from the Destination Printer/Device drop down menu for the original and each copy.  Choose 
<Form Printer> to use the Default PrintBoss Printer. 

CAN PRINTBOSS PRINT A SIGNATURE ON A CHECK? 
Yes.  PrintBoss can add one or more .BMP, .JPG, or .PCX files as signatures to a check.  Conditions can be added to 
the signature command to specify printing at a certain dollar amount or range.  PrintBoss can also print a security 
protected signature on checks.  This signature requires a special disk to be inserted into the computer to allow the 
signature to print.  Contact Wellspring Software for more information on security protected signatures. 

CAN CUSTOM DESIGNED FORMS BE USED? 
Wellspring Software can create a custom form according to your specifications.  Submit a sample or a description 
for a quote. 

HOW CAN I ADD A SECOND SIGNATURE LINE TO A CHECK? 
A second signature line can be added based on the bank account using a standard PrintBoss form.  Edit the Bank 
List.  Select the account requiring the second signature line.  Check the 2nd Signature Line box on the Miscellaneous 
tab.  Click OK.  Repeat for any additional accounts requiring a second signature line. 

HOW CAN I PRINT A SIGNATURE ONLY FOR CERTAIN DOLLAR AMOUNTS? 
Use a condition on the command that prints the signature.  See #AmountRange in Chapter 9, Form Files. 

HOW CAN I ADJUST THE MICR LINE? 
Click the Options menu in PrintBoss and select Configuration.  The MICR Offset Adjustment feature in the Settings 
tab has two fields: Left/Right and Top/Bottom.  The defaults are set to zero.  Run the MICR Adjust Wizard to 
properly adjust the values. 

This setting is workstation specific. 

WHAT LOGO FORMATS CAN PRINTBOSS READ? 
PrintBoss can accept logos formatted as .PCX, .JPG, or .BMP files.  PCX files only print in black and white (shades 
of gray), so it is best to save logos as monochrome for this file type.  BMP and JPG files will print color. 

HOW CAN I ADD A LOGO TO A FORM? 
Use a #BMP, #PIC, or #PCX command in the Form.  If the same logo will appear on all documents regardless of the 
Company, reference the filename in the command.  Otherwise, copy the logo to PRNTBOSS\LOGOS directory, 
reference the variable {BLogoFile} in the command on the Form, and enter the filename of the logo in the 
respective field of each bank record that will use the logo. 

WHAT IF THERE IS A LOGO FOR ONLY SOME COMPANIES? 
Logos are usually printed on the left side of a check and Company Information is printed to the right of the logo. 
Conditions can be placed on the logo and company information commands to specify when to exclude or print the 
logo and shift the company information.  Most standard PrintBoss forms can handle these situations automatically. 

Select EDIT / BANK LIST in PrintBoss.  Choose the appropriate bank record and click the Edit Bank button.  Enter 
the logo file name in the Logo Properties field on the Signatures_Logos tab.  The form will automatically add this 
logo when printing checks from this account and shift the company information accordingly.  If there is no logo 
filename in the bank record, the company information will remain left justified and no logo will print. 

NOTE: 

For additional information, please visit our Support Documents page at www.WellspringSoftware.com. 
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Appendix 

G 
TROUBLE SHOOTING 

Be sure to review the special instructions (Installation Notes) for the accounting software.  Go to the 
PRNTBOSS\DOC\ directory to get find the appropriate file and print it out. 

NOTE: 

For additional information, please visit our Support Documents page at or www.WellspringSoftware.com. 

QUICKBOOKS 

NO COMPANY INFORMATION IS APPEARING ON THE CHECKS. 
Make sure to turn on the option to print the Company Address within the QuickBooks printer setup. 

THE CHECK PRINTS WITHOUT THE MICR LINE AND BANK INFORMATION. 
Make sure the PrintBoss printer driver is selected for printing the checks. 

ERROR MESSAGE:  YOU HAVE PRINTED A DOCUMENT TO PRINTBOSS THAT IS NOT RECOGNIZED BY PRINTBOSS. 
SPECIFICALLY, NO ENTRY IN THE "FORM / BANK REQUEST LIST" MATCHES THIS FORMAT. 
Make sure the voucher style of check is selected within QuickBooks.  Also make sure the check is worth at least 
$0.01.  Zero dollar checks are not recognized by PrintBoss. 

NT/W2000/WXP WORKSTATIONS 

WHEN INSTALLING PRINTBOSS ON AN NT/W2000/WXP WORKSTATION, I AM UNABLE TO INSTALL THE 

PRINTBOSS PRINTER DRIVER. 
Log in as ADMINISTRATOR before installing PrintBoss.  Reboot the workstation after installing the printer driver. 

WHEN RUNNING PRINTBOSS ON AN NT/W2000/WXP WORKSTATION, PRINTBOSS DOES NOT LAUNCH 

AUTOMATICALLY. 
Log in as ADMINISTRATOR, rerun the workstation install, and restart the workstation. This should install the 
PB32stub.exe into the Windows\System32 directory. The PB32stub process should run in the background to allow 
PrintBoss to automatically load.  PB32stub is listed in the Task Manager when it is running. 
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W2003 SERVER 

WHEN INSTALLING PRINTBOSS ON A W2003 SERVER FOR USE WITH TERMINAL SERVICES, I AM UNABLE TO 

INSTALL THE PRINTBOSS PRINTER DRIVER. 
The newest version of PrintBoss will automatically install the PrintBoss 50 printer driver.  If the PrintBoss NT40 
printer is necessary, a group policy will need to be changed. 

 See Chapter 5, The PrintBoss Printer Driver. 

VISTA /WINDOWS 7/WINDOWS 8 OPERATING SYSTEMS 

ON A VISTA/WINDOWS 7/WINDOWS 8 WORKSTATION I CANNOT ACCESS THE PRINTBOSS DRIVER SETTINGS. 
Close the PrintBoss Program.  You must RIGHT CLICK on the PrintBoss Program and Run as administrator.  The 
settings on the PrintBoss Driver Settings screen will be available. 

GENERAL 

THE DOCUMENTS ARE PRINTING ON THE WRONG PRINTER. 
Check the following areas: 

 Make sure the accounting software is printing to the PrintBoss printer driver. 
 Select FILE / PRINTER SETUP in the PrintBoss program.  Choose the correct printer. 
 Edit the PrintBoss Form File and check the Multi-Parts & Printers tab.  The Destination Printer/Device 

should reflect the correct printer for each copy.  The Default PrintBoss Printer is identified at the bottom of 
this tab.  Select <Form Printer> to print to the default PrintBoss printer. 

THE DOCUMENTS ARE PRINTING FROM THE WRONG TRAY. 
Leave the printers set to their auto select / default tray choice. 

Edit the PrintBoss Form File, select the Multi-Parts & Printers tab, and select the Source Tray for each copy.  The 
tray choices listed are for the printer selected in the Destination Printer/Device column in PrintBoss.  Test the 
different choices to find the correct tray name. 

THE PRINTER REQUIRES A MANUAL PROMPT ON THE FORM FEED BUTTON BETWEEN EACH PAGE. 
Make sure to choose the correct tray from within the PrintBoss Form (Multi-Parts & Printers) instead of the printer 
settings. 

You have selected a Manual tray if you have chosen the tray within the PrintBoss Form.  Choose a different setting 
for the tray you want. 

THE SIGNATURE WON'T PRINT. 
 Make sure the signature disk is in the correct drive (if required). 
 Make sure a copy of the *.sig file from the disk is placed into the PRNTBOSS\LOGOS directory. 
 Make sure the PrintBoss Form references the signature file correctly. 

THE SIGNATURE PRINTS ON VOID PAGES OF MULTIPLE PAGE CHECKS. 
Add the following condition to the signature command in the PrintBoss Form: 

[AmntRange, 0.01] 

An example command would look like this: 

#[AmntRange, 0.01]PCX 5.2, 9.85, "Your_Sig.Sig" 
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THE LOGO IS THE WRONG SIZE. 
Go to EDIT / FORM FILES / <highlight the form> / VIEW if the logo will be printed on all documents for this 
Form.  You will see a rough view of your form (no data).  Double click on the logo.  Select the Percent radio button 
and adjust the horizontal and vertical size in the Pic Command Properties dialog.  Click on OK to view the adjusted 
logo. 

Go to EDIT / BANK LIST / <highlight record> / EDIT BANK if the logo is printed according to the bank record.  
Select the Signatures_Logos tab.  Adjust either the width and height or the percentage to change the size. 

Changes will take affect the next time you print from this account. 

MY SIGNATURE PRINTS ONLY ON SOME OF THE DOCUMENTS IN THE BATCH. 
Check to see if there are any conditions on the command.  If there are, this may be why it is not printing on some 
documents (i.e. signature with an amount range, etc.) 

 See Chapter 9, Form Files, for more information on Conditional Commands. 

If there are no conditions on the graphic commands, you may need to update the driver for your printer or add more 
memory to the printer.  Be sure to download the latest PCL5 driver for the printer and operating system if you are 
upgrading the printer driver. 

THE MICR LINE IS CUT IN HALF 
Download the latest driver for the LaserJet printer.  Be sure that it is a PCL5 driver.  If that doesn't work, adjust the 
MICR line by changing the MICR Offset Adjustment settings in the OPTIONS / CONFIGURATION window. 

 See Chapter 8, Bank Accounts. 

THE COMPANY NAME AND ADDRESS LINES DO NOT FIT WITHIN THE ENVELOPE WINDOW 
Edit the respective PrintBoss Form.  Select EDIT / FORM FILES from the main PrintBoss screen.  Highlight the 
appropriate Form and select View.  Grab the Company Name and drag it to the desired location.  The Company 
address will typically adjust accordingly if you are using one of our standard forms.  Close the View and click Yes to 
save the changes.  This adjustment applies to all companies using this Form. 
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Appendix 

H 
GLOSSARY 

ABA 

American Banking Association 

APOSTROPHE 

' 

BACKSLASH (a.k.a. reverse solidus) 

\ 

This slash is NOT under the question mark on a standard keyboard. 

BRACES 

{  } 

Hold the SHIFT key and type the brackets on a standard keyboard. 

BRACKETS (a.k.a. square brackets) 

[  ] 

CAPTURED TEXT 

This is text that is received from the accounting package.  

COLON 

: 

Hold the SHIFT key and type a semicolon. 

COMMENT 

Enter a pipe symbol ( | ) in front of the command line to make PrintBoss Select skip that line. 

Hold the SHIFT key and type a backslash on a standard keyboard. 

CPA 

Canadian Payments Association; L'Association Canadienne des Paiements (L'ACP) 

DPI 

DPI stands for Dots Per Inch. 
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DIVISON 

÷ 

This special character is often used when there is a chance other delimiters appear within a string used in a variable.  Hold 
CTRL and type the apostrophe ( ' ) to generate this symbol within the PrintBoss Form Editor. 

DUPLEX PRINTER 

This is a printer that has the ability to print on both sides of the page in one pass.  

FORM 

The file used by PrintBoss Select to format data provided by the Host Accounting Software. This typically consists of 
elements traditionally preprinted.  

Forms are files with the .PBF extension. 

FORWARD SLASH (a.k.a. whack) 

/ 

This is the key under the question mark on a standard keyboard. 

HOME 

This is the path to the PRNTBOSS folder.  For example, HOME would be C:\program files\prntboss if the PrntBoss 
folder is in the program files list. 

MICR / MICR LINE 

Magnetic Ink Character Recognition – refers to the ABA characters at the bottom of a check. 

MICR TONER 

The toner used to print the MICR line at the bottom of checks so they can be read by magnetic scanning equipment. Check 
with your bank to determine whether MICR toner is required. 

MODULUS 9 

An asterisk placed at the end of a series of numbers (usually the check number) that will be replaced with Modulus 9 
check sum. 

PARENTHESES 

(  ) 

These characters are SHIFT 9 and 0 on a standard keyboard. 

PCL5 

Printer Control Language 5 – PrintBoss Select uses this printer language to communicate with printer hardware.  
Most Hewlett-Packard LaserJet printers use this language.  PCL translates the data and sends it in binary form to the 
printer. 

PCL6 

Printer Control Language 6 – Some of the new Hewlett-Packard LaserJet printers are distributed with this newer 
PCL printer driver version.  Be sure to download the newest version from the HP web site (www.hp.com) when 
using this driver.  PCL translates the data and sends it in binary form to the printer. 

PIPE 

| 

Pipe is the symbol at the beginning of comments in the Form Editor.   
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Hold the SHIFT key and type a backslash on a standard keyboard to generate this symbol in the PrintBoss Form 
Editor. 

POUND 

# 

The symbol at the beginning of all active PrintBoss commands in the Form Editor. 

PS – POST SCRIPT 

Postscript printer drivers send a page description to a printer that is translated by the printer.  We do NOT 
recommend using PostScript drivers with PrintBoss Select.  See PCL5 or PCL6 listed above. 

QUOTE 

" 

Hold the SHIFT key and type an apostrophe. 

REPORT 

A file used by the Host Accounting Software to generate documents to be printed.  

SEMI COLON 

; 

TILDE 

~ 

Hold the SHIFT key and type the graves symbol (`).  This is above the Tab key on a standard keyboard. 

UNCOMMENT 

Remove the pipe symbol ( | ) from the beginning of the command line to activate the command. 

VIEW or INSTALLATION NOTES 

These are notes referencing a specific accounting package.  These should be printed during the installation of 
PrintBoss Select.  They can also be found as *.rtf files in the PRNTBOSS/DOC directory.   

WORK FILE 

Work Files are a database of documents printed through PrintBoss Select.  The work file has the same name as the 
PrintBoss Form used at the time of printing.  Options for retaining, deleting, or archiving completed work files can 
be found on the Setting tab of the Form Editor. 


